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Welcome to The Journal 1

1 Welcome to The Journal

* Keeping a daily journal has never been easier! The Journal always knows what day it is, and
automatically organizes your entries by day, month and year.

¢ Get organized! With The Journal's many options for categories and entries you can be as
organized as you want to be. Keep your personal journal separate from your work notes, or your
dreams separate from your correspondence--but only if you want to.

* Do it Your Way! The Journal has no "agenda"--except to be as useful as possible. Use any
journaling technique or writing style you want, even none at all. It's completely up to you.

* The Journal Newsletter! Sent out monthly, The Journal Newsletter provides tips for using The
Journal, articles about journaling and writing, writing exercises, news of updates and fixes, and more.

Getting Started - New Users

Getting Started with The Journal - A Step by Step Guide

Frequently Asked Questions (FAQ)

Getting Started - Upgrading

See what's new in The Journal 7!

* Find what you're looking for with lightning speed!
Take full control of your journaling and writing!
Synchronize multiple copies of The Journal!
And much, much more!

Upgrading from The Journal 6 or Earlier
Upgrading Add-on Packages
Upgrading from The Journal 2.x

© 1996-2016 by David Michael
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2 The Journal Information

Getting Started with The Journal - A Step by Step Guide

Frequently Asked Questions (FAQ)

Contact Information (email, Web page, etc.)

THE JOURNAL - PRODUCT LICENSE INFORMATION

Credits
Dedication

Special Thanks

Buy The Journal
The Journal Pricing
The Journal Order Form

Version History

See what's new in The Journal 7!

21 Contact Information

The Journal Home Page
http://www.davidrm.com/thejournal/

The Journal Customer Support, Bug Reports & Suggestions
support@davidrm.com

The Journal Newsletter
http://www.davidrm.com/thejournal/newsletter/

The Journal User Discussion

Ask questions, swap journaling techniques, and learn tips and tricks for using DavidRM Software's The
Journal.

Subscribing is free! Sign up here:

http://www.davidrm.com/thejournal/tjsupport.php

DavidRM Software
http://www.davidrm.com

Mailing Address:

DavidRM Software

7018 East 78th Place
Tulsa, OK 74133

United States of America

© 1996-2016 by David Michael
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2.2

THE JOURNAL - PRODUCT LICENSE INFORMATION
NOTICE TO USERS: CAREFULLY READ THE FOLLOWING LEGAL AGREEMENT.

USE OF THE SOFTWARE PROVIDED WITH THIS AGREEMENT (THE "SOFTWARE") CONSTITUTES
YOUR ACCEPTANCE OF THESE TERMS. IF YOU DO NOT AGREE TO THE TERMS OF THIS
AGREEMENT, DO NOT INSTALL AND/OR USE THIS SOFTWARE.

1. LICENSE GRANT.

DavidRM Software grants you a license to use one copy of the version of this SOFTWARE on any one
hardware product for as many licenses as you purchase. "You" means the company, entity or
individual whose funds are used to pay the license fee. "Use" means storing, loading, installing,
executing or displaying the SOFTWARE, whether on the hardware product directly or via a network.

HOUSEHOLD LICENSE: Individuals (not companies nor other entities) who purchase the SOFTWARE
may use the SOFTWARE on any hardware products they own or are the primary user of, and on any
hardware products owned by members of their immediate family residing in their household.

When you first obtain a copy of the SOFTWARE, you are granted an evaluation period of not more
than 45 days or 45 uses, whichever is greater, after which time you must pay for the SOFTWARE
according to the terms and prices discussed in the SOFTWARE's documentation, or you must remove
the SOFTWARE from your computer.

You may not modify the SOFTWARE or disable any licensing or control features of the SOFTWARE
except as an intended part of the SOFTWARE's programming features.

This license is not transferable to any other company, entity, or individual.
2. OWNERSHIP.

The SOFTWARE is owned and copyrighted by DavidRM Software. Your license confers no title or
ownership in the SOFTWARE and should not be construed as a sale of any right in the SOFTWARE.

3. COPYRIGHT.

The SOFTWARE is protected by United States copyright law and international treaty provisions. You
acknowledge that no title to the intellectual property in the SOFTWARE is transferred to you. You further
acknowledge that title and full ownership rights to the SOFTWARE will remain the exclusive property of
DavidRM Software and you will not acquire any rights to the SOFTWARE except as expressly set forth
in this license. You agree that any copies of the SOFTWARE will contain the same proprietary notices
which appear on and in the SOFTWARE.

4. UNAUTHORIZED USE.

You may not use, copy, rent, lease, sell, modify, decompile, disassemble, otherwise reverse engineer,
or transfer the SOFTWARE except as provided in this agreement. Any such unauthorized use shall
result in immediate and automatic termination of this license.

5. U.S. GOVERNMENT INFORMATION.

Use, duplication, or disclosure by the U.S. Government of the computer software and documentation in
this package shall be subject to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in
Technical Data and Computer Software clause at DFARS 252.277-7013 (Oct 1988) and FAR 52.227-19
(Jun 1987). The Contractor is DavidRM Software, 7018 East 78th Place, Tulsa, OK, 74133.
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6. LIMITED WARRANTY.

THIS SOFTWARE IS PROVIDED ON AN "AS IS" BASIS. DAVIDRM SOFTWARE DISCLAIMS ALL
WARRANTIES RELATING TO THIS SOFTWARE, WHETHER EXPRESSED OR IMPLIED, INCLUDING
BUT NOT LIMITED TO ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE. NEITHER DAVIDRM SOFTWARE NOR ANYONE ELSE WHO HAS BEEN
INVOLVED IN THE CREATION, PRODUCTION, OR DELIVERY OF THIS SOFTWARE SHALL BE
LIABLE FOR ANY INDIRECT, CONSEQUENTIAL, OR INCIDENTAL DAMAGES ARISING OUT OF THE
USE OR INABILITY TO USE SUCH SOFTWARE, EVEN IF DAVIDRM SOFTWARE HAS BEEN
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES OR CLAIMS. THE PERSON USING THE
SOFTWARE BEARS ALL RISK AS TO THE QUALITY AND PERFORMANCE OF THE SOFTWARE.

SOME JURISDICTIONS DO NOT ALLOW LIMITATION OR EXCLUSION OF INCIDENTAL OR
CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATIONS OR EXCLUSION MAY NOT APPLY TO
YOU TO THE EXTENT THAT LIABILITY IS BY LAW INCAPABLE OF EXCLUSION OR RESTRICTION.

IN NO EVENT SHALL ANY THEORY OF LIABILITY EXCEED THE LICENSE FEE PAID TO DAVIDRM
SOFTWARE.

7. NO LIABILITY FOR CONSEQUENTIAL DAMAGES.

IN NO EVENT SHALL DAVIDRM SOFTWARE OR ITS SUPPLIERS BE LIABLE TO YOU FOR ANY
CONSEQUENTIAL, SPECIAL, INCIDENTAL OR INDIRECT DAMAGES OF ANY KIND ARISING OUT
OF THE DELIVERY, PERFORMANCE OR USE OF THE SOFTWARE, EVEN IF DAVIDRM
SOFTWARE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO EVENT WILL
DAVIDRM SOFTWARE'S LIABILITY FOR ANY CLAIM, WHETHER IN CONTRACT, TORT OR ANY
OTHER THEORY OF LIABILITY, EXCEED THE LICENSE FEE PAID BY YOU, IF ANY.

8. SEVERABILITY.

In the event of invalidity of any provision of this license, the parties agree that such invalidity shall not
affect the validity of the remaining portions of this license.

9. GOVERNING LAW.

This agreement shall be governed by the laws of the State of Oklahoma excluding the application of its
conflicts of law rules and shall inure to the benefit of DavidRM Software and any successors,
administrators, heirs and assigns. Any action or proceeding brought by either party against the other
arising out of or related to this agreement shall be brought only in a STATE or FEDERAL COURT of
competent jurisdiction located in Tulsa County, Oklahoma. The parties hereby consent to in personam
jurisdiction of said courts. This agreement will not be governed by the United Nations Convention on
Contracts for the International Sale of Goods, the application of which is expressly excluded.

10. ENTIRE AGREEMENT.

This is the entire agreement between you and DavidRM Software which supersedes any prior
agreement or understanding, whether written or oral, relating to the subject matter of this license.

11. RESERVED RIGHTS.

All rights not expressly granted here are reserved to DavidRM Software.
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2.5

Credits
The Journal was designed and developed by David Michael.

The Journal splash screen and icon graphics were designed by Don Michael, Jr (http://www.
donmichaeljr.com).

The Journal was developed using Borland Delphi (http://www.borland.com/delphi).

The Journal's online help was created with Help & Manual from EC Software (http://www.
helpandmanual.com).

The Journal uses the following third-party algorithms, libraries and components:

TRichViewEdit component by Sergey Tkachenko (http://www.trichview.com).

TScaleRichView component by llya I. Zelensky.

DISQLite3 database components by Delphi Inspiration (http://www.yunga.de/delphi/doku.php/).
Configurable menu and toolbars from Developer Express (http://www.devexpress.com).
BusinessSkinForm and SkinAdapter components from Almediadev (http://www.almdev.com).
Toolbar, menu and many, many Calendar Charm icons by IconShock (http://www.iconshock.com).
Spell checker and thesaurus from Addictive Software (http://www.addictivesoftware.com).

MD5 (password hashing) algorithm produced by RSA Data Security, Inc.

Twofish block cipher (entry text encryption) designed by Bruce Schneier (http://www.counterpane.
com).

Twofish encryption component programmed by Dave Barton.

* MDS5 hashing component programmed by Greg Carter.

LZH5 compression algorithm (a Lempel-Ziv-Huffman algorithm) programmed by South Pacific
Information Services Ltd.

GraphicEx (image file handling) library by Mike Lischke (http://www.soft-gems.net).
RBCalendar from Borshack Software Solutions.

ShellBrowser from JAM Software (http://www.jam-software.com).

ZipForge components by ComponentAce (http://www.componentace.com).

Year/month/day planners by Shorter Path Software (http://www.shorterpath.com).

Doodler component created using Image Editor by Greatis Software (http://www.greatis.com).

The Journal 4's original Calendar Charmicons ( & ® € _.) were created by Dan MacDonald.
Additional Calendar Charms were created by Jennifer Holstien and Mickael Pointier.

All trademarks are the property of their respective owners.
Dedication

For Susan, Davis, Serene, & Quaid.

Special Thanks

First, | must thank my wife, Susan, for being there, and for being here. | couldn't have finished The
Journal 7 (or any previous version) without her.

The Journal 7 testers: David Balzotti, Brad Barborak, Brad Barker, Lars Benson, Vicki Bourg, Kieran
Brady, David G. Cooper, Paul E. Dawn, Jr., Mike Ellis, Beth Gardner, Scot Gerardi, James Gill, Craig
Gordon, Fred Gray, Mark Hamilton, A C Harper, Guy G. Hawkins, Donavon Hiss, Ken Jones, Graham
Keys, Ed Livingston, Michael ‘Mac’ McCormack, George McCusker, John S. Martin, David Milligan,
Sandro Perotti, Stan Reinhardt, Doug Renz, Joost Rongen, John Rowney, Mark Sapp, Rich See, Julie
Smith, Susie Stonehill, Marianne Strait, Jeff Toomb, James Walker
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The Journal 7 translators:
¢ Matthias Nagel (German)

Special Thanks from The Journal 6

The Journal 6 testers: Frances Aranda, Joan J. Artus, Brad Barker, Christina Becker, Ben Charron,
David Cooper, Kathy Dunham, Kimberly Elahab, Mike Ellis, Laura Federico, Aaron Grawat, Patricia
Harris, Rebecca Henry, Donavon C. Hiss, Nicole Holzem, Al Jacques, Sue James, Floyd Johnson,
Helga Kocurek, Wayne Lampel, Jock McDonald, Matthias Nagel, Amir Noori, Sandro Perotti, James
Salyers, Rich See, Daniel Shin, Julie Smith, Brendan Stallard, Wandio Tim, Jeff Toomb, Mark
Tyrnauer, Martin Vernhout

The Journal 6 translators:

¢ Matthias Nagel (German)

* Daniel Calbimonte (Spanish)
¢ Hrant Ohanyan (Armenian)

Special Thanks from The Journal 5

The Journal 5 testers: Christina Becker, Vicki Bourg, Chuck Carruthers, Sue Cifelli, Beth Collins, Jim
Cook, Dawn Del Guercio, Emrah Diril, Robert Dunn-Miller, Mark Fassett, James Galiano, Aaron
Grawat, Gary Ingraham, Wesley Jones, Joan Korte, Heather Kuhn, Jim McGowan, Dave McRobie,
Steve Martinez, John Mihnos, Andrew Mitcham, Leslie Moore, Rich O'Brien, Val Peever, Terry
Rickman, James Salyers, Rich See, Julie Smith, Russell Starner, Renger van Nieuwkoop, Ken Virapen,
Bill Watkins, Arthur White, Tenzin Yonten

The Journal 5 translators:
* Baryshnikov Kirill (Russian)
¢ Matthias Nagel (German)

Special Thanks from The Journal 4

My hat is off to Sergey Tkachenko, developer of the TRichView components. The Journal 4 owes a lot
to what Sergey has made possible.

The Journal 4 testers: Brett Allen, Rob Barrett, Patricia Campbell, Trudi Champion, Jim Cook, Kathy
Dunham, Laurie Engle, Laura Federico, Gary Filipski, Len Flier, M. Hamilton, Patricia Harris, David
Hollingworth, Peter Hollyer, Floyd Johnson, Lily Labrecque, Patrick S. Lewis, Michael Lowe, Raphael
Love, Jerry McKee, Kevin McKenzie, Gerard Montigny, John Murphy, Noelle Neuwirth, Craig Nicol,
Oskar Ortiz, Tom Plunket, Cindy Rasmussen, Kenneth S. Rhee, Lisa Smith, Brenden Stallard, Steve
Sutton, Andrew Wray, Mel Yow, Stephen Zeoli

Special Thanks from The Journal 3

| would also like to thank Alexis Balmont-Aoutine, Tony Costanzo, Gary L. Filipski, Brian Ford, Pete
Hollyer, Allen Johnson, Floyd Johnson, Sheila Perry, Tom Plunkett, and Julie W. Smith for their help
with testing the initial release of The Journal 3.

Special Thanks from The Journal 1.x and 2.x

Many thanks to Steve Kellock, Marty Brown, Andrew Williams, Sylvia Lutnes, Lance Perry, Ken
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Marineau, Matej Trampus, Edmo Abreu Mendes Filho, Bernard Beam, Chris Victor, Gary L. Filipski,
John R. Hutchings, and Alexis Balmont-Aoutine.

Buy The Journal
Click Here to Buy The Journal! (only $64.95)

Benefits of Buying The Journal

¢ Keeping a daily journal has never been easier! The Journal always knows what day it is, and
automatically organizes your entries by day, month and year.

¢ Get organized! With The Journal's many options for categories and entries you can be as
organized as you want to be. Keep your personal journal separate from your work notes, or your
dreams separate from your correspondence--but only if you want to.

* Do it Your Way! The Journal has no "agenda"--except to be as useful as possible. Use any
journaling technique or writing style you want, even none at all. It's completely up to you.

* The Journal Newsletter! Sent out monthly, The Journal Newsletter provides tips for using The
Journal, articles about journaling and writing, writing exercises, and more.

* FREE bug-fixes and feature updates! All releases of The Journal 7, whether simple bug-fixes or
major updates, are FREE! *

* FREE technical support via email! I've tried to make The Journal as easy to use as possible, but if
you have any problems, questions, or suggestions, don't hesitate to email DavidRM Software!

* Some releases of The Journal may include modules that must be purchased separately. However, if
these releases also include bug-fixes or other new features, these will be available free of charge.

For pricing information, including special upgrade rates, see The Journal Pricing.

How to Buy the Journal via the World Wide Web

Click Here to Buy The Journal!

Your payment will generally be processed and your Registration Keys emailed to you within 24 hours.

How to Buy the Journal via "Snail" Mail

Print The Journal Order Form, fill it out, and send it along with your payment to:

DavidRM Software
7018 East 78th Place
Tulsa, OK 74133

Please make checks and money orders payable to David Michael.

If you include your email address, you will receive the Registration Keys much quicker. Otherwise, your
Registration Keys must be mailed back to you.

Please allow 10-15 business days for the payment to arrive and be processed.
All payments are processed the business day they are received.
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2.7 The Journal Pricing

The Journal 7 (Download) $64.95
The Journal 7 Complete (Download) $99.95

Amounts are in US Dollars.

Click Here to Buy The Journal!

Discounts Available

The following discounts are available:
Student

Teacher/Educator

US Military (active duty and veterans)
US Law Enforcement
Firefighter/EMT/Nurse

Senior Citizen

Hardship

To purchase The Journal using one of these discounts, contact DavidRM Software.

Upgrade Pricing

People who have purchased any previous version of The Journal are eligible for special upgrade
pricing.

The Journal 7 Upgrade $29.95

To receive your The Journal 7 Upgrade Coupon Code, you must submit your full name, mailing
address, and date of purchase to DavidRM Software (support@davidrm.com).

Your Upgrade Coupon Code will be emailed back to you within 24 hours. Enter this code when you
purchase The Journal 7 and you will receive $35 off the regular price (a 55% discount).

Quantity Pricing

Quantity Price Per

1-9 $64.95
10-49 $61.70
50-99 $58.45

100+ $55.20

To purchase The Journal using Quantity Pricing, contact DavidRM Software.
28 The Journal Order Form

Print this page as an order form.

The Journal Order Form

Full Name

© 1996-2016 by David Michael
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Email Address

Mailing Address

The Journal 7 (Download) $64.95 US
The Journal 7 Complete (Download) $99.95 US
Includes all available add-ons for The Journal (a $170

value).

The Journal Upgrade from any previous version $29.95 US

Upgrade Coupon Code:

NOTE: To receive your Upgrade Coupon Code for The Journal 7, email your full name, mailing
address, and date of purchase to: support@davidrm.com

Send payment to:

DavidRM Software
7018 East 78th Place
Tulsa, OK 74133

Make check payable to: David Michael

Please allow 10-15 business days for the payment to arrive and be processed.
All payments are processed the business day they are received.

Version History

The Journal 7

v7.0.0.1073
Released 1 November 2016

Bugs Fixed

* When rotating tablet display, don't move the category tree position.

After rotating tablet display, some popup forms not displaying properly.
Menus/toolbars sometimes updating their status during close.

Initial entry on startup is being missed in the back/forward buttons.

When using "Lock entries on edit", active entry should be unlocked on minimize.

New Features
* Updated theme engine.
¢ New global theme option: "Theme applies to form borders"
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Updated SSL DLLs.

New entry tree command: "Demote”

New hot-keys for entry tree Promote/Demote (Alt+Left/Right).
Changed hot-keys for back/forward (Shift+Alt+Left/Right)

v7.0.0.1065
Released 3 October 2016

Bugs Fixed

* "Show User Name tabs" global setting isn't being saved.

* When clicking on the calendar on a date that has no entry, if the category has entry time stamps,
default the time stamp to the current time.

Spell checker tab in User Preferences not always scaling properly.

Topics sometimes "highlighting" as unreadable black-on-black.

Not stripping bookmarks from pasted RTF.

Events set to the n-th and m-th days of the week/month not displaying correctly when edited.
When pasting from Firefox, getting an extra space at the beginning of paragraphs.

Entry tree, topics tree, etc., not always scrolling with the mouse wheel.

When typing new text in the middle of highlighted text, the new text isn't keeping the highlight.
When selecting topic(s) from the topic tree, clicking on the topic name should check the box next to
it.

¢ [nsert Media form isn't sizeable.

¢ Shouldn't allow creation of topics with commas.

New Features

¢ Appointment and event reminders now have default charms for done and missed/canceled.
¢ Minor tweaking of menu/toolbars/Ul colors for "Windows" theme.

¢ Backup form is now sizeable, and has "Select/Unselect All" buttons.

® Restore progress form now displays name of Journal Volume being restored.

v7.0.0.1057
Released 29 August 2016

Bugs Fixed

¢ |f the doodler is open during an automatic save, the doodler is being closed.
All open dialogs should respond to tablet rotation.

Can't draw in the doodler with a touch screen.

Can't resize images (or the doodler) with a touch screen.

When entry tree has keyboard focus, it should pass the Paste Special and Paste as Text commands
to the editor.

¢ If an entry has no title, the first line should display as the title above the editor.
® Pressing enter on an indented, blank bullet/numbered item should unindent the item.
* When using WYSIWYG editor, sometimes getting an error when closing The Journal.

New Features
¢ Extended Security features now available to all users.
¢ Updated TRichViewEdit/ScaleRichView (entry editor components).

v7.0.0.1045
Released 8 August 2016
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Bugs Fixed

* In "Search Entries," unable to access results pages past the first.

"Check for Update of The Journal" command not always opening update Web page.

Editor option "Use alternative editor formatting" should disable Uniscribe.

On PC's with touchscreens, the splitters need to be wider.

With the split-screen editor active, clicking on a table cell in the other editor sometimes causing an
error.

* Entry Report Wizard results aren't properly displaying tabs in the entry text.

¢ When using the embedded category tree, category tree is sometimes sized incorrectly on startup.

New Features

* New category option: "Display entry topics in status bar"
® Detect tablet rotation.

* New default options for new and upgrading users.

* New category option: "Display entry count in entry tree"

v7.0.0.1031
Released 25 July 2016

Bugs Fixed

* |n "Styles", clicking Add button twice in a row causes an error.

¢ \When hovering the mouse over an image with a description, it's displaying the description plus some
erroneous extra text.

Some issues when upgrading text styles from earlier versions of The Journal.

In "Shared Categories...", unable to unlink a shared category.

In "Category Properties...", getting an error when linking a shared category.

In "Category Properties...", clicking on "Shared Categories..." should warn the user that all unsaved
changes to categories are about to be applied.

Sometimes getting an error on startup if the splash screen is disabled.

Sometimes not loading the description of an image.

Ul isn't scaling when you set the user interface font to values above the default.

Topic highlights in entry text not always displaying correctly.

Sometimes an odd interaction between certain global options and a custom Ul font size.

Doing a Print Preview of a large batch of entries (1000's) can take a long time.

"Copy Link" is oddly placed in the editor's context menu.

Shouldn't be able to drag-and-drop entries in "Select Entry" form.

If the default category is using the WYSIWYG editor, the first entry loaded on startup is displayed
incorrectly.

"Force bidirectional editing" global option isn't being saved.

Changing "Force bidirectional editing" option shouldn't require a restart to take effect.

Capitalize Words command isn't properly handling contractions with curly apostrophes.

Importing text files (.tdt) is not detecting the BOM (byte order mark).

When typing in a right-to-left language, spaces and punctuation aren't being handled properly.
When switching a paragraph from left-to-right editing to right-to-left (or vice versa), existing text in the
paragraph isn't being displayed properly.

When applying changes to category properties, sometimes not remembering the active category.
Sometimes getting "List index out of bounds (0)." when using Format Painter.

"Backup The Journal" form isn't displaying the most recent backup date.

Don't start a backup on startup without prompting first.

Don't start a backup when closing on Windows shutdown or restart.
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In split-screen editor mode, it's possible to resize the top (or left) editor too small to recover.

New Features

New Format command: "Bullets & Numbering..." Brings up a gallery of available bullets/numbering
options.

New editor context menu commands for "Customize Bullets..." and "Customize Numbering..."
Updated German translation.

Updated TRichViewEdit/ScaleRichView (entry editor components).

Made click-and-drag sliders wider/easier to use on touch screens.

Updated DISqlite3 library.

Added "Sync from Backup File..." to the File menu, Maintenance sub-menu.

v7.0.0.1007
Released 16 May 2016

Bugs Fixed

In "Export Entries to Document...", if exporting the entire journal, password-protected categories are
being exported without verifying the password.

Sometimes seeing "Preparing for search" popup when rearranging entries in the tree.

Dragging and dropping entries to arrange them in a loose-leaf category should set the sorting to
"none".

Sometimes getting "Index out of bounds" errors after selecting text, when trying to apply certain
formatting.

When installing an update to a USB drive or cloud folder, sometimes installing into a sub-folder of the
intended folder (e.g., "The Journal 7\The Journal 7").

Batch Entry Import should make better use of database transactions.

When doing a Batch Entry Import of a CSV file, entries on the same date are ending up with the
same first line display.

In "Table Properties”, Cell Padding (on the Table page) and Cell Width and Cell Height (on Cell page)
are displaying incorrect pixel values.

New Features

New Batch Entry Import option: "InfoSelect v8/v9"
New Batch Entry Import option: "Jorte (diary) CSV file"

Default Entry Templates now always load for all new calendar entries, even entries on past and future
dates.

Updated Diaro import.
Updated DISqlite3 library.

v7.0.0.987 - Interim Update
Released 7 March 2016

Bugs Fixed

Clicking on a folder-only category in the category tree is causing an error.

"Match whole words only" option in Search Entries forming incorrect search query.

In "Category Word Cloud", clicking on a folder-only category with no entries causes an error.
Highlighted text not always being automatically spellchecked.

When typing a new first line of an entry, entry tree isn't immediately showing the new text.
Headings in imported/pasted HTML are too big.

Search Entries not handling curly apostrophes well.

Rulers and text aren't matching up in WYSIWYG mode.
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When sorting loose-leaf entries by ftitle, if an entry has no title it should use the first line.

When using larger Ul sizes, the customize toolbar form isn't scaling.

When pasting HTML via Paste Special, bookmarks aren't being stripped.

Format menu commands Font, Paragraph, and Paragraph Borders aren't working on text inside
tables.

Reading dates from INI files sometimes having an error.

Some popup forms having a few pixels cut off on the right side.

In "Table Properties”, values for border widths, cell spacing and cell padding aren't being properly
set.

Sometimes getting an error when opening an entry with a table in WYSIWYG mode.
"Daily/Weekly Reminder Report" is always reporting "No entries to report.”

New Features

New option: "Indexed Searching Type" (can be either Word or Character).

New option: "Default Category Type" (can be either Calendar or Loose-leaf)

New word-based indexed search tokenizer that recognizes in-word apostrophes (e.g., "can't") and in-
number commas and decimal points (e.g., "10,000.01").

Category tree now remembers expanded/collapsed state between sessions.

New command "Create New Entry for Now" (hot-key: Ctrl+Shift+F9) (on the Entry menu).

New option in Category Properties: "Display entry title in entry tree"

v7.0.0.969
Released 1 February 2016

Bugs Fixed

Sometimes getting "Divide by zero" error on startup.

On "Apply Topic" form, autocomplete list is being cut off, and isn't showing scrollbar.

In Batch Entry Import, a blank line in a CSV file is causing an "Index out of bounds" error.
Daynotez CSV file format has changed.

Toolbar icons should scale a bit smaller on higher DPI monitors.

Loose-leaf search results in entry tree aren't always clear.

Inserted media file names not displaying with category's default font color.

Search tab won't stay active when switching to another category and back.

Sometimes getting "Index out of bounds" error when changing font color from toolbar dropdown
menu.

"Journal Volume may be open already" message pops up unnecessarily.

The "Go to Bookmark" and "Insert Template" sub-menus get confused if a category has both
bookmarks and templates.

When you end a paragraph with Italics text, then either click the "I" button or use CTRL+I to return to
normal text, and then hit ENTER for a new paragraph, the text formatting reverts back to Italics in the
new paragraph.

Entry title display above entry editor needs to be centered a bit to the left to accommodate editor
scrollbar.

If the first line of text in an entry is in a table, it's not being displayed in the entry tree.

Reminder charms in entry reports aren't vertically centered on the line.

In the print preview of Entry Report Wizard results, report name header is a bit to the left.

New Features

Updated German translation.
Updated DISqlite3 library.
External entry links (links to entries from outside The Journal).
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Added "Manage Bookmarks" command to Go menu.

Added "Show Categories as Tabs" and "Show Categories as Tree" commands to the Category menu,
and the category tab/tree context menus.

* New option for category tree layout: "Embed category tree in entry user interface"
New option for category tree layout: "Show category name above entry"

v7.0.0.951
Released 16 December 2015

Bugs Fixed

¢ When upgrading entries, sometimes choosing a heading style when a Normal-based style makes
more sense.

* |In Search Entries, can't search for & (ampersand) character.

* |n Search Entries, the search results aren't updated after clicking "Update Search Index for All
Categories".

* The background color for empty entries isn't being saved.

¢ Cannot customize keyboard shortcut for "Calendar”, "Entry Tree" and "Timer" on the View menu.

New Features
* New flat themes: Metro Black and Metro White.

v7.0.0.945
Released 20 October 2015

Bugs Fixed

* Improved extraction of image caption/title/description from JPG files.

¢ |f there is an error in creating the database backup file, abort backup process and report.

* Toolbar icons, entry editor status bars, and the theme preview aren't scaling to match user interface
size.

Some of the default entry background images are too small for newer 4K monitors.

Can't right-click on an animated GIF and get the "Image" sub-menu.

When showing week numbers on calendar, Create New Entry form's calendar isn't wide enough.
Sometimes getting an error when editing topics.

"Keep all active calendar categories on the same date" option isn't working.

"Missed Reminders" and "View All Reminders" aren't properly displaying the reminders when larger
user interface sizes are active.

New Features

* Updated DISqlite3 library.

¢ Added new option: "Create New Entry prompts for entry date (calendar categories only)".
¢ Added new option: "Create New Entry defaults to today's date (calendar categories only)"

v7.0.0.935
Released 14 September 2015

Bugs Fixed

* Improved extraction of image title/description from JPG files.

* When changing a topic's color in "Edit Topics", current entry isn't showing the change right away.

¢ When running "The Journal 7 Repair Utility" shortcut, if you choose to make a backup, there is an
error.
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When typing in a topic name on Apply Topic(s) form, pressing comma should automatically select the
first item in the autocomplete list.

Editing a table's width in Table Properties isn't working.

If the automatic backup on starting The Journal has an issue, it stops The Journal from opening
properly.

When using "Save Image as..." on image entries, the file name and extension aren't being set
properly.

Backup process should verify the size of the backup file created.

New Features

Updated DISqlite3 library.
Updated Diaro import.

v7.0.0.923
Released 11 August 2015

Bugs Fixed

"The Journal Support Page" link on the Help menu is going to the main Web page, not the support
page.

After inserting a table with auto-size set, the first time you type in the table, it shrinks.

Edit Properties & Layout for images and objects isn't properly handling spacing and width/height.
Inserted images are smaller at "full size" than they used to be.

When printing entries with images in them, the sizes are off.

Insert Date, Insert Time and other insert commands with hot-keys aren't active in the full-screen
editor.

Need to extract UserComment from JPEG ExIf in addition to ImageDescription.

"Get Web Page" command should be able to download more images.

If an image in the editor has been stretched (either larger or smaller), clicking on "Toggle Image Full/
Thumbnail" should set it to full size, not to thumbnail size.

v7.0.0.917
Released 27 July 2015

Bugs Fixed

When deleting a category in Category Properties, still sometimes getting an access violation when
applying.

When using category tabs, if active or default category is a sub-category, the tab displays blank after
editing Category Properties.

When using Large (or larger) User Interface Size, some forms aren't being properly resized.

In User Preferences, there is no way to reset the user interface font to the default.

When switching to a larger user interface size, the calendar isn't resizing to the proper height.

After applying a font with a name like "Segoe Ul Light", you can no longer apply a font with a
substring of that name, like "Segoe UI".

When using the arrow keys in the entry tree to move up and down the entries, keyboard focus is
shifting to the entry editor.

Not locking Ul when minimized by the Windows "Show Desktop" and "Minimize All" commands.
Unable to reset user login password.

Not acquiring an exclusive transaction lock on System db in some cases.

When the split editor is active, the relative sizes of the panes aren't tracking when The Journal is
resized.

When the split editor is active, the relative sizes of the panes aren't being saved between sessions.
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Style and paragraph formatting forms aren't properly supporting Metric measurements.

Metric measurements should all be millimeters for consistency.

When upgrading entries from previous versions that contained applied topics, sometimes setting the
topic text to "Block Quote" style.

Paragraph border and background offsets and paddings are being applied inconsistently.

"Insert Image..." form can't be resized.

Non-recurring reminders should always display their current status.

When pasting HTML, should remove all checkpoints (HTML anchors) from the pasted text.

When doing a "Search Entries by Topic", the first (oldest) entry isn't being searched.

When a reminder pops up and The Journal is minimized or "behind" other programs, The Journal's
task bar button isn't blinking.

New Features

Added support for importing EfficientPIM CSV files to Batch Entry Import.
If a JPEG image file has an image description, it is loaded by default.

v7.0.0.903
Released 1 June 2015

Bugs Fixed

On Search Entries form, have to un-click and re-click "Show recent entries first' checkbox to make
the option take effect.

On Search Entries form, "Show recent entries first" should be the default.

On Search Entries by Topic form, "Automatically Select/Unselect sub-topics" option isn't being saved.
When deleting a category in Category Properties, sometimes getting an access violation when
applying.

Insert Symbol form displays the available symbols very small.

When creating a new holiday reminder, trying to set the date to the 3rd Monday of the month isn't
working.

When "Capitalize first word of a sentence" is active and The Journal is running under a Windows
emulator, getting an error while typing in the entry editor.

When the timer is displayed, the "Time Remaining" field should have keyboard focus.

In Category Properties, when creating a new category, the new category should be added to the end
of the list.

In Create New Category, the "Make new category a sub-category of" list isn't always properly sorted.
When inserting a word processor file into an entry, sometimes getting "Style X does not exist" error.
When using "Capitalize Words" on the Reformat menu, the first word of paragraphs after the first
paragraph is sometimes being lowercased.

v7.0.0.897
Released 11 May 2015

Bugs Fixed

Pressing "Buy The Journal" sometimes opening up Notepad instead of browser.

If user has a default category set, and that category is made inactive, can cause errors when editing
category properties.

When selecting an entire paragraph and applying a paragraph style, paragraph settings aren't being
applied.

Cannot indent bullets or numbered lists inside a table cell.

Penzu import should adjust time stamps for the local time zone.

When importing Penzu entries, getting false positives on entry conflicts.
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Category Word Cloud isn't respecting categories with passwords.

When inserting date/time after an open parenthesis, inserting an extra space before the date/time.
Minor improvements (one hopes) to toolbar and menu colors.

When spell checking contractions with curly apostrophes, straighten first.

When adding contractions to spell checker with right-click menu, curly apostrophes aren't being
straightened.

¢ When "Display reminders/events from MS Outlook" is active, sometimes getting an error when
opening calendar categories.

v7.0.0.893 - Initial Release
Released 24 April 2015

April 2015: "The Journal, Evolved!" The Journal turned 18 years old in June of last year (making it
my second child to reach voting age). The Journal 1 was written for Windows 95, and supported only
daily entries. No "Notebook" category. No reminders. And | was the only one using it. =)

So much has changed since then. The Journal has been in almost constant development, growing and
evolving from the feedback of the many, many incredible users who have contacted me over the years,
sending in suggestions and bug reports and wish lists. With The Journal 7, | hope to have granted more
than a few wishes, including some of my own.

The Journal 7's new features:

* Search anywhere! See lightning-fast search results in any category. Search results update as you
type. Plus, in-entry searching has been made even better, making it easier to see search terms and
navigate between them.

* Search everything! The new, improved Search Entries shows you search results as you type, and
allows you to easily add or remove entire categories from your search. Plus, you can now save your
searches.

¢ More word-processing power! Format your text with new, more powerful styles, including many
new options at the paragraph and character levels. Use typographical quotes and apostrophes (AKA
"curly quotes"). View two entries at once with split-screen editing. Shut out the world and focus on
your writing with the new distraction-free, full-screen editing mode. Search-and-replace within all
entries of a category. Save and load DocX files.

* More flexible user interface! Display your categories as a tree or nested tabs. Color-code your
categories. Sort your loose-leaf entries by name, date created, or even last date updated. Fully
customize menus, toolbars, and even command hot-keys.

* Word clouds! See word clouds for your categories based on your entry text or on the topics you
have assigned to your entries.

¢ Better integration with Windows 8 (and whatever comes next)!

* New visual themes! The Journal 7 includes a new set of visual themes and a more cohesive look-
and-feel (but you can still use the old skins, if you want).

* Improved security! With salted passwords and a new layer of encryption, The Journal 7 keeps your
entries safer than ever.

* Recover accidentally deleted entries!

¢ Streamlined backup, restore, and upgrading!

The Journal 6

June 2012: My mission statement for The Journal 6 was: "The Journal, Even Better!" | wanted to
make The Journal easier to use, while also adding some powerful new features like synchronizing and
indexed text searching. Work on The Journal 6 began in June 2011 while my wife and | were waiting for
our 3rd child to arrive. He was late, but was eventually induced to make his appearance. Which
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appearance then seriously slowed The Journal 6 development for a while. :-)

The Journal 6 new features:

¢ Lightning-fast searches! Even if you have thousands of entries in hundreds of categories,
searching them is fast and easy.

¢ Synchronize multiple copies of The Journal! Have The Journal on your laptop at work and your
desktop at home? Keeping them in sync is easier than ever. You can sync from another Journal
Volume, a backup file, or any of The Journal's export files.

* Synchronize The Journal with your mobile- and tablet-based software! Import your entries and
notes from such products as Evernote, Penzu, and more. The Journal also supports exporting to the
Xml-based ATOM publishing format which can be imported by other products.

¢ Use The Journal with automatic backup/sync-ing software! The Journal's new, single-file
database configuration is faster, takes up less space on your hard drive or USB/Flash drive, and
makes it much easier to use with products like DropBox.

¢ More!

Improved printing, exporting, and importing!

New Entry Report Wizard (on the Tools menu), with new and improved reports!

Improved topic support and reporting!

Improved international character support, including Insert Symbol (on the Insert menu)!

More options for categories, including specifying the day the week starts and sorting options

for loose-leaf entries.

* New entry editor options like linking images, a running word count on the status bar, improved
highlighting, and format painter.

v6.0.0.779 - Released 21 October 2014
v6.0.0.773 - Released 15 September 2014
v6.0.0.767 - Released 5 August 2014
v6.0.0.765 - Released 4 August 2014
v6.0.0.759 - Released 30 June 2014
v6.0.0.751 - Released 2 June 2014
v6.0.0.743 - Released 31 March 2014
v6.0.0.739 - Released 3 February 2014
v6.0.0.727 - Released 6 January 2014
v6.0.0.721 - Released 4 December 2013
v6.0.0.719 - Released 4 November 2013
v6.0.0.709 - Released 3 October 2013
v6.0.0.705 - Released 27 August 2013
v6.0.0.693 - Released 1 August 2013
v6.0.0.691 - Released 10 June 2013
v6.0.0.675 - Released 9 April 2013
v6.0.0.669 - Released 12 February 2013
v6.0.0.657 - Released 11 December 2012
v6.0.0.635 - Released 7 November 2012
v6.0.0.621 - Released 26 September 2012
v6.0.0.609 - Released 6 August 2012
v6.0.0.597 - Released 18 July 2012

V6 (v6.0.0.589) - Released 9 July 2012

The Journal 5.1

December 2009: The Journal 5.1 is a feature update and bug-fix of The Journal 5. Work on The
Journal 5.1 began in late October 2009. My goal for The Journal 5.1 was to add some of the features
that had been planned for the initial release of The Journal 5 but, due to time constraints, had been put
off to the future.
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The Journal 5.1 fixes some bugs (see the list below), updates a few third-party components, and adds

some significant new features:

¢ Improvements to skinning and more new skins! Many of the skins have been updated, including
The Journal's default skin (BlueBrilliant).

¢ New toolbar icons for a number of commands, plus the option to use The Journal 4's icons for
toolbars, menus and the entry tree.

* Localization support - As new language translations of The Journal become available, they will be

added.

Improvements for using The Journal over a network with multiple simultaneous users.

View your Outlook calendar reminders in The Journal!

Support for "Quick Blogcast" blog tool and new blog posting options.

And, finally, you can wrap text around images in your entries!

.0.497 - Released 11 April 2012
.0.489 - Released 14 February 2012
.0.481 - Released 14 November 2011
.0.469 - Released 8 August 2011
.0.461 - Released 6 June 2011

.0.453 - Released 24 January 2011
.0.451 - Released 27 December 2010
.0.435 - Released 4 October 2010
.0.427 - Released 10 May 2010
.0.417 - Released 3 March 2010
.0.409 - Released 27 January 2010
.0.407 - Released 25 January 2010
(v5.1.0.393) - Released 15 December 2009

The Journal 5

July 2009: My plan for The Journal 5, which began development in September 2007, can be summed
up as "The Journal Even Better". | wanted to improve all the major parts of The Journal--the database,
the internal data structures, the user interface--and provide more support for international users. Plus |
wanted to offer additional category and entry options, more reports and other tools, and, finally, to offer
a selection of "skins" for the user interface.

SRR R RN R RORO R RORO RS

| think | achieved most of that--even if it took a bit longer than | expected.

In short, The Journal 5 is an inside-out redesign of The Journal, preserving all the great journaling and
writing features that have accumulated over the years and adding some cool new features and
capabilities.

The Journal 5 adds lots of significant new features:

Updated user interface:
® Choose your favorite "skin" from the many, many available (180+).
* Quickly switch between logged in users and open Journal Volumes with their (optional) tabs.

Updated Journal Volumes:
* No more 2 GB limit. Store up to 128 GB in your Journal Volumes.
* Have as many Journal Volumes as you want, all open at the same time.

* Be more secure with the improved backup and restore features, with options to copy your backup file
to separate locations automatically.
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More category options:
* You can have categories that create new entries for you every century, decade, year, month, week,

day, and hour.
See a month or a year at a time with the new month and year calendar views.

Use the day planner to see your reminders for today or the whole week.
Automatically "stamp" your entries with current date and time.
Edit your entries with WYSIWYG (what-you-see-is-what-you-get) formatting.

More entry options:
® Your calendar category entries can have loose-leaf sub-entry "attachments".
* Drag and drop entries between categories with ease.

* Select multiple entries and copy (or cut) them to the Windows clipboard--then paste those entries into
another category of The Journal or even into a word processor like MS Word.

¢ |nsert media files (audio & video) into your entries, and play them back within The Journal.

¢ Take advantage of the new (optional) grammar checking features to automatically change i to | and
automatically capitalize the first word of a sentence.

* Use topics to mark blocks of text within an entry, or to tag an entire entry.

* Be even more organized with topics that have sub-topics (that have sub-topics, that have sub-
topics...).

¢ Easily wrap text around inserted images.

More search options:

¢ Automatically include sub-topics when searching by topics.

¢ Search for multiple topics with either AND (all) or OR (any) logic.
¢ Search in reminder notes.

¢ Limit your search to whole words.

And more:

® See your MS Outlook calendar reminders in The Journal.

* Export your categories and entries to HTML and get a Web-page-like list of categories and entries.

* Create a wiki-like set of entries with automatically updated links.

* Run a report of those entries that you've created or updated in the last week, month, year or other
date range.

* Post to Blogger (Google) without getting an annoying error message (and lots of other minor fixes and
changes).

v5.0.0.367 - Released 5 October 2009
v5.0.0.359 - Released 21 September 2009
v5.0.0.355 - Released 9 September 2009
v5.0.0.347 - Released 31 August 2009

v5.0 (v5.0.0.341) - Released 26 August 2009

The Journal 4.1

(March 2006 - August 2009)

March 2006: Though not a major upgrade like the one from v3 to v4, The Journal 4.1 is still a significant
step forward. Reminders & Tasks have now been added to The Journal, supplying whole new ways you
can use The Journal to organize your life and life's work. Set reminders for daily tasks, monthly
appointments, special days and anniversaries, and more! And with the new entry locking features for
shared categories, The Journal edges closer to becoming a true multi-user, maybe even a collaborative,
platform. | look forward to building on all of the 4.1 additions and changes as The Journal continues to
grow.
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August 2007: The last major new feature added to The Journal 4.1 was the option to have multiple
entries on a given date. Such an obvious feature (in retrospect), and yet added so late. I'm always
surprised by how The Journal continues to evolve.

v4.1.0.253 - Released 5 February 2008
v4.1.0.247 - Released 10 December 2007
v4.1.0.241 - Released 15 October 2007
v4.1.0.239 - Released 9 October 2007
v4.1.0.237 - Released 4 September 2007
v4.1.0.231 - Released 13 June 2007
v4.1.0.229 - Released 11 June 2007
v4.1.0.219 - Released 8 May 2007
v4.1.0.213 - Released 23 April 2007
v4.1.0.207 - Released 19 February 2007
v4.1.0.195 - Released 4 December 2006
v4.1.0.189 - Released 2 October 2006
v4.1.0.181 - Released 12 June 2006
v4.1.0.177 - Released 26 April 2006
v4.1.0.175 - Released 17 April 2006

The Journal 4

(November 2004 - March 2006)

August 2004: Though the story of The Journal 4 lacks the drama of The Journal 3's grueling
development period, it's an important upgrade nonetheless. Built on the foundation created in v3, v4
takes The Journal to new levels of power and ease of use.

Work on The Journal 4 began in December 2003, with early efforts centered on switching from using
the Windows Rich Text Common Control to the very powerful TRichView components created by
Sergey Tkachenko. This was a huge change, both in source code and in philosophy, because The
Journal was originally built around the rich text edit, and probably would not have existed except for that
feature of Windows 95. After years spent tweaking and cajoling (and cursing) the rich text edit to get it
to do things that Microsoft probably never meant for it to do, | suffered a few withdrawals. However, this
one change, by itself, made possible a large portion of The Journal 4's new features, including
background images for entries, print preview, tables, and on and on. So I'm past the withdrawals now,
and not looking back.

With the new entry editor in place, | shifted to adding numerous other features that users have asked
for over the years, such as n-depth category nesting, user-created Calendar Charms, and daily/weekly
reporting. Beyond user requests, there were other extensions that | wanted to make, such as the ability
to install and run The Journal on read-only CDROM's, that would make The Journal more stable overall
and useful in new arenas.

By late August 2004, | had implemented the last of the planned additions and on 1 September | handed
The Journal 4 over to a small group of testers. There's nothing like user testing to help smooth out a new
interface and add the necessary polish to new features--and point out the obvious features and
extensions you somehow forgot.

The Journal 4 added:

¢ A more modern look-and-feel
* |Improved editing capabilities, including:
¢ Background images for entries
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More powerful and more flexible text styles
Improved image handling (faster saving and loading, resizing, and more)
Tables
HTML importing and improved HTML exporting
Paragraph borders and background colors
Outline mode
Improved bullets and numbering
Improved auto-replace, supporting both formatted and unformatted text
* Assigning topics to blocks of text within an entry
® Improved printing, including print preview
* Improved searching, with:
* Google-like results presentation, with excerpts of found text and links to the found entries
® Search text highlighting in found entries
¢ Date range limiting for standard categories
® Searching by topic, or by image description
Daily/weekly/etc "reporting” for standard categories, with printing
Support for user-created Calendar Charms and entry background images
Improved blog support, with posting of images (if the blog supports posting images)
Web page "archiving" within entries
Improved arranging of loose-leaf entries and categories
Improved category "nesting", so you can have sub-categories of sub-categories of sub-categories
of...
New category options likes "Read Only" and "Folder Only"
¢ The ability to install and run The Journal on self-contained, removable media, like a USB flash drive or
CDROM
¢ Improved database speed and security

v4.0.0.163 - Released 6 December 2005
v4.0.0.161 - Released 24 October 2005
v4.0.0.157 - Released 26 September 2005
v4.0.0.153 - Released 29 August 2005
v4.0.0.147 - Released 20 July 2005
v4.0.0.145 - Released 13 July 2005
v4.0.0.141 - Released 11 April 2005
v4.0.0.137 - Released 2 February 2005
v4.0.0.135 - Released 24 January 2005
v4.0.0.133 - Released 29 December 2004
v4.0.0.127 - Released 8 December 2004
v4.0.0.123 - Released 2 December 2004
v4.0 - Released 29 November 2004

The Journal 3

(November 2001 - November 2004)

(November 2001): The Journal 3 is a complete re-design and re-write of The Journal, incorporating
years of accumulated feedback and suggestions. Since The Journal was first released in 1996, users
have sent in their suggestions for features and extensions. As much as possible, these suggestions
were incorporated. But some suggestions were beyond what the original design of The Journal could
tolerate. There was only so far that The Journal's feature set could be stretched without starting over
from scratch.

© 1996-2016 by David Michael



34

The Journal

Begun in the summer of 1999, development on The Journal 3 proceeded slower than expected. Those
initial delays were caused by several factors. | was (and still am) co-owner of another software
company (Samu Games, http://www.samugames.com) and other projects came up that stalled the
development of The Journal 3. Plus there was the ever-present need to support the current version of
The Journal. By the end of 1999, only The Journal 3's new database configuration was completed.

In 2000, two major projects with Samu Games prevented significant work on The Journal 3. The Journal
2.3 was released in early 2000, and The Journal 2.4 was begun in the fall of the year. Though the 2.3
release was a relatively straightforward update of The Journal 2.2. The 2.4 release incorporated some
of the features that had been designed for The Journal 3. New word processing features (like numbered
lists and multi-level undo), improved image handling, and especially the new export/import format were
all from work done for The Journal 3.

Most of the work on The Journal 3 that occurred during 2000 was on the new user interface. There was
a lot of experimentation with new layouts, new configurations, and new ways of representing the
categories and entries in the database. Some of it worked, and was kept. A lot of it, though, proved "iffy
at best" and was discarded (or turned into a "user preference", default off).

In March 2001, following the release of The Journal 2.4, | realized that | had spent too much time on
"research and development". If | expected to release The Journal 3 in this lifetime, | was going to have
to stop thinking up new features to add and experiment with. So the feature set of The Journal 3 was
"frozen", and | began working on getting The Journal 3 done.

Interestingly enough, while The Journal 3 already sported quite a few features that The Journal 2.x
would never be able to duplicate, The Journal 2.x had many more features that had not yet been
implemented in The Journal 3. So to get The Journal 3 "done" | had to get all of the existing 2.x features
working in the new version. Everything from simple options like "minimize to system tray" to more
complex features like entry templates had yet to be added to The Journal 3.

This turned out to be the single largest effort in the development of The Journal 3. The Journal had
accumulated quite a few features in its 5+ years, and re-doing them for The Journal 3 proved to take
more time than | estimated. In August 2001, 6 months later, the last of the 2.x feature set was finally
added to The Journal 3.

In September 2001, The Journal 3 was handed over to a small number of volunteers to see how it would
stand up. With their help, most of the bugs and issues were found and either fixed or resolved. The last
bit of testing and polishing occurred when The Journal 3 "pre-release version" was made available in
mid-November.

The Journal has already grown beyond my original vision for the project. I'm excited to see what new
directions the product will head in the future.

2004 Afternote: The Journal grew significantly after the initial release of v3. Here's a list of the major
improvements and features added to The Journal 3 from November 2001 to October 2004:

Improved printing

Improved "Search Entries..."

Improved entry navigation

Improved entry templates

Improved initial defaults for new users

Improved entry export and import

Improved user interface, including lots of new hot-keys
Improved entry links and internet links

Improved database maintenance

Improved documentation
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Calendar Charms

Add-on package support
MemoryGrabber add-on package
Writing Prompts 1 add-on package
Blog support

v3.0.0.73 -Released 19 January 2005
v3.0.0.71 -Released 22 September 2004
v3.0.0.67 -Released 13 July 2004
v3.0.0.65 -Released 13 April 2004
v3.0.0.63 -Released 6 April 2004
v3.0.0.61 -Released 10 February 2004
v3.0.0.59 -Released 29 December 2003
v3.0.0.57 -Released 15 December 2003
v3.0.0.51 -Released 6 October 2003
v3.0.0.49 -Released 15 July 2003
v3.0.0.47 -Released 9 July 2003
v3.0.0.45 -Released 10 April 2003
v3.0.0.43 -Released 24 February 2003
v3.0.0.41 -Released 9 December 2002
v3.0.0.39 -Released 26 August 2002
v3.0.0.35 -Released 2 April 2002
v3.0.0.33 -Released 18 February 2002
v3.0.0.31 -Released 12 February 2002
v3.0.0.27 -Released 6 February 2002
v3.0.0.25 -Released 4 February 2002
v3.0.0.23 -Released 7 January 2002
v3.0.0.21 -Released 17 December 2001
v3.0.0.19 -Released 3 December 2001
v3.0  -Released 28 November 2001

The Journal 2

(September 1998 - October 2001)

The Journal 2.0, released in September 1998, built on the feature set that had been finalized in the 1.51
release. More word-processing and security features were added, and database maintenance and
stability were greatly enhanced. Throughout the 2.x series of releases, The Journal continued to mature,
though not at the same pace as before. Refinement and extension replaced a headlong rush to add new
features. The 2.4 release of The Journal, coming nearly a year after the previous release, was the most
significant of the 2.x updates after 2.0.

V2.43 - Released September 28, 2001.
Vv2.42 - Released August 20, 2001.
v2.41 - Released April 16, 2001.

Vv2.40 - Released February 9, 2001.
v2.30 - Released April 7, 2000.

Vv2.20 - Released December 6, 1999.
v2.11 - Released June 21, 1999.
v2.10 - Released April 5, 1999.

v2.02 - Released February 1, 1999.
v2.01 - Released November 11, 1998.
v2.00 - Released September 30, 1998.
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The Journal 1

(October 1996 - August 1998)

v1.30 was the first shareware release of The Journal, made available in October, 1996. This was a
period of expanding features for The Journal. Hardly a month went by without a new release coming out
with more features--and bug-fixes for previously added features. This "growth spurt" period went on for
nearly a year before finally slowing down.

With the release of The Journal 1.5 in January, 1998, The Journal became a mature software product.

v1.51 - Released February 20, 1998.
v1.50 - Released January 30, 1998.

v1.44 - Released December 12, 1997.
v1.43 - Released September 26, 1997
v1.42 - Released July 19, 1997

v1.41 - Released July 1, 1997

v1.40 - Released June 28, 1997

v1.39 - Released June 7, 1997

v1.38 - Released March 23, 1997

v1.37 - Released February 9, 1997

v1.36 - Released January 12, 1997

v1.35 - Released December 29, 1996

v1.34 - Released December 13, 1996

v1.33 - Released November 25, 1996

v1.32 - Released November 15, 1996

v1.31 - Released October 14, 1996

v1.30 - First Shareware Release October 11, 1996

The Journal 1 - The Freeware Days

(June-September 1996)

The Journal started out as a quick project, mostly as a way to learn how to use Delphi. Fittingly, most of
the original users of The Journal were other Delphi programmers who downloaded it from the various
"Made in Delphi" web pages. Feedback from these and other users prompted me to extend The Journal
significantly, and release it as shareware.

v1.21 - Released August 12, 1996

v1.20 - Released August 9, 1996

v1.1 - Released July 8, 1996
v1.0 - Initial Release. June 18, 1996

What's New in The Journal 7

Journaling, Evolved!
Keep a diary! Maintain a knowledgebase! Write a book! You can do it all with The Journal 7!

More Power!
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* Search anywhere! See lightning-fast search results in any category no matter how many entries you
have. Search results update as you type. Plus, in-entry searching has been made even better,
making it easier to see search terms and navigate between them.

* Search everything! The new, improved Search Entries shows you search results as you type, and
allows you to easily add or remove entire categories from your search. Plus, you can now save your
searches.

* More writing power! Format your text with new, more powerful styles, including many new options at
the paragraph and character levels. View two entries at once with split-screen editing. Shut out the
world and focus on your writing with the new distraction-free, full-screen editing mode. Search-and-
replace within all entries of a category.

* Word clouds! See word clouds for your categories based on your entry text or on the topics you
have assigned to your entries.

¢ Improved printing, exporting, and importing!
* Improved topic support and reporting!
¢ Improved international character support!

¢ Improved image/photo support, including image rotation, thumbnails, and doodling (directly in the
entry or on other images)!

¢ Improved media file support, with playback using Windows Media Player!

* More options for categories, including specifying the day the week starts and sorting options for
loose-leaf entries.

* New entry editor options like hot-linking images, a running word count on the status bar, format
painter, and improved text highlighting.

* New Entry Report Wizard (on the Tools menu), with new and improved reports!

Improved Security & Stability!

* Recover accidentally deleted entries!

¢ Streamlined backup, restore, and upgrading!

¢ Easily use The Journal with automatic backup/sync-ing software! The Journal's new, single-file
database configuration is faster and uses less space on your hard drive or USB/Flash drive, and
makes it much easier to use The Journal with products like DropBox.

* Improved security! With salted passwords and a new layer of encryption, The Journal 7 keeps your
entries safer than ever.

More Convenience!

* More flexible user interface! Display your categories as a tree or nested tabs. Color-code your
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categories. Sort your loose-leaf entries by name, date created, or even last date updated. Fully
customize menus, toolbars, and even command hot-keys.

New visual themes! The Journal 7 includes a new set of visual themes and a more cohesive look-
and-feel (but you can still use the old skins, if you want).

Synchronize multiple copies of The Journal! Have The Journal on your laptop at work and your
desktop at home? Keeping them in sync is easier than ever. You can sync from another Journal
Volume, a backup file, or any of The Journal's export files.

Synchronize The Journal with your mobile- and tablet-based software! Import your entries and
notes from such products as Evernote, Penzu, and more. The Journal also supports exporting to the
Xml-based ATOM publishing format which can be imported by other products.

Give your tired eyes a rest! Today's high-def displays (especially newer tablet displays) come with
tiny print that can be very hard to read. The Journal 7 includes new, easier-to-read toolbar icons, and
lets you see what you're typing!
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3.1

How to Use The Journal

Step 1. Getting Started

The first things you have to do after installing The Journal are create your first Journal Volume and your
login name and (optional) password.

Don't worry: Most users can just click right through these and use the default settings.

Step 2. Making Entries

Once you have your login name and password, you can run The Journal and start making entries and
printing entries. And since you almost certainly want more than text in your entries, this section shows
you how to insert images and media filesinto your entries.

Step 3. Using Categories

The Journal automatically creates a "Daily Journal" category and a "Notebook" category for you. But
you aren't limited to just those. This section describes the difference between a calendar category and
a loose-leaf category, and shows you how to create a new category.

Step 4. Creating Additional Logins

Want your spouse to have his or her own login (with password) in The Journal? This tells you how to
create a new user login.

Step 5. Creating Additional Journal Volumes

One Journal Volume is enough for most users, but if you need more than one, this section tells you how
to create a new Journal Volume.

Step 6. Maintaining The Journal

Finally, this section gives you the basics of backing up your entries.

Also check out the Frequently Asked Questions.

Getting Started

The first time you start The Journal, the New User Wizard is run automatically to help you.
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Welcome to The Journal!

New Users:
Click on Next to get staried using The Journal right away!

Rerurning Users:

Choose the opiion that best deseribes your siuation:

+ [ have just installed (or re-installed) The Journal.

= I need w restore from a backup of The Journal.

+ | am upgrading from an earlier version of the The Journal..

Click on Mext to continue, of choose one of these other options
1 1 have just installed (ar re-installzd) The Jaurnal.
I need ta restore from a backup of The houmal
1 am upgrading from an earer version of The Joumal

[ weonald e 10 choose the location for The Joumal data Tiles.

| b e

Don't worry: Most users can just click right through these and use the default settings.

The most important part of this process is Creating your login name.

Once you've done that, you're ready to start making entries in The Journal.

3.1.1 Creating Your First Journal Volume

Unless you check the option "I would like to choose the location of The Journal's data files”, The
Journal will handle this step for you automatically. Otherwise, you will be taken automatically to the next
step: Creating Your Login Name.

What is a Journal Volume?

A Journal Volume is an "entry database". The Journal Volume created during this step will hold your
login name, your categories, and all of your entries.

) The Joursal - Bew User Wizard d

‘What would you like to call your Joumal Volume?
Joumal Valume Name

My Joamia
Joumal Valumes Foker
AThe Jowrnal Volumes 7

Use Existing Joumal Valume

‘What is a "Jownal Volume™?
A Joumad Volume 5 an “enbry database” for The lournal, A loumal Volume -
can comain one ar mare user logirs and all of their categoies and enbries,

The Joumal supparts multiple aumnal Yolumes, each m a unique folder,
Hawever, most wsens of The Joumal will only need a single Journal Velume,

lournal Vodumes can be placed on any available hard drive, internal ar

extemal of Network altached, or even removabile thumb diives. Each
Journal Volume must bhave & unigue name.

4 Hack | b Hest

If you are unsure about the Journal Volume, simply accept the default settings by clicking on Next.

NOTE: The default settings are recommended for most users.

Journal Volume Name
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3.1.2

The default Journal Volume name is "My Journal”. You can set this to be any nhame you want.

The Journal Volumes Folder

The Journal Volumes folder is the path where your first Journal Volume will be created as a sub-folder.
If you later create additional Journal Volumes, they will also use this same base path.

The default path for the Journal Volumes folder is:
My Documents\The Journal Volumes\7\

If you are installing The Journal on a USB/external hard drive, the default path is relative to the installed
path:
\\The Journal Volumes\7\

See Journal Volumes for more information about Journal Volumes.

Creating Your Login Name

Your login name and password are how you access The Journal.

I

Specify & User Name and Passward
LUsar Mame (Required)

Dl

Passward

1 da not need a password

4 Back

User Name
Your login name defaults to your Windows user name. You can change this to be any name you want

(and you can have as many login names as you want, each with their own categories and entries; more
about that here).

Password
Type in the password you want to use for this login name.

If you do not want a password, simply check the "l don't need a password" option. This gives you a
blank password and sets the Auto-Login option so you aren't prompted for a password when you login.

If you change your mind later, you can always give yourself a password by clicking on the User menu,
un-check the Auto-Login option and then choose Change User Password...

When you're ready, click on Next to continue. If you have chosen a password, you'll be asked to
confirm your password (type it in again exactly the same) before continuing.
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3.1.3 Confirm Your Journal Volume and Login Name

The last step is confirm your Journal Volume and login name.

The Joumal Valumes path
AThe Jewrnal Volumesi 7

User Namwe: David
Fassword: No Password

4 Back & Finish

If everything looks good, click on Finish.
This will create your Journal Volume and login name and log you in.

3.1.4 Installing Add-on Packages

If you purchased The Journal with add-on packages (like the MemoryGrabber, Devotional Prompts 1, or
Steve Paviinas Templates) or chose to install any optional add-on packages (like My Address Book),
you will now be prompted to install those now.

5] Wewt Addd- o Packages 3

New Add-on Packages

¥ Memonsgraboer
® Memonmgrabber Demo
® My Address Book

Install 2hap

Un-check any add-ons you don't want to install (you can always install them later by clicking on the
Tools menu and choosing Add-ons...) and click on Install. Or click on Skip to install no add-ons at this
time.

Now you're ready to start making entries in The Journal.

3.2 Making Entries in The Journal

Making entries in The Journal is easy.

Making Entries in "Daily Journal”

The "Daily Journal” category that is created for you automatically is a calendar category. You'll notice
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that The Journal has created a single entry for the current date. You can type in this entry just as you

would a word processor or text editor.

To create a new, blank entry for today, press F9 (or click on the Entry menu, find the Create New
Entry sub-menu and choose Create Entry: Document).

To create a past entry, simply click on a past date on the calendar. A new, empty entry will be brought
up for you. The entry is not added to the "tree" of dates below the calendar yet, because the entry is
empty. Once you begin adding text to the entry, then it will show up in the date tree.

1
S M
1
7 8
14 15
21 22
28 29

December 2014 [ 4
T W T F S
2 3 4 5 6
9 10 11 12 13
16 17 [l 19 20
23 24 25 26 27
30 31

As the days and weeks go by, your collection of entries will grow. In the tree of dates, your entries will

be organized by year and month.

M 2014

December
% 18 (1:05 PM) - Welcome t

E§19 (2:30 PM) - A new ent

Making Entries in "Notebook™

To the left of the entry editor, just past the calendar, is the tree of available categories. The selected
category in the tree is "Daily Journal". Below that is "Notebook". Click on "Notebook" now to make it
active. You can switch between "Daily Journal" and "Notebook™ at any time. The Journal will keep your

entries separate for you.

The "Notebook™" category is a loose-leaf category. Unlike "Daily Journal", entries in "Notebook" are not

tied to a date. Instead, the entries are named.
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3.21

E) Notebook Example Entry

[ How to Keep a Journal
(2 What's New in The Journal 7

To create a new entry, click on the Entry menu, choose Create New Entry, and then Document (or
press F9). This will create a new document entry. Enter the name you want the entry to have and hit
ENTER. You now have a new loose-leaf entry following the first one in the tree.

"Notebook Entry" is the default name of entries created in this category. To change the name of the
entry, click on the entry in the tree (or press F2). Then type in what you want to call the entry.

Press F10 ("Create New Sub-Entry") to create a new entry as a sub-entry of the current entry.

A loose-leaf entry can have as many sub-entries as you want. Loose-Leaf entries can also be
organized by dragging and dropping them in the tree.

Click on the second entry in the tree and "drag" it up to the first entry. Then release it. The second
entry is now a "sub-entry" of the first entry.

This gives you the basics of creating and using entries in The Journal.
For more information, see Entries.

Printing Entries

Once you have created entries in The Journal, a common task is to print those entries.

To print a single entry, bring up that entry. Then click on the File menu and choose Print (or press
Ctrl+P).

With "Active Entry" selected, click on "Print". That will print the currently selected entry.
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3.2.2

Select Categories/Entries to Print
& [ Active Entry
O [% Active Entry wilh All Sub-Entries
# O [ Current Day
O @l These Categones/Entries
# O Daily lournal
# O] Motebook
w1 O Templates
% CIEF Mew Categony

Printing Options | Headers & Footers | Additional Options

Print ter | HP Officejet 7200 series : | Printer Setup
Print Range Copies
® Al Mumibes of Copies !
Pages B Caillate

Example: 3-3,11

Erilry Beparts.. Print Preyiew Cancel

Want to review the entry before you print? Click on "Preview".

| o2 priae | Funpage = i | 3| Pape1or2 | Qo

Druiy dowrml

Twrany, December LB, 2014 - LEEFAE

Whedc cove 1o The Jowmadll

Thm “Unily dowreal” compery 8 e doryos sy 0 Baip I IR GRCHY
s

Ty b ety . v st sty svpe
ety ey iy, ot e

i e s chbie, gl Gk
A tha b 1 e ~Caimpuey Propanin—”

5l gt Vbl P B 1 1k b i 1 sl i

o g ke sy s by i O The el pghan i ys
s s
Mt 18136 P 15 T Jarmd e caa e Pt D R B

Fagr |
Frimied n Thoaseslay, Dsronioes 18, 3014

You can also print multiple entries, either from the same category or multiple categories. To do that,
click on "These Categories/Entries" and then select the categories and/or entries that you want to
print. Then click "Print".

For more information, see Printing.

To learn more about headers and footers, see Printing Headers and Footers and User Preferences:
Printing.

Inserting Images and Media in Entries

Your entries aren't limited to just text. You can insert digital photos, clip art, and even media like audio
and video.

Inserting Images

To insert almost any kind of image in your entries:
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¢ digital photos,
¢ clip art,
* any image of type JPG, PNG, BMP or GIF.

Click on this icon on the toolbar:
| = [l 2 @3 BB |

Or click on the Insert menu, and choose "Insert Image..."
You can also drag images from Windows Explorer and drop them into your entry.

By default, inserted images are positioned relative to the base line of the current entry text. You can
change this default, for example to be to the left of your entry text, in User Preferences: Editor Image

Options.

Inserting Media

You can also insert most types of audio and video files into your entries:
* audio - wma, wav, mp3, mid, midi, ra, ram
® video - wmv, mpg, mpeg, avi, mov, rm

Click on this icon on the toolbar:
| & (9= V|
Or click on the Insert menu, and choose "Insert Media File (Audio/Video)..."

You can also drag images from Windows Explorer and drop them into your entry.

A_n attached audio file shows this icon:

IB

An attached video file shows this icon:
NOTE: Some media files are very large. Media files larger than 10 MB will cause your entries to load
and save slower. Media files larger than 50 MB may not perform well when stored in The Journal.

Also note: The Journal relies on Windows for media file playback. If you are using Windows XP, it's
possible that not all types of media file listed above will play.

3.2.3 Other Entry-Related Topics

Besides printing and inserting images, you can also:
* post your entries to a blog;

* insert tables;

® use images as backgrounds for your entries;

* link entries together like a Wiki;
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3.3

3.3.1

* tag your entries with topics;
¢ and more!

These topics are covered in detail in The Journal Reference section of this online help.

Using Categories

The Journal's categories provide a powerful tool for organizing your journaling, notes or other writing
projects.

The "Daily Journal" and "Notebook categories" are created for you automatically, but you are not limited
to just those. You can have as many or as few categories as you want.

The Journal supports two kinds of category: calendar and loose-leaf.

Calendar Categories

Calendar categories can have entries for an hour, a day, a week, a month, a year--even for decades
and centuries. The "Daily Journal" category created for you automatically is a calendar category that
creates a new entry for you every day.

Calendar categories automatically organize your entries for you into days, weeks, months, and years.
You can also view summaries of your entries in a monthly calendar, or a horizontal yearly calendar.

You can create an entry for any date: past, present or future. Any date, as far back or as far forward
as you want to go.

Don't worry about empty entries: The Journal doesn't store empty calendar entries.

Further, calendar categories can have loose-leaf sub-entries, just like a loose-leaf category.

Loose-leaf Categories

Loose-leaf categories are a collection of entries that are not tied to a particular date (as they are in
calendar categories).

Entries in a loose-leaf category are named documents, arranged by you, just like a loose-leaf notebook.
Loose-leaf category entries can be arranged in any order (just click-and-drag in the entry tree), and
entries can have sub-entries (which can have sub-entries, which can have sub-entries, and so on).

Creating a New Category

To create a new category, click on the Category menu and choose "Create New Category..."
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[T} Creste Bew Category

Categary Name
Categary Tyne
@ Cadenclar {Daiy, haurky, weekly, =tc.)

Create a new entry every day

B Include tme on entry

B Round time 1w 5 minutes
Locse-leal (Motebook)

Makm a sub-categony af ..
=ranes

Craate Cancal

Enter the name of the category you would like, then choose whether you want a calendar category or a
loose-leaf category. If you choose a calendar category, you will then have to specify how often you
want the category to create new entries.

When you click "Create", the new category is added to your collection of category tabs.
3.3.2 Editing Categories

To edit a category, right-click on the category in the tree (or on its tab) and choose "Category
Properties..."

DainJDurnaI

5 Notebook Category Properties... |_
[= Templates

Create Mew Category...

J Buy The Journal!

= o n E T 11

Or you can click on the Category menu and choose "Category Properties..."

Categary List General | Calendar | Entry | Entry Text Style | Security | Sharing
B Daily Journal

i Wotebook Category Mame (Displayed on Tab)

T Templates Dranly Journal

A Wew Category

Category Active (Tab Visible)

8 Show day planner with active reminders
Show reminders for current date only
Planner Time Scale 1 higar
B Only show if there are active reminders
Show list of active to-do items

[risplay start of week on Drefault (Sunday)

Tab,Tree Colar Default
Click and drag categornes to arange them.

MNew Category TabyTree Text Color “ .

Delete Category “~ Category sort order

Done At Cancel

You can edit the name of your category, its order in the tabs, even whether its tab is visible or not and a
whole lot more.
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3.5

See Category Properties for more information.

Creating Additional Logins

When you first started The Journal, you had to create your first login name.

You can have, however, as many logins as you want: one for each project (for even more separation
than categories), one for each family member, one for work and one for home, and so on. Each login
can have its own password.

Create a New User

Click on the File menu and choose "Create New User..."

(7] Create Rew User in My Journasl %
Specity a User Name and Passwend
ser Mame

Fazsword

Ido not noed a password

Every user must have a unique User Name. Every user must also have a password, or choose to have
no password (a blank password).

Once you click Next, and then Finish, the user will be created within the currently active Journal
Volume.

Creating Additional Journal Volumes

When you first started The Journal, The Journal automatically created your first Journal Volume.

Like entries, categories and user logins, though, you can have as many Journal Volumes as you want.
Each Journal Volume is completely separate from every other.
Creating a New Journal Volume

Click on the File menu, find the Journal Volume sub-menu, and choose "Create New Journal
Volume..."

© 1996-2016 by David Michael



How to Use The Journal 51

fI] Create New Journal Volume kS
Journal Volume Name
ournal 1
Make this volume the default volume
Create Journal Volume in this Folder
AThe Journal Volumesh/
Ok Cancel

Every Journal Volume must have a unique name. This name is used to create a sub-folder for that
Journal Volume.

NOTE: Itis not recommended that you change the base Journal Volume folder (displayed under Create
Journal Volume in this Folder).

Once you click OK, the Journal Volume is created.

The first time you open a Journal Volume, you will be prompted to create the first login name for that
Journal Volume.

3.6 Database Maintenance

The Journal's entry database has proven very stable over the years, but it is always a good idea to
make regular backups.

The Journal automatically prompts you to make a backup once a week (every 7 days). If you would like
to backup more or less frequently, you can set this using the Backup Settings.

How do | backup The Journal?

1. Click on the File menu, find the Maintenance sub-menu, and choose "Backup The Journal..."
2. Check to select the Journal Volumes you want to backup.

3. Click on "Start Backup".

See Backup Settings for more information.

How do | copy my backup file to another location?

Your Journal backup files can be automatically copied to another folder on your hard drive, to a
network folder, to an external hard drive, or even offsite to an FTP server.

1. Click on the File menu, find the Maintenance sub-menu, and choose "Backup Settings..."

2. Under "Copy backup archive to these locations", add the folder(s) or FTP server you would like
your backup copied to.

For more information see Backup Settings.
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Frequently Asked Questions (FAQ)

4 Frequently Asked Questions (FAQ)

Entries

How do | import my entries from Evernote, Penzu, Diaro, or WordPress?
How can | import my entries from another diary or journal program?
How do | insert images in my entries?

Can | insert digital photos in my entries?

How do | wrap text around pictures in my entries?

How can | use tables in my entries?

How do | make my tables look like those in MS Word/WordPerfect/Etc?
How do | use topics in my entries?

How do | lock my entries so they can't be edited?

How do | post my entries to a blog?

How do | use templates in my entries?

How do | have a template automatically inserted in my entries?

How can | create my own templates?

Why can't | edit my past entries?

How do | create loose-leaf entries in my calendar category?

How many entries can The Journal hold?

How do | get rid of the time on my entries?

Printing

How do | set the printer margins?

Categories

What is a "category"?

What is a "calendar category"?

What is a "loose-leaf category"?

How do | set a category's default font?

How do | create a new category?

How do | delete a category?

How do | see how many entries are in a category?

User Interface

| lost my password. How do | reset my password?

How can | customize the look of The Journal (change the skin)?
How do | customize the toolbars?

What is the hot-key (keyboard shortcut) for...?

Can | use voice-recognition software with The Journal?

Journal Volumes

What is a Journal Volume?

How do | synchronize 2 Journal Volumes?

How do | move The Journal to a new computer?
How do | use The Journal on a Network?

What is the size limit on a Journal Volume?

Export/Import
How can | import my entries from another diary or journal program?
How do | synchronize 2 installations of The Journal?

Database Maintenance
How do | backup The Journal?
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How do | copy my backup file to another location?
How do | restore from a backup?

How do | see what is in my backup file?

How do | restore just one category from a backup file?

Security
How do | set/change my password?

How do | get rid of my password?
What is Extended Security?
What kind of encryption does The Journal use?

Upgrading

Will The Journal 7 upgrade my categories and entries from The Journal 6 (or earlier)?
| am a regqistered user of The Journal 6 (or earlier). What is the upgrade price for The Journal 7?

Glossary

Your question not here? Feel free to ask! Click here to email DavidRM Software.
FAQ: Entries

How can | import my entries from another diary or journal program?
How do | insert images in my entries?

Can | insert digital photos in my entries?

How do | wrap text around pictures in my entries?

How can | use tables in my entries?

How do | make my tables look like those in MS Word/W ordPerfect/Etc?
How do | use topics in my entries?

How do | lock my entries so they can't be edited?

How do | post my entries to a blog?

How do | use templates in my entries?

How do | have a template automatically inserted in my entries?

How can | create my own templates?

Why can't | edit my past entries?

How do | create loose-leaf entries in my calendar category?

How many entries can The Journal hold?

How do | get rid of the time on my entries?

How do | insert images in my entries?
Click on this icon on the toolbar:
|= 2 @BV
Or click on the Insert menu, and choose "Insert Image..."
You can also drag-and-drop images into your entry using Windows Explorer.

By default, inserted images are positioned relative to the base line of the current entry text. You can
change this default, for example to be to the left of your entry text, in User Preferences: Editor Image

Options.

Also see: Using Images in Entries and How do | wrap text around pictures in my entries?
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Can |l insert digital photos in my entries?

Yes. You can insert just about any kind of image into The Journal, including digital photos (which are
most often compressed JPEG images: *.JPG).

Keep in mind, however, that digital photos larger than 3-4 megapixels (MP) may take a noticeable
amount of time to save and load. The more photos in the entry, the longer it will take to load. So you
may want to crop and/or reduce digital photos of 6+ MP before inserting them. Feel free to experiment
and see what works best for you.

The Journal's Automatic Image Resizing feature can help with inserting digital photos into entries.

How do | wrap text around pictures in my entries?

1. First, you insert the image, picture or digital photo as described above.
2. Click on the image to select it.

3. Right-click the image and open the "Image" sub-menu.

4. Choose either "Wrap Text on Right" or "Wrap Text on Left".

How can | use tables in my entries?

To insert a table, click on this icon on the toolbar:

| ] O @E]V|

Or click on the Insert and choose "Insert Table..."

See Using Tables.

How do | make my tables look like those in MS Word/WordPerfect/Etc?

You can give your tables the single-black-line border used in most word processors by adjusting the cell
spacing and turning off the table's border.

1. Select the table.

2. Click on the Table menu and choose "Table Properties..."

3. Click on More... (next to Cell Spacing).

4. Un-check Equal Values.

5. Change the Horizontal and Vertical values for Between Cells to: -1

6. Change the Horizontal and Vertical values for From Table Border to Cells to: 0

7. Click on OK.
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8. Click on Table Border...
9. Under Border Type click on None.
10. Click on OK.

11. Click on OK.

How do | use topics in my entries?

See Using Topics.

How do | lock my entries so they can't be edited?

You can make any entry "read only", to prevent changes to that entry.

1. Select the entry you want to lock.

2. Click on the Entry menu and un-check "Lock/Unlock Entry"” (hot-key: F4).

You will see "Locked" displayed on the status bar below the entry.

You can edit the entry again by repeating that procedure. F4 toggles locked/unlocked status.

You can make all past entries in a calendar category locked automatically by checking the option in the
Calendar tab of the Cateqory Properties.

How do | post my entries to a blog?

See Using a Blog.

How do | use templates in my entries?
To insert a template in an entry:
1. Click on the Insert menu, and bring up the "Insert Template" sub-menu.

2. Choose the template to insert, and the text from that template will be inserted in your entry.

How do | have a template automatically inserted in my entries?
1. Right-click on the category tab and choose Category Properties...

2. Bring up the Entry tab.

3. Select the Default Entry Template from the available drop down list of templates.

The selected template will be inserted into new entries. For calendar categories, this template will be
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inserted into new entries for the current day. For loose-leaf categories, the template will be inserted into
all newly created entries.

How can | create my own templates?

See Creating Simple Templates and Creating Enhanced Templates.

Why can't | edit my past entries?

In your category, past entries may be set to be locked. You can override this by clicking on the Entry
menu and choosing "Lock/Unlock Entry” (or pressing the hot-key: F4).

You can also change the category setting so that all past entries edit-able:
1. Click on the Category menu and choose "Category Properties..."
2. Bring up the Calendar tab.

3. Un-check the option: "Automatically lock past entries"

How do | create loose-leaf entries in my calendar category?
To create a sub-entry of a calendar entry (or a loose-leaf entry): Press F10

To create a new, root-level loose-leaf entry: Press Shift+F9

How many entries can The Journal hold?

You can have a maximum of just over 2 billion entries in a Journal Volume.

How do | get rid of the time on my entries?

By default, your new entries are "stamped" with the current time. If you would like to turn that off:
1. Right-click on the category in the list (or the category tab) and choose Category Properties...
2. Bring up the Calendar tab.

3. Un-check the option "Include time in entry".

4.2 FAQ: Printing
How do | set the printer margins?

To set the printing margins:

1. On the User menu, click on "User Preferences..."
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2. Bring up the Printing tab.
3. Click on "Edit Default Page Setup".
4. There you can set the margins to how you want them, and click "OK" when you're done.

Those settings will be used every time you print, unless you override them at the category level.

FAQ: Categories

What is a "category"?

What is a "calendar category"?

What is a "loose-leaf category"?

How do | set a category's default font?

How do | create a new category?

How do | delete a category?

How do | see how many entries are in a category?

What is a "category™?

Categories are a powerful way to organize your entries in The Journal. The Journal creates three
categories for you automatically: "Daily Journal", "Notebook", and "Templates". You can create as
many categories as you want.

"Daily Journal" is a calendar category which creates a new entry for you every day, and organizes
those entries into months and years for you.

"Notebook" is a loose-leaf category. Entries in a loose-leaf category are not tied to a specific date.
Instead, they are like named documents that you can arrange any way you want.

For more information, check out Calendar Categories and Loose-leaf Categories.

What is a "calendar category"?

Calendar categories can have entries for an hour, a day, a week, a month, a year--even for decades
and centuries. The "Daily Journal" category created for you automatically is a calendar category that
creates a new entry for you every day.

Calendar categories automatically organize your entries for you into days, weeks, months, and years.
You can also view summaries of your entries in a monthly calendar, or a horizontal yearly calendar.

You can create an entry for any date: past, present or future. Any date, as far back or as far forward
as you want to go.

Don't worry about empty entries: The Journal doesn't store empty calendar entries. When you log out,
all empty entries are automatically purged.

What is a "loose-leaf" category?

Loose-leaf categories are a collection of entries that are not tied to a particular date (as they are in
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calendar categories). Instead, entries in a loose-leaf category are named documents, arranged by you,
just like a loose-leaf notebook.

Loose-leaf category entries can be arranged in any order (just click-and-drag), and entries can have
sub-entries (which can have sub-entries, which can have sub-entries, ...).

How do | set a category's default font?

You can use any Windows font (TrueType or Type-1) for your entries.

To set the default font used by a category:

1. Click on the Format menu and choose "Change Default Font for [category name]".

If you want to change the default font for all categories, you need to change your user default font:

1. Click on the User menu and choose "Change User Default Font".

How do | create a new category?
1. Click on the Category menu and choose "Create New Category..."
2. Choose a name for your category (example: "Dreams").

3. Pick a category type, Calendar or Loose-leaf.

. If you are creating a calendar category, you will need to choose how often you want a new entry:
Every 1-12 hours,
Every day,
Every week (on a particular weekday),
Every month (on a particular day), or
Every year, decade, or century (if you're writing a history)

e o o o o N

5. If you would like the new category to be a sub-category, choose the category that the new category
will be under.

When you click on "Create", your new category will be created and you will be able to click on its tab
and start making entries immediately.

Learn more about The Journal's categories here: Categories

How do | delete a category?

1. Right-click on the category tab, and choose "Category Properties..."
2. Select the category to delete from the list of categories.

3. Click on "Delete Category".

NOTE: Deleting a category also deletes all of the entries in that category, as well as any sub-categories
(and their entries). Deleting a category cannot be undone. You would need to restore from a backup to
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recover a deleted category.

How do | see how many entries are in a category?

Click on the Category menu and choose "Category Statistics..."

FAQ: User Interface

| lost my password. How do | reset my password?

How can | customize the look of The Journal (change the skin)?

How do | customize the toolbars?

What is the hot-key (keyboard shortcut) for...?

Can | use voice-recognition software with The Journal?

| lost my password. How do | reset my password?
Most lost user passwords and category passwords can be reset.

Email DavidRM Software and request a password reset code.

You will be sent a password reset code and instructions for how to use it.

NOTE: Users who have activated Extended Security cannot have their passwords reset. That is one of
the features of Extended Security.

How can | customize the look of The Journal (change the theme)?

There are a lot themes for you to choose from, which you can easily change as your mood or style
takes you.

Click on the View menu and choose "Change Theme..."

You can also change the them--or turn off themes--of The Journal in User Preferences (on the User
menu), on the "Global" tab, "Theme" sub-tab.

How do | customize the toolbars?

Right-click on the menu or toolbar that you want to customize, and choose Customize. This will open
up a form which contains all available menu and toolbar commands.

Bring up the Commands tab.

Click on the commands you want and drag-and-drop them on the menu or toolbar where you want them
to appear.

In addition, all toolbars, as well as the main menu, can be undocked and be floating at any position on
your screen. Mouse over the far left of each toolbar until the four directional cursor appears, then left-
click and drag the toolbar to the position you'd prefer.
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What is the hot-key (keyboard shortcut) for...?

All hot-keys are listed here: Keyboard Shortcuts

Can | use voice-recognition software with The Journal?
Yes, The Journal can be used with most voice-recognition software (VRS).

When you use VRS with The Journal, it's recommended that you turn off a couple of features:
* "Check spelling as you type"
e "Correct spelling errors as you type"

Both of these features can be turned off on "Spell Checker" tab of "User Preferences” (on the User
menu).

4.5 FAQ: Journal Volumes

What is a Journal Volume?

How do | synchronize 2 Journal Volumes?

How do | move The Journal to a new computer?
How do | use The Journal on a Network?

What is the size limit on a Journal Volume?

What is a Journal Volume?

A Journal Volume is an "entry database" for The Journal. A Journal Volume can contain one or more
user logins and all of their categories and entries.

Journal Volumes can be placed on any available hard drive, internal or external or network attached, or
even removable thumb drives. Each Journal Volume must have a unique name.

Most users of The Journal will only need a single Journal Volume.

See Journal Volumes for more information.

How do | synchronize 2 Journal Volumes?

It is possible to keep entries across multiple Journal Volumes "in sync" several ways:
* Using a backup file created by The Journal.

® Using an export file from The Journal.

* Using the Journal Volume folder on an external hard drive.

See the Export/Import Overview and Synchronizing The Journal for more information.

How do | move The Journal to a new computer?

1. Create a backup of your Journal Volume(s) (File menu, Maintenance sub-menu, Backup The
Journal...).
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2. Download and install The Journal on your new computer.
3. Copy the backup file(s) you created in #1 to your new computer.

4. Run The Journal on your new computer. In the New User Wizard, check the option "Il need to
Restore from a Backup of The Journal” and click on "Next".

5. Browse to select the backup file.
6. Click on "Restore". You will be prompted to create the Journal Volumes you need.

See also: How do | restore from a backup?

How do | use The Journal on a Network?

The Journal can have its Journal Volume(s) on a shared or network folder, allowing multiple users to
access those Journal Volume(s) at the same time. To do this, though, The Journal must be installed

properly.

1. When you install The Journal, on the "Select Additional Tasks" page of the install wizard, you need
to check this option: "The Journal's database will be in a shared or network folder"

2. You will be prompted to specify the shared/network folder to use.

3. You will have to do this on each of the computers or workstations that will be using The Journal over
the network.

4. If the users will be accessing or updating the same categories and entries simultaneously:Once you
have The Journal installed, you'll want to have set categories to use the "Lock Entries on Edit" option (on
the "Sharing" tab of Category Properties).

What is the size limit on a Journal Volume?
The maximum size of a Journal Volume is 30 TB (terabytes) on Windows.

NOTE: If you are running The Journal under a Windows emulator, the maximum size of the Journal
Volume will be limited by the host operating system (e.g., 2 GB under Wine on Linux).

FAQ: Export/Import

How do | import my entries from Evernote, Penzu, Diaro, or WordPress?

How can | import my entries from another diary or journal program?

How do | synchronize 2 installations of The Journal?

How do | import my entries from Evernote, Penzu, Diaro, or WordPress?

The Journal supports importing from a variety of other software products, including Evernote, Penzu,
Diaro, and WordPress. This same process can be used for any software products that can export to
the ATOM publishing format.

1. Export the entries from the other software to a file.

© 1996-2016 by David Michael



Frequently Asked Questions (FAQ) 63

2. In The Journal, click on the File menu, Import sub-menu, and choose "Import Entries..."

3. Browse to select the file you exported in #1.

4. Do the import.

You don't have to worry about importing the same entries more than once. The Journal detects this, and
checks the entries. If the entries are identical, nothing happens. If the current entry and the imported
entry are different, however, you will be prompted to import the new entry, keep the current entry, or
keep both.

Diaro NOTE: If possible, point the import to the folder with the Diaro xml file *and* the "Media" folder
(with "Photo" sub-folder). That will allow The Journal to import your photos as well as your text entries.

How can | import my entries from another diary or journal program?

The Journal supports batch entry import, which makes it relatively simple to import entries from other
diary or journal programs.

1. Create a temporary folder on your hard drive.

2. Export your entries from the other software into individual text (.bxt), rich text (.rtf), or HTML (.htm;.
html) files. Export to the temporary folder you created in #1. If the entries are for a particular day, make
sure the date is used in the name of the exported file. The best date format will use a 4-digit year, a 2-
digit month, and a 2-digit day.

Example:
1993-10-05.rtf (entry for 5 October, 1993)

3. Once you have the entries exported, start The Journal. On the File menu, Import sub-menu, choose
"Batch Entry Import..." to import the entries into The Journal.

4. Choose the option "Each in a separate file", and click on "Next".

5. Choose the category you want to import the entries into (like "Daily Journal).
6. Browse to the temporary folder where your exported entries are.

7. Set the "Specify Date Format" to match how the export named your entries.

Example:
yyyy-mm-dd.rtf

Then do the import.

See Importing Entries from Other Journal Software and Batch Entry Import for more information.

How do | synchronize 2 installations of The Journal?

It is possible to keep entries across multiple Journal Volumes "in sync" several ways:
* Using a backup file created by The Journal.

® Using an export file from The Journal.

* Using the Journal Volume folder on an external hard drive.
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See the Export/Import Overview and Synchronizing The Journal for more information.

FAQ: Database Maintenance

How do | backup The Journal?

How do | copy my backup file to another location?

How do | restore from a backup?

How do | see what is in my backup file?

How do | restore just one category from a backup file?

How do | backup The Journal?

1. Click on the File menu, find the Maintenance sub-menu, and choose "Backup The Journal..."
2. Check to select the Journal Volumes you want to backup.

3. Click on "Start Backup".

See User Preferences: Backup/Restore for more information.

How do | copy my backup file to another location?

Your Journal backup files can be automatically copied to another folder on your hard drive, to a
network folder, to an external hard drive, or even offsite to an FTP server.

1. Click on the File menu, find the Maintenance sub-menu, and choose "Backup Settings..."

2. Under "Copy backup archive to these locations", add the folder(s) or FTP server you would like
your backup copied to.

See User Preferences: Backup/Restore for more information.

How do | restore from a backup?
1. Click on the File menu, find the Maintenance sub-menu, and choose "Restore From Backup..."
2. Browse to select your backup file.

3. When the backup file is opened, the Journal Volume name will be displayed, as well as the date the
backup file was created.

4. If more than one Journal Volume is listed, select the Journal Volume to restore from the list.
6. Click on "Restore Journal Volume".

7.a. If the Journal Volume doesn't exist in The Journal, you will be asked if you want to create the
Journal Volume.
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7.b. If a Journal Volume with the same name does exist, you will be ask to confirm overwriting the
current Journal Volume.

7.c. Otherwise, select the Journal Volume to restore into.

NOTE: Everything that is in the Journal Volume you select will be overwritten by the information in the
backup. So select the Journal Volume *very* carefully.

Once the restore is finished, you can open the Journal Volume and log in.

How do | see what is in my backup file?

1. On the File menu, find the Maintenance sub-menu, and choose "Restore from Backup...". Browse
to select your backup file.

2. When the backup file is opened, the Journal Volume name will be displayed, as well as the date the
backup file was created.

3. Click on "Create New Journal Volume" to create a new, temporary Journal Volume that you can
restore into.

4. Click on "Restore Journal Volume". This will restore the backup file into the newly create Journal
Volume.

Then you can open the new Journal Volume, log in and review what it contained.
When you need to delete the temporary Journal Volume:
5. Click on the File menu, Journal Volume sub-menu and choose "Delete Journal Volume..."

6. Select the Journal Volume you created in #3 above, and then click on "Delete".

How do | restore just one category from a backup file?

1. Click on the File menu, Import sub-menu and choose "Sync from Backup File..."
2. Browse to select the backup file.

3. If you're prompted for the user login password, enter that.

4. Under "What would you like to synchronize", un-check all the options except "Categories &
Entries". Then click on "Next".

5. Click on "Clear All", then check the category (on the left side) that you want to restore. Then click
on Next.

6. There will not be any entry conflicts, so click on "Next" again.
7. Click on "Sync".

And you're done.
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FAQ: Security

How do | set/change my password?

How do | get rid of my password?

What is Extended Security?

What kind of encryption does The Journal use?

How do | set/change my password?
Click on the User menu and select "Change User Password..."

You will need to enter your current password (unless you have a blank password) to create a new
password, and then confirm your new password.

How do | get rid of my password?

If you do not want The Journal to prompt you for your password:
1. Click on the User menu and choose "Auto-Login".

2. Enter your password at the prompt to confirm auto-login.

You can turn off automatic login by clicking on the User menu and choose "Auto-Login" again.

What is Extended Security?

Extended Security enhances The Journal's normal security by adding an additional layer of protection,
and a couple of security-related options.

The Journal's "basic" security is quite good, more than most people will ever need. Extended Security
builds on that to make The Journal as secure as possible.

See Extended Security for more information.

What kind of encryption does The Journal use?

Encryption of entries uses the Twofish block cipher designed by Bruce Schneier.
See Security Details for more information.

FAQ: Upgrading

Will The Journal 7 upgrade my categories and entries from The Journal 6 (or earlier)?
| am a registered user of The Journal 6 (or earlier). What is the upgrade price for The Journal 77?

Will The Journal 7 upgrade my categories and entries from The Journal 6 (or
earlier)?
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Yes, The Journal 7 will upgrade your existing categories and entries from any past version of The
Journal.

Upgrading Your Journal Volumes from The Journal 6 (or earlier) (Most Users)

Upgrading Your Journal Volumes from The Journal 6 installed on a USB drive

Upgrading from a Backup File (*.jbk or *.jbu)

See Upgrading from The Journal 5, 4 or 3 or Upgrading from The Journal 2.x for more information.

| am a registered user of The Journal 6 (or earlier). What is the upgrade price
for The Journal 7?

If you purchased The Journal 6 from 1 October 2014, up to the release of The Journal 7, you are
eligible for a free upgrade. Email DavidRM Software to request your Registration Keys for The Journal
7. Include your full name (first + last), email address (or mailing address), and approximate date of
purchase.

People who have purchased any previous version of The Journal are eligible for special upgrade
pricing ($29.95 US). To receive your The Journal 7 Upgrade Coupon Code, you must submit your full
name (first + last), email address (or mailing address), and approximate date of purchase to DavidRM
Software.

See The Journal Pricing for more information.

4.9.1 Upgrading from The Journal 6, 5, 4 or 3

Upgrading Your Journal Volumes from The Journal 6 (or earlier) (Most Users)
Upgrading Your Journal Volumes from The Journal 6 installed on a USB drive
Upgrading from a Backup File

Upgrading Your Journal Volumes from The Journal 6 (or earlier) (Most Users)

If you have The Journal 6 (or TJ5 or TJ4 or TJ3) installed, then the first time you run The Journal 7 it
will detect your existing Journal Volumes and offer to import them into The Journal 7.

Information (e v

The Journal has detected a Journal Volume from The Journal 4 or earfier: Home'

Journal Volume Path:
0 CAUsars\DavidDocumenisiThe Journal \Volumes\Home

impart this Journal Volume into The Journal 57

NOTE: Original Journal Volume wil NOT be affected.)

Yes No

Click on Yes to start the import.

The import process copies your TJ6/TJ5/TJ4/TJ3 Journal Volumes to a new location before upgrading
them. Your existing Journal Volumes will not be changed or modified in any way.

The upgrade happens in 2 steps:
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1. Database upgrade. This happens the first time you open an imported Journal Volume.

2. User upgrade. This happens the first time you log in with a user name.

If you have a lot of entries, the upgrade may take a few minutes.

UPGRADE NOTES for The Journal 4 and The Journal 3:

* A user's auto-login setting (no prompting for password) is not upgraded, so you will be prompted for
your password. You can set auto-login again by clicking on the User menu and choosing "Auto-
Login".

* Categories that were set to "read only" lose that setting when upgraded. You can set the category to

read only again in Category Properties, on the Security tab, check the option "Category entries
are Read Only (and no new entries)".

Upgrading Your Journal Volumes from The Journal 6 installed on a USB drive
NOTE: You will need about 35 MB of space just to install The Journal 7, and then about twice as much
free space as your TJ6 Journal Volume currently uses (it won't always need this much space; just
during the import and upgrade).

First, install The Journal 7 to your USB drive.

Run The Journal 7.

You will be presented with the New User Wizard.

Check the option "I am upgrading from an earlier version of The Journal." Then click Next.

Browse *into* the folder for your TJ6 (or earlier) Journal Volume. Select any file in the folder and click
on "Open".

That will start the upgrade process. The Journal 7 will then copy the Journal Volume into your new
Journal Volumes folder and upgrade it.

Upgrading from a Backup

If you do not have The Journal 6 (or earlier) installed, but you do have a backup file (*.jpbackup, *.JBK
or *.JBU) from The Journal 6 (or earlier), you can upgrade from that.

The first time you run The Journal 7, you will be shown the "New User Wizard".

Click on "I need to Restore from a Backup of The Journal", then click on Next.
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You will then browse to select the backup file to restore from.

Once the restore has finished, The Journal 7 will ask you to confirm that you want the Journal Volume
upgraded. Follow the on-screen instructions to upgrade the Journal Volume.

The upgrade happens in 2 steps:
1. Database upgrade. This happens the first time you open an imported Journal Volume.
2. User upgrade. This happens the first time you log in with a user name.

If you have a lot of entries, the upgrade may take a few minutes.

Reverting to The Journal 6 (or earlier)
Should you decide not to stick with The Journal 7, you will want to do this:
1. Export all new/edited entries created or changed since you installed The Journal 7.

1.a. Use Windows Explorer to create a temporary folder to export into.

1.b. In The Journal 7, click on the File menu, Export sub-menu, Export Entries as Document...

1.c. Click on the "Export Options" tab and make sure that the "File Options™ is set to "Create a file
for each exported entry”.

1.3. Select the entries you have created/changed in The Journal 7.

1.3. Export these entries to RTF files into the folder you created.

2. Uninstall The Journal 7 using Windows Control Panel.

3. Run The Journal 6 (re-install if necessary). The Journal 6 should see your entries from before
installing The Journal 7.

4. Import the entries exported from The Journal 7.

4.a. In The Journal 6, click on the File menu, Import sub-menu, and choose Batch Entry Import...
4.b. Browse to the folder you created in #1 (above) with your exported entries.

4.c. Select the category to import the entries into.

4.d. Select the .RTF files to import.
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4.9.3

Upgrading Add-on Packages

If you have purchased add-on packages for earlier versions of The Journal, such as MemoryGrabber
and Writing Prompts 1, you can still use them in The Journal 6.

Any packages you are already using should be upgraded. If not, the easiest way to get the packages
into The Journal 7 is to run the add-on installation again:

1. Make sure The Journal is not running.

2. Run the installation program for the package. When asked for the folder to install into, change it from:
C:\Program Files\DavidRM Software\The Journal 6\Package\

To:
C:\Program Files\DavidRM Software\The Journal 7\Package\

If you need to download the add-on installation program, email DavidRM Software.

Upgrading from The Journal 2.x

The Journal 7 can upgrade users, categories, and entries created with any 2.x release.

If you already have The Journal 2.x installed, you can upgrade the entry database easily. Just point the
upgrade process to the folder on your hard drive which contains the 2.x database. The 2.x database will
be copied to a temporary location before the upgrade is processed to prevent any changes to it.

If you have a backup that was created with The Journal 2.x, you can also upgrade from that. The
backup will be restored to a temporary database, which will then be upgraded.

NOTE: The information below applies only to users, categories, and entries upgraded from The
Journal 2.x.

Upgrading Users

All user-specific settings are upgraded except for some display settings (like the size and position of
The Journal). Settings for "Single User Mode", "Minimize to System Tray", and "Always on Top" are not
upgraded.

Your password is unchanged from the upgrade. It is recommended that you change your password
after upgrading.

If you use "Single User Mode" in The Journal 2.x, it is recommended that you turn if off before you
upgrade so that you can be certain you still remember your password.

Upgrading Categories

All categories are upgraded, whether they are active or inactive.

"Daily" categories in The Journal 2.x are converted to calendar categories (daily).
"Non-Daily" categories are also converted to calendar categories (daily).

"Loose-leaf" categories in The Journal 2.x are converted to loose-leaf categories. The "tree structure" of
entries is preserved, as is the sorting of entries.

Categories with passwords are upgraded, but the password protection is removed. So any password-
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protected categories will have to be given passwords again after the upgrade.

Upgrading Entries

All entries in The Journal 2.x are upgraded.

71

© 1996-2016 by David Michael




Top Level Intro

This page is printed before a new
top-level chapter starts




The Journal Reference 73

5 The Journal Reference

This section includes detailed descriptions of all The Journal's features, and how to use them.

Glossary

Blog Support

Categories
Database Maintenance

Entries
Export/Import & Syncing
Images & Media
Journal Volumes
Links

Printing

Reminders & Tasks
Security

Styles

Tables

Templates

Topics

User Interface
User Preferences

;

%

5.1 Glossary
Auto-Login
The auto-login option automatically logs you in when you start The Journal. You can turn on auto-login
by clicking on the User menu and checking "Auto-Login". You will be prompted for your password
once more, but not again. You can turn off auto-login by clicking on the User menu and un-checking
the "Auto-Login" option.

This option can also be set on the Security tab of User Preferences.

Blog

Short for "Web log", a form of public diary usually posted on a Web site. The Journal allows you to post
your entries to most blogs (WordPress, Blogger, and so on). See Using a Blog for more information.
Bookmark

A bookmark is a point in an entry that can be linked to. To insert a bookmark, click on the Insert menu
and choose Insert Bookmark... You will be prompted for a name for the bookmark.

You can jump to any bookmark in any entry. Click on the Go menu, then open the "Go to Bookmark™
sub-entry to see all of your bookmarks.

Calendar Charms
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Calendar Charms are icons, or small graphic images, that can be assigned to entries. The entry's
Calendar Charm is then displayed on the calendar and in the category's entry tree. Calendar Charms
can also be inserted into entries, like clip art.

Categories

Categories are a powerful way to organize your entries in The Journal. The Journal creates three
categories for you automatically: "Daily Journal", "Notebook", and "Templates". Each category has its
own entries, and you can easily switch back and forth. You can create as many categories as you
want.

There are two types of category: Calendar and Loose-leaf.

Categories, Calendar

Calendar categories are often called "daily entry" categories. However, calendar categories can also be
hourly, weekly, monthly even yearly. Calendar category entries are tied to a specific date (or range of
dates) and optionally a specific time. You can make as many entries on a date and/or time as you
would like.

Categories, Loose-leaf

Loose-leaf categories are often called "notebook" categories. Entries in a loose-leaf category are not
tied to any date. Instead, they are named documents (or external objects or images). Also, unlike
calendar category entries which are always arranged by year, month, day and time, loose-leaf
category entries can be arranged in "trees" of the user's choosing. An entry can have as many sub-
entries as you want.

Categories, Shared

A shared category is a category that can be accessed by each user that links to it (and provides the
optional sharing password). All entries in the shared category are accessible. Categories can be
shared "read only" or "full access".

Day Planner

The day planner is your reference for all your active reminders, and can be set to display in any of
your journal categories above the entry editor. You can display your reminders just for today and up to
a week in advance.

Entry (Entries)

Entries, organized by category, are the core of The Journal. Entries can be text "documents”, external

objects, or images. Most categories use document entries, because they are the most flexible type of
entry, but any type can be set as the default for the category.

Entry, Document
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Document entries are formatted text documents, much like word processor files. Text can be entered
freely to any length. Any Windows font installed on your PC can be used to format the text. Document
entries can also include images, media files, and even embedded files.

Entry, External Object

External object entries are essentially Windows data files stored in (or linked from) The Journal. Double-
clicking an external object entry will open the entry using the associated Windows application. If
possible, the application will be "hosted" inside The Journal.

Entry, Image

Image entries are graphic files (BMP, JPG, etc) that are stored in The Journal.

Entry Tree

The "entry tree" is the list of entries below the small calendar. Calendar entries are arranged
automatically by year, month, day and time. Loose-leaf entries are arranged however you want them
(just click and drag to arrange loose-leaf entries).

Exporting

Use The Journal's export features to make entries available to other software or to synchronize Journal
Volumes.

Importing

Bringing files created by other applications (including other journal software) into The Journal. See
Importing.

Journal Volume

A Journal Volume is an "entry database" for The Journal. A Journal Volume can contain one or more
user logins and all of their categories and entries. Each Journal Volume has its own folder on your hard
drive (or USB device or network drive).

Links

The Journal supports hypertext-style links in document entries.

There are two types of link: entry links and Internet links. Entry links are links to another entry in The
Journal (or to a bookmark within an entry). Internet links are links to Web pages or email addresses.

If an entry is "read only", you can activate a link just clicking on it. If the entry is not "read only",
however, you will need to hold down the Ctrl key and then click on the link.
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Links, Entry

Entry links are special hyperlinks within The Journal to allow jumping to another entry, or to a bookmark
within an entry.

Links, Internet

Internet links are links web page addresses, email addresses, and so on. You can also link to files on
your hard drive.

Media

Audio files and video files like .wav and .mpg are called "media files". You can embed media files in
your entries, and play them back.

Synchronizing

Keeping two installs of The Journal up-to-date with each other is known as synchronizing, or syncing.
See Synchronizing The Journal for more information.

Style

A style is a pre-defined text format. A style can set the font, change paragraph spacing and borders,
and more. The Journal automatically creates a small collection of styles for you besides the default (or
"Normal") style: Heading 1, Heading 2, Heading 3, and HTML Passthru (for blogs).

Topic

Topics are another way to organize your entries. You can set a topic (e.g., "Feelings -> Happy") to the
text of entry, either as you type it or afterward. You can set as many topics within an entry as you wish.
You can also "tag" an entry with a topic. In that case, the topic applies to the whole entry, not just to a
block of text. You can then search entries with a topic or topics and review them.

Blog Support

The Journal's blog support gives you the ability to post entire entries (or just selected portions of
entries), both text and images, to public blogs--without sacrificing privacy and security. You choose
what entries and information are posted to your blog, and keep sensitive and/or private information
inside The Journal.

Blogs Supported

B2Evolution (www.b2evolution.net)
Blog-City (www.blog-city.com)
Blogger (www.blogger.com)
Cafelog (www.cafelog.com)
LiveJournal (www.livejournal.com)
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MovableType (www.movabletype.org)

MSN Spaces (spaces.msn.com)

Quick Blogcast (from GoDaddy)

TypePad (www.typepad.com)

WordPress (www.wordpress.org or www.wordpress.com)

Custom: Blogger (blogs that support the Blogger API)

Custom: LiveJournal (blogs that use the LiveJournal API/source code)
Custom: MetaWeblog (blogs that support the MetaWeblog API)
Custom: MovableType (blogs that support the MovableType API)

Support for more blogs will be added as users request them. So if you don't see your favorite, check
Setting Up a Custom Blog or contact DavidRM Software (support@davidrm.com).

Using a Blog
Blog Profile

5.2.1 Using a Blog

Here are the steps to using a blog with The Journal:

1. Create your Blog Account

First, you will need a blog account to post to. Many blog hosts, like WordPress, LiveJournal and
Blogger, provide free accounts. You just have to sign up for one.

2. Create a Blog Profile in The Journal
Next, you need to create a blog profile so The Journal knows how to post to your blog.
Click on the Tools menu, and choose Blog Profiles...

On the Blog Profiles form, click on Create New Blog Profile and enter the necessary information:
* Blog Tool (example: LiveJournal)

¢ Alias/User Name (example: DavidRM)

* And so on.

See Blog Profile for more information about setting up your blog profile.

In most cases, you can leave the rest of the blog profile settings as they are.

3. Make an entry in The Journal

Bring up a blank entry and type up the text you want to post to your blog, just like you were making a
normal entry in The Journal.

4. Post the entry to your Blog

Select the text you want to post to your blog and right-click on it to bring up the editor's context menu.

© 1996-2016 by David Michael


http://www.movabletype.org
http://spaces.msn.com
http://www.typepad.com
http://www.wordpress.org
http://www.wordpress.com
mailto:support@davidrm.com
http://www.wordpress.com
http://www.livejournal.com
http://www.blogger.com

78

The Journal

5.2.2

Open the Post to Blog sub-menu and select the blog profile to use.

You will be prompted for your password, and then the selected text will be posted to your blog.
That's all there is to it!

Blog Profile

Blog Tool

Identifies the type of blog (e.g.: LiveJournal). Each blog tool has its own way of posting new entries.
Once set, the blog tool for a profile cannot be changed.
Alias

This is your alias/user name on the blog tool. This is required when logging into the blog to post an
entry.

Blog API

Host - This is the host site of your blog (e.g.: www.livejournal.com). The Journal communicates with this
site to post the entry to your blog.

Page - This is the page (e.g.: /interface/xmirpc/) on the blog's host site which The Journal uses to post
the entry to your blog.

Port - The port number (e.g.: 80) used to communicate with the host site. This number will be 80 in
most cases.

Timeout - The timeout value specifies how many seconds to wait for the host site to respond before
cancelling.

Proxy Settings
Do not use a Proxy Server - Use a direct connection (no proxy server) to the blog's host site.

Use Internet Explorer Proxy Settings - Use Internet Explorer's proxy settings to connect to the blog's
host site.

Use These Proxy Settings - Specify your proxy server information yourself. You must enter both an
Address and a Port. If necessary, you can also enter your proxy User Name and Password.

Export Settings
No Formatting (Simple Text) - Post entries to the blog as simple text, with no formatting.

Force doublespace between paragraphs - Force doublespacing (a blank line) between paragraphs.
NOTE: This option is only available if No Formatting is selected.

HTML Formatting - Post entry to the blog, preserving text formatting with HTML. NOTE: Not all text
formatting supported in The Journal is available in HTML.
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Use <BR> tag instead of <P> tag for paragraphs - By default, the HTML exported by The Journal
uses the <p> tag for paragraphs. If you would prefer that the export use the <br /> tag for paragraphs,
check this option.

Force a Leading Blank Line in Post - If checked, a single blank will be inserted at the top of the post,
followed by the content of the post. Specifically what happens is: all "white space" at the beginning of
the post, if any, is removed, and a single blank line is inserted.

Force a Trailing Blank Line in Post - If checked, a single blank will be appended to the bottom of the

post. Specifically what happens is: all "white space" at the end of the post, if any, is removed, and a
single blank line is appended.

Additional Settings

Make blog posts private - Post the entry to the blog as private, or not visible to other bloggers. Not
supported by all blog types.

Prompt for a title when posting - Prompt for a subject/title for the blog post. Not supported by all blog
types.

Use first line of post for title - If checked, the first line of your post will be used as the title, and
removed from the body of the post. Not supported by all blog types.

Save password for this profile - Save the password for this blog profile so that you don't have to type
it in every time. Un-check this option to clear the saved password and be prompted again.

Always post to this blog - If you can post to multiple blogs with this blog profile, you have the option of

always posting to the same blog, to avoid being prompted over and over. Un-check this option to be
prompted again.

5.2.3 Setting Up a WordPress Blog

If you have a blog hosted by WordPress (blogname.wordpress.com):
1. Blog Tool: WordPress

2. Alias/User name: blogname

3. Host: blogname.wordpress.com

4. Page: /xmirpc.php

If you are hosting your WordPress blog on your own server:
Example 1: www.blogname.com

1. Blog Tool: WordPress

2. Alias/User name: blogusername

3. Host: www.blogname.com
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5.2.5

4. Page: /xmirpc.php

Example 2: www.server.com/blogname
1. Blog Tool: WordPress

2. Alias/User name: blogusername

3. Host: www.server.com

4. Page: /blogname/xmirpc.php

Posting Entries with Images
NOTE: This only works if you are hosting WordPress on your own server.
If you want to post entries with images in them, you will need to some additional setup on the blog.

1. In the WordPress "dashboard", click on "Settings", and then bring up the "Miscellaneous Settings"
page.

2. Set the "Store uploads in this folder" option.

3. Finally, make sure that the folder specified exists.

Setting Up a Blogger (Google) Blog

1. Blog Tool: Blogger (Google)

2. Alias/User name: Your Gmail address (example: name@gmail.com)
The Blog API settings will be filled in for you automatically.

NOTE: If you have multiple blogs on Blogger, you will be prompted which one to post to when you do the
"Post Entry to Blog".

Setting Up a Custom Blog

Even if the blog site you use isn't listed in the Blog Profiles form, there's is still a good chance that The
Journal will work for you.

Gather the Necessary Blog Information

Check in your blog site's Help or FAQ (Frequently Asked Questions) section to find these bits of
information:

1. APl supported - Many blog sites support the Blogger API. The MetaWeblog is also popular. You
need this information so you can choose the correct "Blog Tool" in your blog profile. If you cannot find
this information, try "Custom: Blogger API".

2. Host site - The Journal communicates with the host site to post the entry to your blog. For many blog
sites, this is the same as blog's home page (e.g., www.typepad.com).
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3. Page - This is the page that is posted to on the host site.
The Host site and Page may be displayed as combined. Example: www.typepad.com/t/api/
In this case, you would separate the Host and Page like this:

Host: www.typepad.com
Page: /t/api/

NOTE: The Page may require a trailing slash (/).

Create Your Blog Profile
Once you have the above information, you can create your blog profile as described in Using a Blog.

5.3 Categories

The Journal's categories provide a powerful tool for organizing your journaling, notes or other writing
projects.

You can have as many categories as you want. Every category has its own collection of entries.

The Journal supports two kinds of category: calendar and loose-leaf.

Calendar Categories

Calendar categories can have entries for an hour, a day, a week, a month, a year--even for decades
and centuries. The "Daily Journal" category created for you automatically is a calendar category that
creates a new entry for you every day.

Calendar categories automatically organize your entries for you into days, weeks, months, and years.
You can also view summaries of your entries in a monthly calendar, or a horizontal yearly calendar.

You can create an entry for any date: past, present or future. Any date, from 1 AD to 9899 AD.

Don't worry about empty entries: The Journal doesn't store empty calendar entries. They are purged
when you log out or close The Journal.

Further, calendar categories can have loose-leaf entries, just like a loose-leaf category. These can be
sub-entries or attachments of calendar entries, or stand-alone entries.

Loose-leaf Categories
Loose-leaf categories are a collection of entries that are not tied to a particular date.

Entries in a loose-leaf category are named documents, arranged by you, just like a loose-leaf notebook
or folder. Loose-leaf category entries can be arranged in any order (just click-and-drag in the entry
tree), and entries can have sub-entries (which can have sub-entries, which can have sub-entries, and
SO on).

Loose-leaf entries can be sorted (forward and backward) by name, date create, date modified--or not
sorted at all.

© 1996-2016 by David Michael



82

The Journal

5.3.1

5.3.1.1

Calendar Categories

Calendar categories can have entries for an hour, a day, a week, a month, a year--even for decades

and centuries. The "Daily Journal" category created for you automatically is a calendar category that
creates a new entry for you every day.

Entries in a calendar category are always tied to a particular date (or date+time) or range of dates.
Calendar categories automatically organize your entries for you into days, weeks, months, and years.
You can also view summaries of your entries in a monthly calendar, or a horizontal yearly calendar.

You can create an entry for any date: past, present or future. Any date, from 1 AD to 9899 AD.
Don't worry about empty entries: The Journal doesn't store empty calendar entries.
Further, calendar categories can have loose-leaf entries, just like a loose-leaf category. Loose-leaf

entries can be sub-entries of calendar entries, and the category can have its own loose-leaf entries that
aren't sub-entries of calendar entries (just like a loose-leaf category).

See Category Properties: Calendar for more information.

Calendar Views

Calendar categories can display your entries in monthly and yearly calendar views.

In both calendar views, dates with entries have a slightly darker background and the day number
bolded (see below). You can see the first line of the entry (or entries) on a date by moving the mouse
over that date.

Reminders for a date are displayed with their calendar charm and the time, if applicable. You can see
the full name and time of the reminder by moving the mouse over the reminder.

If you click on a date, you will see a list of all the reminders for that date and summaries of the entry or

entries on that date. Entries with photos in them will have those photos reduced to thumbnails. You can
click-and-drag to select multiple, consecutive dates.

Month Calendar
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5.3.2 Loose-leaf Categories

Loose-leaf categories are often called "notebook" categories because of the "Notebook" loose-leaf
category that is created automatically for new users of The Journal.

Entries in a loose-leaf category are not tied to a specific date (as they are in calendar categories).
Instead, entries in a loose-leaf category are named documents, arranged by you, just like a loose-leaf
notebook.
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5.3.3

5.3.4

Loose-leaf category entries can be arranged in any order (just click-and-drag in the entry tree), and
entries can have sub-entries (which can have sub-entries, which can have sub-entries, ...). Arrange
your entries by clicking on the entry in the tree "dragging" it where you want it. You can move entries to
be "in front of" other entries (hover the mouse over the entry icon) or a "child of" other entries (hover
the mouse over the name of the entry). The mouse cursor will display differently based on the action
that will be taken.

Loose-leaf entries can be sorted (forward and backward) by name, date create, date modified--or not
sorted at all.

Shared Categories

Categories can be "shared" by users within a Journal Volume.

A shared category can be accessed by each user that links to it (and provides the optional sharing
password). All entries in the shared category are available.

Categories can be shared as either "read only" or "full access". A read only shared category allows all
entries in the category to be read, but those entries can only be updated by the user that owns the
category. The entries in a full access shared category, on the other hand, are treated just like any other
entries. They can be read, edited, deleted, or even re-arranged (in loose-leaf categories).

To see the available shared categories, click on the Category menu and choose "Shared
Categories..."

See Category Options: Sharing for more information.

Merging Categories

Click on the Category menu and choose "Merge Categories..."
This form allows you to merge two or more categories into a single category.

You can merge:

* | oose-leaf categories into other loose-leaf categories.
* | oose-leaf categories into calendar categories.

* Calendar categories into other calendar categories.

You cannot merge a calendar category into a loose-leaf category (do it the other way).

You cannot merge into a read-only category.

NOTE: This operation cannot be undone. If you change your mind, you will have to restore the category
or categories from a previous backup.

Merge these categories

Select the category or categories you want to merge from. Hold down the CTRL key when you click on
a category so you can select more than one.

Delete categories after merging

Check this option to delete the categories once they've been merged.
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Into this category

Select the category you want to merge into.

5.3.5 Add-on Packages

Add-on packages are collections of categories that can be installed into The Journal.

E-books, articles, templates, and more can be added to The Journal with packages. Once a package is
installed, the categories in the package are available as shared categories.

Some add-on packages may create new categories for you automatically. For example, the
Memorygrabber package for The Journal creates a "My MemoryGrabber" category for you to fill out.
The questions and prompts for the different parts of your life are typed in, so all you have to do is type
in the answers to quickly and easily create your memoirs.

To view the packages you have installed, click on the Tools menu and choose "Add-Ons..."

Add-ons Available

This is the list of packages that have are available but have not yet been fully installed.

Add-ons | am Using

This is the list of packages that you have fully installed.

Button: >>

Select an add-on package under "Add-ons Available" and click on this button to finish installing the add-
on. The install process usually will create one or more new categories with the content of the add-on.
Button: <<

Select an add-on package under "Add-ons | am Using" and click this button to stop using it. Those add-

on package categories that can be will be removed. Some of the categories you might have to delete
yourself using Category Properties...

Uninstall Add-on

This button removes the selected add-on package from The Journal.

5.3.6 Category Properties

Categories in The Journal are highly configurable.

You can see these options by right-clicking on the category tab (or clicking on the Category menu)
and choosing "Category Properties..." Then bring up the "Calendar" tab.

General
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Calendar

Entry

Entry Text Style
Security
Sharing

New Category
New calendar and loose-leaf categories can be created with this button. Options such as the category

name, the frequency with which the category will create entries (for calendar categories) and if the
newly created category should be a sub-category of an existing category can be chosen here.

Delete Category

When you click Delete, the highlighted category in the category tree will be deleted. You will be asked
to confirm this deletion before it actually takes place.

WARNING: This operation cannot be undone (if you make a mistake, you will have to restore the
category from a previous backup).

Category Properties: General
These options are available to all category types.

Category Name

This is the name of the category. The name of the category can be changed at any time.

Category Active (Visible)
If this option is un-checked, this category will not show in the category tree (or as a tab). Use this

option to "hide" categories that are no longer as active as they were. Should you need to access the
entries in the category, it's a quick and simple matter to make the category visible again.

Category is a Folder Only

This option is only available for categories that have sub-categories. By default, a Master Category
presents itself as a sub-category of itself. By setting the category as "Folder Only", though, this doesn't
happen.

Any category with sub-categories can be designated as a "folder only" category. These categories are
used to help you organize your categories and sub-categories.

NOTE: If a folder only category has entries, those entries aren't displayed. To access those entries, you
would need to un-check this option.
Show day planner with active reminders

When this option is checked your active reminders for Tasks, Events, Appointments and Special Days
will displayed in the day planner above the entry editor.
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You can choose to show reminders for the current day, the current week, or for the next 2 to 7 days.
And you can set the time scale of the planner for 1 hour, 30 minutes, 20 minutes, 15 minutes, 10
minutes or 5 minutes.

Only show if there are active reminders

When this option is checked (the default) the day planner will only display when there are active
reminders.

Show list of active to-do items

If checked, un-checked to-do items for this category will be displayed in a list above the entry editor.

Display start of week on

The category's calendar can be set to start on any day of the week, Sunday through Saturday.

Tab/Tree Color & Tab/Tree Text Color

These options define the color of the tab and text when the option "Show category color on tab or tree"
is active (User Preferences, Category tab).

By default, calendar categories and loose-leaf categories have different colors.

Category sort order
The sort order option controls in what order the category tabs are displayed.

You can also click and drag categories in the list to re-arrange them.
5.3.6.2 Category Properties: Calendar

These options are only available to calendar categories.

Create a New Entry Every ...

A calendar category can automatically create a new entry for you every:
* hour

2 hours

3 hours

4 hours

6 hours

8 hours

12 hours

day

week (on a particular weekday)
month (on a particular day: 1-31)
year
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* decade
¢ century

Include time (or date) in entry

In addition, the entry can include a time stamp (for hourly, daily, and weekly calendar categories), the
day (for monthly categories), the month (for yearly categories), and the year (for decade categories). If
this option is checked, the default stamp will be the current time and/or date, but you can choose any
time and/or date.

NOTE: The Journal doesn't save blank entries.

In any type of calendar category, you can also create a new entry at any time by pressing F9 (Entry
menu, Create New Entry sub-menu, and choose Create New Entry).

Round time to 5 minutes

If checked (the default), entry time stamps are rounded up to the nearest 5 minutes. Otherwise, the time
stamp is the current hour+minutes.

Display calendar folders for ...

Each type of calendar category (hourly, daily, etc) has a default set of "calendar folders" it displays in
the entry tree. You can customize which folders are displayed with this option.

For example, if "Years" is checked, in the tree to the left of the entry editor you will see the years that
you have created entries.

Actual entries are always displayed.

Display full entry date and time in tree

If checked (the default), in hourly, daily, weekly, and monthly categories:
¢ |f the display month folder (see above) is un-checked, the 2-digit month for the entry will be displayed
along with the 2-digit day.

Example:
4@ 2009
P 08 01 - Welcome
- How to Keep a Journal

¢ |f the display year folder is un-checked, the 4-digit year for the entry is displayed.

Example:
o 2009 08 01 - Welcome
- How to Keep a Journal

If un-checked, the above examples would look like this:

4@ 2008
P 01 - Welcome t
o How to Keep a Jou
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1 01 - Welcome to Tl
o How to Keep a Jou
Display day of week for daily entries in tree

If checked, daily entries will display the abbreviated day of the week (Sun-Sat) in addition to the day of
the month.

Example:

4@ 2009
4[] October
L 01 (Thu) (4:15 PM)

Display calendar entries after loose-leaf entries in entry tree

If checked, any root-level loose-leaf entries will be listed in the entry tree *before* the calendar entries.

Automatically lock past entries
If checked, then past entries of the category are locked by default.

This setting can be overridden at any time to make changes to a particular entry. Just select the entry,
and press F4 (or click on the Entry menu and choose "Lock/Unlock Entry").

Even if this option is not checked, you can make particular past entries locked (read-only).Just select

the entry, and press F4 (or click on the Entry menu and choose "Lock/Unlock Entry"). "Locked" will
display in the status bar below the entry editor to show that this entry has been locked.

Start on latest entry by default

If checked, the latest entry in the category is displayed when you first open the category. New, blank
calendar entries are not created automatically. To create a calendar entry, choose the date on the
calendar, or press F9.

5.3.6.3 Category Properties: Entry
These options are available to all category types.

Default Entry Type

This setting determines the default entry type of the category, and what kind of entry newly created
entries will be. In loose-leaf categories, this setting can be overridden to create an entry of any type.

Normal Document Entry

Document entries are formatted text documents, much like word processor files. Document entries can
have images, movies and other types of files inserted into them. It is recommended that calendar
categories use document entries.

See Document Entries for more information.
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External Object Entry
External object entries are essentially Windows data files stored in (or linked from) The Journal.

See External Object Entries for more information.

Image Entry
Image entries are graphic files (BMP, JPG, etc).

See Image Entries for more information.

Default Entry Template
The selected template will be inserted into new entries. For calendar categories, this template will be

inserted into new entries for the current day (or week or whatever). For loose-leaf categories, the
template will be inserted into all newly created entries.

Entry Tree/Editor Options

Display entry title in entry tree

If checked (the default), the title of the entry is displayed in the entry tree.
Display first line of entry in entry tree

If checked (the default), the first line of your entry is displayed in the entry tree (up to 50 characters).
You can see this by hovering your mouse cursor over the entry in the tree.

NOTE: If the first line of the entry is the same as the entry title, it will not be displayed.
Display entry count in entry tree

If checked, the number of entries in the category is displayed in the entry tree.
Display entry word count in status bar

If checked, the word count of the entry is displayed on the status bar beneath the editor. As you add or
delete words, the count updates.

For calendar categories, this option defaults to off. For loose-leaf categories, it defaults to on.
Display last updated date in status bar

If checked, the date the entry was last updated is displayed on the status bar beneath the editor.
Display entry topics in status bar

If checked, the topics tagged to the entry are displayed.

Save entry editor state between sessions

If checked, the position of the caret, including the selection of any text, and the scroll position of the
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entry editor is preserved for the entry. The next time you bring up the entry--even if you've closed The
Journal and restarted--you will be exactly where you were.

For calendar categories, this option defaults to Off. For loose-leaf categories, this option defaults to On.
Use WYSIWYG editor

If checked, the category's entries are edited WYSIWYG ("what you see is what you get"). That is, the
entries are displayed exactly as they would print to the active printer.

Loose-Leaf Options
Loose-leaf entry default name format

This option controls the name given to new loose-leaf entries. By default, the loose-leaf entry name
format is:
%c Entry

%c is replaced with the name of the category.

%date is replaced with the current date in short format.
%time is replaced with the current time in short format.
%d, %dd, %ddd, %dddd - current day

%m, Y%mm, %mmm, %emmmm - current month

S%yy, %yyyy - current year

Loose-leaf entry sorting

You can have your loose-leaf entries automatically sorted. The options are:
* None (no sorting)

* By entry title

* By date entry created

¢ By date entry updated

Reverse Sort Order

The entries are sorted as selected, but in reverse order.

Printing Options
Edit Page Setup, Header, Footer

Use these settings to override the page setup, header, and footer created in User Preferences: Printing.

Default Page Setup, Page Header, Page Footer, and Entry Header

Use this setting to restore the page setup, page header, page footer, and entry header created in User
Preferences: Printing.
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5.3.6.4 Category Properties: Entry Text Style

These options are available to all category types.

Entry Background Color

This is the default color used for the background of document entries.

Entry Background Image

This is the default background image used for entries in this category. This overrides the entry
background color, if that is also set.

Font and Paragraph Settings

Each category can be set to use a particular font and paragraph settings. By default, every category
uses the default font set by the user (or the parent category, if this is a sub-category).

Click on "Edit" to edit the font or paragraph settings. "Reset" will restore the font or paragraph back to
the default.

See Styles for more information.

5.3.6.5 Category Properties: Security
These options are available to all category types.
Category Entries are Read Only (and no new entries)

When checked, this category and its entries cannot be edited or deleted. Also, no new entries can be
created.

Category Password

If you want this category to have a password, enter it here. You will need to enter the password again in
the "Confirm Password" field.

If the category already has a password, you will need to enter the existing password to change it or to
Clear it.

Only Verify Password Once per Session

If checked, you will only need to enter the category's password once per journaling session. A
"session" starts any time The Journal prompts you for your user name password. Minimizing The
Journal will also cause The Journal to prompt you for category passwords.

If this option is not checked, you will have to enter the password every time the category is selected.
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5.3.6.6 Category Properties: Sharing
These options are available to all category types.
Lock Entries on Edit
If you are using The Journal over a network and/or sharing categories between users, and there is a
possibility that multiple users will be accessing and updating the entries of this category at the same
time, you will want to have this option checked. When a user edits an entry, that entry will be locked,
preventing other users from editing the entry at the same time.
Prompt for Lock Message
When "Prompt for Lock Message" is checked, all entries in the category are "Read Only" by default,
and you must use Entry | Edit Entry (hot-key: F4) and enter a lock message. This lock message is

displayed to any other users who attempt to edit the entry. Use this option along with "Lock Entries on
Edit" to further coordinate your editing with other users.

Category is Shared

If checked, this option allows other users within the Journal Volume to link to this category and access
its entries.

Read Only?

This option is only available if the category is shared. If checked, then other users can only read the
entries in the category. They cannot edit, delete, or re-arranged the entries in any way.

Category Share Password

If you want this category to have a share password, enter it here. You will need to enter the password
again in the "Confirm Password" field.

If the category already has a share password, you will need to enter the existing password to change it
or to clear it.

The share password must be entered correctly by other users to link to the shared category.

Note that the share password is different from the category password described in Category Properties:

Security.

See Shared Categories for more information.

54 Database Maintenance

The Journal's entry database has proven very stable over the years, but it is always a good idea to
make regular backups.

The Journal automatically prompts you to make a backup about twice a week (every 3 days). If you
would like to backup more or less frequently, you can set this using the Backup Settings.

See Backup/Restore for more information.
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5.4.1

5.4.2

5.4.3

Database Maintenance FAQ
How do | backup The Journal?

How do | restore from a backup?

How do | see what is in my backup file?

Backup/Restore

The Journal's Journal Volumes should be backed up regularly. For more protection, it is recommended
that you copy your backup file(s) to another computer or another location.

To backup The Journal, you have to login normally.

Backups can be made to any valid drive or folder on your PC, even network drives or external hard
drives connected by a USB.

Further, once the backup is completed, The Journal can automatically copy the backup file to separate
locations--even upload the backup file to an offsite FTP server.

It is possible to restore from a backup made with any previous version of The Journal since The Journal
2. (Restoring from a backup of The Journal 1.x, though, requires special instructions. Email DavidRM
Software.)

How do | backup The Journal?
How do | restore from a backup?
How do | see what is in my backup file?

Backup Settings

Backup options can be set through the File menu, Maintanance sub-menu, and then selecting "Backup
Settings..." These Backup Settings are also available from the User menu by selecting "User
Preferences...", and then bringing up the "Backup/Restore" tab.

See User Preferences: Backup/Restore for the available backup settings.

Restore

To restore from a backup, click on the File menu, Maintenance sub-menu, and choose "Restore from
Backup..."

Backup Archive

This is the name of the backup archive (*.joackup).

You can restore from a backup made by a previous version of The Journal (*.JBU or *.001). In this
case, a Journal Volume must be created especially for the restore and upgrade.

Backup Contents

This will list the Journal Volume that have been backed up into this archive, including the date of the
backup.
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Restore Journal Volume

This command will restore the selected Journal Volume. Unless you pick an earlier date, the restore will
automatically use the most recent backup of the Journal Volume.

Restore into New Journal Volume

This command allows you to create a new Journal Volume and restore into that, to prevent possibly
overwriting an existing Journal Volume.

See also How do | restore from a backup?

5.4.4 Repair The Journal Databases

To repair The Journal's Journal Volumes bring up the Journal menu, the Maintenance sub-menu, and
choose Repair The Journal Databases...

The repair process analyzes The Journal's database tables, correcting any problems that may have
appeared due to system shutdown issues or Windows crashes. The repair process also optimizes the
tables and minimizes the amount of disk space required for all database tables.

In general, The Journal's database tables are quite stable. It is unlikely you will need to use the repair
process more than once or twice per year.

If you have a lot of entries (5,000+) this process could take a few minutes.

Repair Journal Volumes

This button repairs and optimizes all Journal Volumes.

Repair System Database

This button repairs The Journal's System Database.
5.4.5 Clean Journal Volume folder

Click on the File menu, Maintenance sub-menu, and choose "Clean Journal Volume folder..."

This command removes all unnecessary or extraneous files from the folder of the current Journal
Volume.

The files deleted include:
¢ *.Qld - created by certain database updates.
¢ Allfiles left over from upgrading the Journal Volume from The Journal 6 or earlier.

5.5 Entries

Entries, organized by category, are the core of The Journal. Entries can be text documents, external
objects, or images.
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5.5.2

5.5.3

Most categories use document entries, which can include images and other types of files, though any
entry type can be set as the default for the category.

Document Entries
External Object Entries

Image Entries

Entries FAQ

How do | import my entries from Evernote, Penzu, or WordPress?
How can | import my entries from another diary or journal program?
How do | insert images in my entries?

Can | insert digital photos in my entries?

How can | use tables in my entries?

How do | make my tables look like those in MS Word/WordPerfect/Etc?
How do | use topics in my entries?

How do | lock my entries so they can't be edited?

How do | post my entries to a blog?

How do | use templates in my entries?

How do | have a template automatically inserted in my entries?

How can | create my own templates?

Why can't | edit my past entries?

How do | create loose-leaf entries in my calendar category?

Document Entries

Document entries are formatted text documents, much like word processor files. Text can be entered
freely to any length. Any Windows font (TrueType, Type-1, efc) installed on your PC can be used in
your entries.

Document entries can also include images (digital photos, clip art, calendar charms, etc.), media files
(audio and video), and even external objects like spreadsheets.

How do | insert images in my entries?
Can | insert digital photos in my entries?
How can | use tables in my entries?

External Object Entries

External object entries are essentially Windows data files stored in (or linked from) The Journal. If
possible, The Journal will use the standard icon for the file when displaying the entry in the date or entry
tree. Examples are: spreadsheets, word processor documents.

Double-clicking an external object entry will open the entry using the associated Windows application. If
possible, the application will be "hosted" inside The Journal.

External object entries can be "linked" to a file. When linked, the file is not stored inside The Journal.

External objects cannot be printed by The Journal. Instead, you will need to use the default application
for that external object to print it.

Loose-leaf entries can easily be dragged and attached as a sub-entry to any other entry, even a
calendar entry.

Image Entries

Image entries are graphic files (BMP, JPG, etc) that are stored in The Journal.
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5.5.4

Images can be bigger than the visible region of the screen. Clicking and dragging will scroll the image.
The image can also be scaled using the "wheel" on your mouse.

Image entries are much more space efficient than embedding images in document entries because
they store the image in its native format.

When printing image entries, the image is scaled to fit the page.
NOTE: Image entries are included for backwards compatibility with earlier versions of The Journal. For

most users, document entries provide a more flexible and powerful way to organize images in The
Journal.

Create New Calendar Entries

In a calendar category, click on the Entry menu, Create New Entry sub-menu, Document Entry (hot-
key: F9).

How this form works depends on the type of calendar category.

Daily

You choose the day, and (optionally) the time of the entry.

Hourly

You choose the date and the hour. You can optionally set the minutes of the entry.

Weekly

You choose the week, and (optionally) the day of the entry.

Monthly

You choose the month, and (optionally) the day of the entry.

Yearly

You choose the year, and (optionally) the month of the entry.

Decade

You choose the decade, and (optionally) the year of the entry.

Century

You choose the century, and (optionally) the decade of the entry.
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Saving Entries

The Journal automatically saves your entries in your Journal Volume, which is a database.

If you want to save your entries in a format that can be accessed by other software (like a word
processor), you have a couple of options:

¢ "Save Entry As..." (on the File menu, Export sub-menu; hot-key: F12)

¢ "Export Entries as Document...” (on the File menu, Export sub-menu)

Save Entry As...
The "Save Entry As..." command saves the currently active entry to your hard drive.

You can choose to save the entry in a variety of formats:

¢ Rich Text Format (.rtf) - All the text of the entry is saved, with full formatting (font, bold, etc).
Inserted images and objects are saved into the file. Rich text files can be opened by MS Word,
WordPerfect, and almost any other Windows word processor. This is the default format.

¢ DocX Format (.docx) - All the text of the entry is saved, with full formatting (font, bold, etc). Inserted
images are saved into the file. DocX files can be opened by MS Word, WordPerfect, and almost any
other Windows word processor.

¢ Plain Text (.txt) - All the text of the entry is saved, but without formatting. Inserted images and objects
are not saved.

e HTML (.html) - All the text of the entry is saved, with full formatting (font, bold, etc). Inserted images
and objects are saved in separate files.

Export Entries as Document...
Use the "Export Entries as Document..."” command to save one or more entries to your hard drive.

You can select any number or entries (even entire categories) and save them to the same variety of file
formats described above. You can also save the entries in one, large file, or save each entry in its own
file.

For more information, see Export Entries.

Search Entries

Beyond searching for a word or phrase in a single entry, The Journal supports queries that can span all
categories and entries. Plus you can search for text (word, phrase, collection of words), and you can
search for topics.

You can search:

* entry text

® entry titles

* image descriptions

* reminder names and notes

Search Text

Enter the word, words, or phrase you want to search for here. Separate words with spaces. Words in
quotes "like this" are treated as a single search term.
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Queries are not case-sensitive, so don't worry about uppercase and lowercase.

Where to Search

¢ Search entry text - Look for the word(s) in the text of the entry (a normal search).

* Search entry titles - Look for the word(s) in the names of entries.

¢ Search image/media/object descriptions - Look for the word(s) in the descriptions of images and
objects.

® Search reminder names and notes - Look for the word(s) in the names and notes of reminders.

By default, the search will look in the entry text, entry names, image/media/object descriptions, and
reminder names and notes. Turn off one or more of these to narrow the scope of the search (for
example: to search only in image descriptions).

Text Search Options

* Search for for word phrase - The search text is taken as a single phrase. The entire phrase must
be matched for the search to find anything.

¢ Search for any word (OR) - The search text is a collection of words (or quoted phrases) separated
by spaces. If an entry contains any of these words, it will be listed. A "Match %" will be displayed,
indicating what percentage of the searched-for words are present in the entry.

¢ Search for all words (AND) - The search text is a collection of words (or quoted phrases) separated
by spaces. An entry must contain all of the words to be listed as a match. The words don't have to be
in any particular order in the entry to match.

¢ Search with query (phrase is match query) - The search text is passed to the indexed search
engine as a match query. This allows you to use special keywords like NEAR.

¢ Match whole words only - If checked, a word must be matched in full (no sub matches). This option
is ignored when doing a "Search with query".

Match Queries

See Match Query Syntax for detailed information.

Search Topics
Select the topic(s) you want to search for.

The topics you have used at least once in an entry are listed first, in alphabetical order. All other topics
are listed in alphabetical order following the ones you have used.

Topic Search Options

¢ Search for entries with any of the topics (OR) - If an entry contains any of the selected topics, it
will be listed.

¢ Search for entries with all of the topics (AND) - Only if an entry has all of the selected topics will it
be listed.

¢ Display only topic text in search results - In the Search Results, when viewing an entry (or all
entries), only those parts of the entry tagged with the selected topic(s) will be displayed.

* Include sub-topics in search results - If an entry has a sub-topic of a selected topic, the entry will
be included in the search results.

Search Options

You can limit the number of categories searched. By default, the search looks in all categories.

© 1996-2016 by David Michael



100

The Journal

5.5.6.1

Search this date range only (for calendar categories)
Check this option to limit the search to calendar categories (like "Daily Journal"), and to further limit the
search to the specified date range.

Search recent entries first (for calendar categories)
Check this option to search from the most recent entries to the least recent entries.

Search active category only
Check this option to look only in the active category.

Search all categories
Uncheck this option to limit your search to the categories you select

Include sub-categories in search
If checked, the sub-categories of the selected categories will be search, as well as the selected
categories.

Force re-indexing of all entries in categories searched
If checked, all entries in the categories to be searched will be re-indexed. This completely rebuilds the
index used for fast searching, so it should not be done unless needed.

Match Query Syntax

The search text is passed directly to the indexed searching engine. Match queries can include OR and
AND and even NEAR. These are explained below.

NEAR

The NEAR operator may be used to search for entries that contain two or more words or phrases within
a specified proximity of each other. The NEAR operator must always be specified in upper case. The
word "near" in lower or mixed case is treated as an ordinary token. For example, the following query:
engineering NEAR consultancy

matches rows that contain both "engineering" and "consultancy" in the same entry with not more than
10 other words between them. It does not matter which of the two terms occurs first in the entry, only
that they be separated by only 10 words or less. You may also specify a different required proximity by
adding "/N" immediately after the NEAR operator, where N is an integer. For example:

engineering NEAR/5 consultancy

searches for entries containing an instance of each specified word separated by not more than 5 other
words. More than one NEAR operator can be used in a sequence. For example this query:

reliable NEAR/2 engineering NEAR/5 consultancy

searches for entries that contain "reliable” separated by not more than two words from an instance of
"engineering", which is in turn separated by not more than 5 words from "consultancy". Phrases
enclosed in quotes may also be used as arguments to the NEAR operator.

OR

Similar to the NEAR operator, one or more words or phrases may be separated by OR. In this case,
only one of the specified words or phrases must appear in the entry. For example, the query:
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hello OR world
matches entries that contain either "hello", or "world", or both.

%1

Any part of the match query, whether or not it is part of a phrase enclosed in quotes, may have a
character appended to it. In this case, the token matches all terms that begin with the characters of the
token, not just those that exactly match it. For example, the following query:

david*

matches all entries that contain "Davidson" and "David's", as well as those that contain "David".

Parentheses

Parenthesis may be used to overcome the built-in precedence of the supplied binary operators. For
example, the following search text:

(hello world) OR (simple example)

matches entries that contain both "hello" and "world", and entries that contain both "simple" and
"example".

AND

An AND operator may be explicitly specified. For example, the following query is handled identically to
the one above:

(hello AND world) OR (simple AND example)

As with the OR and NEAR operators, the AND operator must be specified in upper case. The word
"and" specified in lower or mixed case is handled as a regular token.

NOT

The NOT operator requires that the query specified as its left-hand operator matches, but that the query
specified as the right-hand operator does not. For example, to query for all entries that contain the term
"example" but not the term "simple", the following query could be used:

example NOT simple

As for all other operators, the NOT operator must be specified in upper case. Otherwise it will be treated
as a regular token.

Precedence
The precedence of the match query operators, in order from highest to lowest, is:

NEAR (highest precedence, tightest grouping)
NOT

AND

OR (lowest precedence, loosest grouping)

It is possible to specify expressions enclosed in parenthesis as operands to the NOT, AND and OR
operators. However both the left and right hand side operands of NEAR operators must be either words
or phrases. Attempting the following match query will return an error:

© 1996-2016 by David Michael



102

The Journal

5.5.7

journal NEAR (fantastic OR impressive)

Queries of this form must be re-written as:

journal NEAR fantastic OR journal NEAR impressive
Search Results

Found entries are displayed in a manner much like that used by search engines on the Web:

Daily Journal - Wednesday, September 08, 2004
... some search text here ...

The first line is an entry link. Clicking on the link brings up the content of that entry, with the search text
(or search topics) highlighted.

The next line shows one example of the search text found, with some context both before and after.

If the Search Results form is ever hidden from view, you can bring it back by choosing Search Entries
on the Search menu, or by pressing the hot-key: Shift+Ctrl+F

Stop Search

Stops the current search (if it hasn't already completed).

New Search

Stops the current search and brings up the Search Entries form again.

Results per Page

You can set the number of results shown per page, from 1 to 100.

Print/Print Preview

Print (or Print Preview) will print either the list of results currently displayed, or the entry selected.

Insert Page Break

To provide more control over the printing, you can insert page breaks. You can also remove the page
breaks you insert.

Show Page Breaks

Click on this command to see where the currently displayed text (result list or entry) will have page
breaks.
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Hide Highlight

This command toggles the highlighting of search terms. This can be useful when printing the search
results, or saving them to a file.

Save to File

Click on this command to save the search results to a file on your computer.

Next Search Term

Click on this button (or press the hot-key F3) to move forward through the entry, highlighting each of the
search terms in turn. When you reach the end of the entry, Next Search Term will loop back to the
beginning.

Entry Report Wizard

To bring up the Entry Report Wizard, click on the Tools menu and choose "Entry Report Wizard..."
Click on the report you would like to see, and the wizard will guide you through the parameters.

It's possible to save reports with their settings for quicker access.

Daily/Weekly Entry Report

Use the Daily/Weekly Entry Report to collect all of the entries made in a given date range: a day, a
week, a month, a year, or any range at all.

NOTE: This report is for calendar categories (like Daily Journal) only.

Example:

You have a project-specific calendar category called "Project Notes" where you track your daily
progress, meeting notes, and so on. On Monday, you want to print out a report of what you did the
previous week. So you:

1. Bring up the "Project Notes" category tab.

2. Click on the Tools menu, choosing Daily/Weekly Entry Report...

3. Select Last Week.

4. Click on See Report.

All of last week's entries in "Project Notes" are now compiled in proper order. You can review them and
then print the report.

Daily/Weekly Reminder Report

The Daily/Weekly Reminder Report is similar to the Daily/Weekly Entry Report, but only reminders
reminders that came due or were completed in the chosen date range.

New/Updated Entry Report

Use the New/Updated Entry Report report to see all of the entries that were created or modified in a
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given date range: a day, a week, a month, a year, or any range at all.

Look for:

* Newly created entries - Entries that were first created within the date range.

¢ Edited/updated entries - Entries that were edited or otherwise updated within the date range.

¢ Show body of entry in report - If checked, the body of the entries is included in the report. If it is
not checked (the default), only the entry headers are displayed. You can click on the entry headers
in the report to see the full entry.

Entry Index

The Entry Index is a report of all enfries in a category or categories, arranged and indented for clarity.
Only the entry date or title is displayed.

The entry name is linked, so you can click on the entry name to see the actual entry.

Topic Usage Report

The Topic Usage Report provides a summary of how many entries contained each topic over the
selected date range.

5.5.9 Entry Report Results

When the Entry Report Wizard collects all of the appropriate entries, it uses this form to display the
results.

The entries are sorted by category, and then by entry date (for calendar entries) or by sort order (for
loose-leaf entries). The category name is displayed before the first entry from that category, and the
entry name is displayed before each entry.

New Report

Discards the current report and brings up the report form again, so you can create another report.

Print/Print Preview

Print (or Print Preview) will print either the list of results currently displayed, or the entry selected.

Page Break

To provide more control over the printing, you can insert page breaks. You can also remove the page
breaks you insert.

Show Page Breaks

Click on this command to see where the currently displayed text (result list or entry) will have page
breaks.
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Save to File

Click on this command to save the report to a file on your computer.

5.5.10 Delete Entries

Entries can be deleted either one at a time from the category's "entry tree", or in batches using the
Delete Entries... command on the Entry menu.

Once an entry has been deleted, it cannot be recovered (except by restoring from a backup).

5.5.11 View Deleted Entries

Click on the Entry menu and choose "View Deleted Entries..."

Entries that you delete aren't immediately removed from the Journal Volume. Instead, they are marked
as deleted and stored here.

You can use this form to recover deleted entries or to permanently delete them.
The entries are displayed by category.

NOTE: When you delete a category from Category Properties, that category's entries are immediately
deleted.

5.5.12 Lock/Unlock Entries

Entries can be "locked" to prevent editing. A locked entry will display "Locked" on the status bar below
the entry editor.

Press F4 to lock the active entry.
Press F4 again to unlock the active entry.
5.6 Export/import & Syncing
The Journal supports the export and import of entries via several formats.
Supported Export Formats
Text Files (. TXT)
Rich Text Files (.RTF)
HTML Files (.HTM)
XML Files (.XML)
Journal Export Files (.TJEXP, .TJXML)

Text files are simply text, such as files made with Windows Notepad. The only formatting in text files is
marking end of lines with carriage returns.

Rich Text files, also called RTF files, contain full text formatting information. Font, paragraph alignment,
colors, and so on, are all preserved. RTF files can be read by most Windows word processors.

HTML files are text files with "hypertext markup language" tags embedded. These tags control formatting
of the file when it displayed with a web browser, such as Internet Explorer. HTML files are only
supported when exporting.

XML is also a text format, so you can edit it in every ANSI text editors (for example Notepad). The
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Journal has its own set of XML tags, but you can browse XML documents exported from The Journal in
every XML-compatibile Web Browser.

Journal Export (.TJEXP, .TJXML) files provide a way to transfer categories and entries, with all
formatting in the entries, as well as other category and entry information, between different installations
of The Journal.

Export/Import FAQ
How do | import my entries from Evernote, Penzu, Diaro, DayNotez, or WordPress?

How can | import my entries from another diary or journal program?

Export Entries as Document

The Journal supports a number of exporting options. You can export a single entry, an entire category,
or a collection of entries from multiple categories to a file or files that can be viewed or opened by a
word processor or Web browser.

Click on the File menu, Export sub-menu, and choose "Export Entries as Document..."

Select Categories/Entries to Export

Active Entry

Only the active entry will be exported.

Active Entry with All Sub-Entries

The active entry and all of its sub-entries will be exported.
Current Day (in all Calendar Categories)

The entry for the current date in all calendar categories will be exported. No loose-leaf entries will be
exported with this option.

Entire Journal (all categories, entries & reminders)
Your entire journal will be exported.
These Categories/Entries

Whichever categories or entries you select will be exported. Entire categories can be selected for
exporting, or groups of entries spanning several categories.

Export Type

Rich Text (.RTF) - Rich Text, or RTF, files include all text formatting and embedded images/objects.
RTF files can be opened by nearly all Windows word processors.

DocX File (.DOCX) - DocX files files include all text formatting and embedded images. DocX files can
be opened by nearly all Windows word processors.
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Plain Text (.TXT) - Entries exported to plain text files are stripped of all formatting except line-breaks.
TXT files can be opened by any text editor and all word processors.

HTML (.HTM) - HTML is the standard format of the World Wide Web. They can be edited by any text
editor, most Windows word processors, and, or course, they can be displayed with any Web browser.

Most text formatting is preserved, though not all. Embedded images are extracted to JPG files and linked
from the exported .HTM file.

Export Options
File Options:
¢ Create a Single File for all Exported Entries - This option creates a single file for all exported

entries. Categories are given "headers" to separate their entries.

¢ Create a File for each Exported Category - This option creates a file for each exported category.
Only entries exported from that category are included in its file.

¢ Create a File for each Exported Entry - This option creates a file for each exported entry.
Depending on the number of entries exported, this option could result in a lot of files being created.

Include Category Name Header in export

By default, exports to RTF/TXT/HTM include the category name as a header before the first exported
entry for that category. Un-check this option to prevent this.

Include Entry Date/Name Header in export

By default, exports to RTF/TXT/HTM include the entry date/name as a header for each exported entry.
Un-check this option to prevent this.

Page Break (RTF export)
* Between Categories
¢ Between Entries

If checked, page breaks will be inserted between categories and/or entries in the RTF export file.

File Names
Category File Name

If the Create a File for each Exported Category option is used, this setting controls the name of the
export file.

To include the name of the category in the file name, use the "%c" flag.
Entry File Name

If the Create a File for each Exported Entry option is used, this setting controls the name of the export
file.

To include the name of the category in the file name, use the "%c" flag. To include the name (or date)
of the entry, use the "%e" flag.

Include "Full Path" in Loose-Leaf Entry Names
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5.6.2

If checked, loose-leaf entry names include their full "path" of parent entries.
Export Path Separator

If exported loose-leaf entries will include their full path, it is necessary to specify a replacement for the
backslash (\ ) character in the path. The backslash (\ ) is not allowed in Windows file names.

This option is also used with the File | Save Entry As... command.
Date Format

For categories with entries tied to a date, such as standard categories, this setting controls how the date
is formatted in the export file name.

Export Entries as File

The Journal supports a number of exporting options. You can export a single entry, an entire category,
or a collection of entries from multiple categories. The resulting export file can be used to easily transfer
entries to another copy of The Journal or, depending on the file type, other journaling or notekeeping
software.

Click on the File menu, Export sub-menu, and choose "Export Entries as File..."

Select Categories/Entries to Export

Active Category

All entries in the active category will be exported.

Reminders

All of your reminders will be exported.

Entire Journal

Your entire journal, all of your categories, entries and reminders will be exported.
These Categories/Entries

Whichever categories or entries you select will be exported. Entire categories can be selected for
exporting, or groups of entries spanning several categories.

Select Export File Type

The Journal Export File (.TJEXP) - The Journal Export Format is a proprietary format used only by
The Journal. It preserves not only all text formatting, but it also preserves all category and entry settings.
TJEXP files are used primarily to transfer entries from one installation of The Journal to another.

The Journal XML (.TJXML) - The Journal's XML export format is similar to the TJEXP format, but uses
XML. Being XML, other software could access the data, so long as they can parse The Journal's tags.

NOTE: Unlike the TIEXP format, the TJXML format is limited to 2GB.

ATOM Publishing Format (.XML) - The ATOM publishing format is a simple, xml-based format used by
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some blogs and other journaling software (such as Penzu).

NOTE: This format is limited to 2GB.

Export Options

Password Protect - If checked, you will be prompted for a password to lock the export file. This option
is only available for the TJEXP format.

Compress - If checked, the content of the export file is compressed when saved, resulting in a smaller
file. This option is only available for the TUEXP format.

5.6.3 Importing Entries

Click on the File menu, Import sub-menu, and choose "Import Entries..."

Importing Documents

Many document formats can be imported into The Journal:
* Text files (.TXT)

Rich text files (.RTF)

HTML files (.HTM;.HTML;.SHTML)

MS Word documents (.DOC)

Word processing documents (.DOCX)

Document files are imported into the currently selected entry. If the entry is not empty, the document
contents are appended to the existing entry. Only a single document can be imported at a time.

Importing Export Files

In addition to documents, The Journal can also import a wide variety of export files, including export
files created by other software, such as Evernote and Penzu.

The Journal export files (. TJEXP, .TJXML, .JNX, .JNL)
Evernote (.ENEX)

Penzu (.XML)

ATOM publishing format (.XML)

WordPress export (.XML)

As you can see, a number of export files use the .XML file extension. The Journal opens the XML file
and determines the type of export it contains.

The Journal export file types (.TUEXP, .TUJXML, .JNX, .JNL) bring up the Import Entries form, allowing
you to choose which categories and entries to import. The other file formats prompt you for the
category you wish to import into and import all the entries in the file.

If the category you are importing into already has entries, The Journal will verify every entry before
importing it. If an entry already exists in the category, and the current entry is identical to the entry
being imported, the current entry is kept. If the entry being imported is different from the current entry,
though, you will be prompted for proper handling. You can choose to either import the new entry
(overwriting the existing entry), keep the current entry (discarding the import entry), or keep both
entries.
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See also: Batch Entry Import and How do | import my entries from Evernote, Penzu, or WordPress?

5.6.4 Import Entries

This form is used for The Journal's export files (. TVEXP, .TUXML, .JNX, .JNL), as well as export files
from Evernote (.enex), Penzu (.xml), and WordPress (.xml).

Select Categories/Entries to Import
Check a category to import that category and all of its entries, including any sub-categories.

You can also expand a category to select one or more specific entries to import.

Entry Preview

When you click on an entry in the tree, the content of the entry is displayed here.

Import
If you have checked any categories or entries, only those categories and/or entries will be imported.
If you check nothing, all categories and entries in the export file will be imported.

For each category being imported, you will be prompted to use an existing category (if you already
have a category with the same name of the same type) or to create a new category. Itis also possible
to skip a category during the import.

If the category you are importing into already has entries, The Journal will verify every entry before
importing it. If an entry already exists in the category, and the current entry is identical to the entry
being imported, the current entry is kept. If the entry being imported is different from the current entry,
though, you will be prompted for proper handling. You can choose to either import the new entry
(overwriting the existing entry), keep the current entry (discarding the import entry), or keep both
entries.

5.6.5 Importing Entries from Other Journal Software

Many people, myself included, have kept their personal journals using other software.

There are a couple of ways of importing these previously existing entries. Which method to use
depends on your circumstances: which software was used, how the entries are saved, etc.

Some software, such as Evernote or Penzu, can create export files that The Journal can read. See
Importing Entries and How do | import my entries from Evernote, Penzu, or WordPress? for more
information. Most other software, though, will require you to use one of the processes described below.

Batch Export/Batch Import

The most convenient method is to use the other software's export capability and The Journal's import
features.

1. Create a temporary folder on your hard drive.

2. Export your entries from the other software into individual text (.bxt), rich text (.rtf), or HTML (.htm;.
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html) files. Export to the temporary folder you created in #1. If the entries are for a particular day, make
sure the date is used in the name of the exported file. The best date format will use a 4-digit year, a 2-
digit month, and a 2-digit day.

Example:
1993-10-05.rtf (entry for 5 October, 1993)

3. Once you have the entries exported, start The Journal. On the File menu, Import sub-menu, choose
"Batch Entry Import..." to import the entries into The Journal.

4. Under "The entries to be imported are:" choose "Each in a separate file (one entry per file)".
5. Choose the category you want to import the entries into (like "Daily Journal).

6. Browse to the temporary folder where your exported entries are.

7. Set the "Specify Date Format" to match how the export named your entries.

Example:
yyyy-mm-dd.rtf

Then do the import.

See Batch Entry Import for more information.

Copy-and-Paste Method

If the software you were using does not support exporting files, but was a Windows program, then this
method will work. It's not the most efficient method, but it's the same way yours truly (the author)
"imported" 3 years of entries made in Microsoft Word documents (one document per month).

1. Launch both the original software and The Journal.

2. In The Journal, select the Category to receive the imported text. Then use the calendar and choose
the appropriate entry date, or create the new entry.

3. Use the Windows Taskbar (or Alt-Tab) to bring up the original software.

4. Select the text in the original software that you wish to import into The Journal, and then copy the text
to the Windows clipboard (Edit | Copy).

5. Use the Windows Taskbar (or Alt-Tab) to bring up The Journal and paste the text in the active entry
(Edit | Paste or Ctrl-V).

6. Repeat until all of the desired entries from the old software have been entered into The Journal.

5.6.6 Batch Entry Import

Many journal software products support exporting your entries in that software to a collection of text (*.
TXT), rich text (*.RTF), DocX (*.DOCX), or HTML (*.HTML) files. With the Batch Entry Import form
(on the File menu, Import sub-menu), you can import those files directly into The Journal.

InfoSelect v8/v9 HTML export files - The Journal can import notes exported from InfoSelect v8/\9 to
HTML format. When you select this option, you will need to select a loose-leaf category to import into.
Also, you will have to browse to select the "Selector. HTM" file created by the IS export.
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Batch Entry Import can also import entries that are all in the same file in the following formats:
Simple CSV (comma-separated values) (Format: "Date/Time","Entry Text")
DayNotez CSV file

750words.com export file

Cumberland Diary export file

WordPress export file (.xml) - both posts and pages

Evernote export file (.enex)

Penzu export file (ATOM publishing format) (.xml)

Diaro export file (text entries only) (.xml)

Lotus Organizer CSV file

Orange Diary Pro CSV file

EfficientPIM CSV file

If you need support for another export file format, contact DavidRM Software: support@davidrm.com

WordPress NOTE: When importing a WordPress export file, if a post includes <img ... /> tags, The
Journal will attempt to download those images and insert them into the entry.

Evernote NOTE: The Journal will attempt to load most types of files attached to a note: images (PNG,
JPG, etc), applications (PDF's, docs, etc), and media files (audio & video).

Importing into a Calendar Category

To be imported into a calendar category, the entry files must all use a standard naming convention. The
date of the entry must be included in the file name. The best date format will use a 4-digit year, a 2-digit
month, and a 2-digit day.

If the entries you are importing have a timestamp, that should be specified, as well. Use the 24-hour
clock for the time stamp, 2-digit hour (00-23), a 2-digit minute (00-59), and (optionally) a 2-digit
seconds (00-59).

Example:
2001-05-01.RTF (entry for 1 May, 2001)

This would need a format of: YYYY-MM-DD

Example with a timestamp:
2007-08-16 16-24-00.RTF

This would need a format of: YYYY-MM-DD HH-NN-SS

NOTE: Dashes (-) were used instead of colons (:) in the timestamp, because colons aren't valid in file
names.

You can also import files with long (December) and short (Dec) month names in the name.

Example with long month names:
2006 October 26.RTF

To import those files, you would need to set the date format to: YYYY MMMM DD

MMMM = long month name
MMM = short month name
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Importing into a Loose-Leaf Category

When importing into a loose-leaf category, no special naming convention is required. The name of the
imported entry file will be used as the name of the entry.

Remove file extension from imported files - Check this option to remove the file extension when
naming the entries.

5.6.7 Synchronizing The Journal

Keeping two (or more) installs of The Journal synchronized (in sync) is simple, and can be done a
variety of ways.

You can sync The Journal from any of the following:

¢ A backup file created by The Journal (.JBACKUP).

¢ A Journal Volume folder on an external hard drive.

¢ A Journal Volume in The Journal.

* An export file created by The Journal (. TJEXP, .TJXML, .JNX, .JNL).

In each case, the steps are the same:

1. Click on the File menu, Import sub-menu, and choose the appropriate "Sync from ..." command.

2. Select the Journal Volume, or browse to select the file or folder you're syncing from.

3. Select what you want to sync/import.

4. Map categories from the sync file to the categories in The Journal.

5. Review and resolve any conflicts in your entries, reminders, images, topics and text styles.

6. Run the synchronization.

NOTE: When syncing from a backup file, The Journal creates a temporary Journal Volume restores the
backup file into that Journal Volume. If the backup is from an earlier version of The Journal, this Journal
Volume will need to be upgraded before the syncing can happen. If that happens, you will see

notifications. When the syncing process is finished, this temporary Journal Volume is deleted. The
backup file is not affected or updated in any way.

Example 1. Syncing The Journal from Work to Home

You have The Journal installed on your laptop at work and your desktop at home, and you want to keep
them in sync.

NOTE: This process takes longer to describe than to actually do. So don't panic. :-)

1. On your work laptop, run The Journal and create a backup file. File, Maintenance, Backup The
Journal...

2. Copy the backup file you created to a USB/Flash drive or email the file to your home address.

3. On your home desktop, run The Journal and log in.
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4. Click on the File menu, Import sub-menu, and choose "Sync from Backup File..." Browse to select
the backup file. If your login has a password, you will be prompted for that. If you have more than one
login, you will be prompted which one to sync from.

5. The first step of the sync process is to choose what you want to sync:
* Categories & Entries

* Reminders

* Topics

* Images (entry backgrounds and calendar charms)
* Text Styles

By default, all of these options are checked.

6. If you are syncing categories and entries, the next step is to "map" the categories in the backup to
the categories you already have. The Journal attempts to do this for you automatically. By default, if a
matching category exists, it is automatically mapped. If a category in the backup does not have a
matching category in The Journal, it will be set to be created and copied. You can change the mapping
of categories and/or you can choose *not* to import certain categories by un-checking them in the list.

7. Once the categories are mapped or set to copy, the sync process will analyze all the entries in the
mapped/selected categories for conflicts. Conflicts only happen if the same entry is in the backup file
*and* already in The Journal. In this case, The Journal inspects both the entry in the backup file and
the entry in The Journal. If the two entries are identical, there is no conflict. If the entries are different in
some way, how they are different is reported.

8. If there are entry conflicts, you will need to resolve them. What this means is that for each entry
conflict, you have to choose one of the following:

* Import the entry from the backup file, overwriting the current entry; or
¢ Keep the current entry (discarding the entry in the backup file).

NOTE: If the actual content of the entries have a conflict, you have an additional option. You can view
the two entries side-by-side and edit the current entry manually.

9. If you have any reminder conflicts, you will need to resolve those.

10. If you have any image conflicts, you will need to resolve those.

11. If you have any text style conflicts, you will need to resolve those.

12. The last step is the actual syncing. Up until now, and even now, you can choose to exit the sync-ing
process and nothing is changed or updated. Once you press "Sync", though, all of the changes begin
and cannot be interrupted.

NOTE: The first time you go through the syncing process is usually the longest and most involved. You
may to map categories and resolve a lot of conflicts. After that, though, you can usually just click Next,

Next, ... Sync and you're done.

To sync the work laptop from your home desktop, you do the same thing, but sending a backup file
from home to work.

Example 2. Syncing The Journal from USB to Desktop

You have The Journal installed on a USB/Flash drive and your desktop at home. You normally keep the
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USB drive with you so you can access The Journal from any Windows computer, but you also want all
the same categories and entries on your desktop at home.

1. Insert your USB drive into the desktop computer.
2. Run The Journal on your desktop computer and log in.

3. Click on the File menu, Import sub-menu and choose "Sync from External Journal Volume..." Browse
into the folder on your USB drive that has your Journal Volume. The default path is:
Z:\The Journal 6\The Journal Volumes\6\My Journal\

4. Follow steps 5-12 in Example 1 (above).

5.7 Images & Media

The Journal lets you include images of all sorts in your entries: digital photos, animated graphics, and
icons (like Calendar Charms). You can also set images as backgrounds for your entries, much like you
can with a Web page.

Beyond images, The Journal also lets you include audio and video files in your entries. Audio and video
files are called "media files".

Read more about using images in The Journal:

Using Images in Entries

Entry Background Images

Creating Your Own Borders
Calendar Charms

Creating Your Own Calendar Charms

Loading Images

Read more about using media files in The Journal:

Inserting Media Files into Entries
Playing Media Files

Inserting Objects into Entries

5.7.1 Using Images in Entries
Inserting Images
To insert images in your entries:

Click on this icon on the toolbar:
| = [ 2 @ FE V]

Or click on the Insert menu, and choose "Insert Image..."

You can also drag images from Windows Explorer and drop them into your entry.

Resizing Images
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5.7.2

When you first insert an image into your entry, the image is resized to fit the entry editor. Click and
drag on the edges of the image to resize it.

If you would prefer to view the image at full size, right-click the image and choose Toggle Image Full/
Fit Window.

You can also double-click the image to toggle full size and back.

Image Descriptions

Images can be given descriptions. These descriptions are displayed when you hover the mouse over
the image. Also, you can do searches of image descriptions.

To give an image a description, or to edit an image's description:
1. Click on the image to select it.

2. Click on the Edit menu, and choose Edit Image/Object Description (hot-key: Ctrl+Shift+D).

Searching Image Descriptions

To search through the descriptions of all images in The Journal:

1. Click on the Search menu, and choose Search Entries... (hot-key: Ctri+Shift+F)
2. Enter the word or words you want to search for in Text to Search for.

3. Un-check: Search entry text, Search entry names and Search reminder names and notes (this
will force the search to look only in image descriptions).

4. Click on Search.

Doodling in Entries

The Journal includes a simple graphic editor so you can doodle in your entries, and even doodle on
other images. The doodler supports drawing lines and simple shapes, flood fill, and even typing text. The
doodler also has an undo and redo, though those only work within the current entry. If you select
another entry, the doodle is saved in its current state, with no further undo/redo possible.

Doodles in your entries look and act like normal images. You can print them. Copy-and-paste them.
Even change their layout properties (so text will wrap around them, for example).

Inserting a Doodle

To insert a doodle in your entry:
Click on the Insert menu and choose "Insert Doodle".

Click on the doodle to begin drawing.

Click and drag on the edges of the doodle to resize it. NOTE: If you resize a doodle *smaller*, you will
lose the portion no longer visible. It is possible to undo a resize.
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Move your mouse over the color selector (in the upper right corner) to see the full range of colors
available.

When you select a new doodling tool (paintbrush, shape, etc), the options for that tool appear above it.

After 5 seconds, the options will disappear to get out of your way. You can bring them back at any time
by clicking on the tool button again.

Doodling on an Image
Right-click on the image you want to draw on, open the Image sub-menu, then choose "Doodle on
Image".

Converting a Doodle to an Image

Right-click on the doodle, open the Doodle sub-menu, then choose "Convert Doodle to Image".
5.7.3 Entry Background Images

There are two primary types of entry background image: borders and backgrounds.

Borders are graphics that run along the borders (left, top, right, and/or bottom) of the entry editor.
Example:

Backgrounds are visible behind the whole entry, not just along the borders. Example:

Setting the Entry Background Image

To set the background of the current entry: Click on the Format menu, find the Background Image
sub-menu, and choose the background you want to use.

You can also set the entry background image to:

¢ Default - use the background image specified by the category (in Category Properties on the Entry
Text Style tab), or the global setting (in User Preferences on the Editor tab).

* No Background Image - forces the entry to have no background image. This overrides the category
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and global settings.

The Journal includes a number of entry background images, but you are not limited to those. You can
create your own.

Creating Your Own Borders

5.7.4 Creating Your Own Borders

Borders are simple to create, especially if you limit your borders to the left hand side of the entry.

1. Select or create a small pattern that repeats itself vertically (like the daisy on green pattern above).

2. Extend the image to the right with solid white (or other color) to a width of at least 1500 pixels. If you
have a high-resolution display, you might want to extend to 2000 pixels or more.

3. Save the image to a JPEG (.JPG) or a PNG (.PNG) file. Both JPEG and PNG images are
compressed, so they take up a lot less space in The Journal's database.

Loading Your Border Image

1. In The Journal, click on the User menu and choose User Images...

2. Click on Load Image, and browse to select your new image.

3. Set the image type to: Background Image

4. Set the "Position" to: Tile

5. To make sure that the entry text doesn't overlap the border pattern, click on Margin Offsets...
6. Un-check: Equal Values

7. In Left enter the number of pixels wide the pattern is (the daisy pattern above sets the left margin to
30).

And that's all there is to it!
Once you have added the image, you can make it a default background in your categories (in Category

Properties on the Entry Text Style tab), or apply it to specific entries (Format menu, Background
Image sub-menu).
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5.7.5 Creating Your Own Backgrounds

Creating your own backgrounds is at once simpler than borders and more complicated. Simpler
because if you use a digital photo then you don't have to worry about the image tiling (though you could
still do that), and more complicated because you have to make sure you can read text against the
background.

Here are some hints for creating your own background images:

* Open Space is Good - If you are using a digital photo, pick one that has a lot of open space in the
middle of the image. Pictures of the sky and ocean or simple textures like wood are good examples.
You can have palm trees or other objects along the left side and/or bottom to set the location and the
mood, but try to keep the middle clear.

¢ Keep it Simple - Expanses of sky and water are very simple backgrounds, making it easy to read
text against them. If you really must have that brook bubbling over many-colored rocks, then:

¢ Experiment with Masking - Most image handling software (free example: Paint.NET) will allow you to
mask or "washout" images making them seem dreamier or more cloud-like. This can make it much
easier to read text over those images. Or:

¢ Experiment with Font Colors - Maybe if you switch away from dark/black fonts to lighter/white fonts
you will be able to read text shown over the image.

¢ Use JPEG Images - You can use either Windows Bitmap file (*.BMP), PNG images (*.PNG), or
JPEG compressed files (*.JPG) for your backgrounds. JPEG files are usually much more compact
(especially if you are using a digital photo), so you should choose that format when you can.
Fortunately, most digital cameras create JPEG files automatically.

Also, check out the many free stock image sources on the Web, including:
¢ hitp://www.sxc.hu
* http://www.photoxpress.com

Loading Your Background Image

1. In The Journal, click on the User menu and choose User Images...
2. Click on Load Image, and browse to select your new image.

3. Set the image type to: Background Image

4. Set the "Position" to: Center

5. If you want to adjust the text margins, click on Margin Offsets...
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5.7.6

5.7.7

6. Check: Equal Values

7. Set the offset you want from the edges of the entry editor (most of the time, you will use values from
10-50).

And that's all there is to it!

Once you have added the image, you can make it a default background in your categories (in Category
Properties on the Entry Text Style tab), or apply it to specific entries (Format menu, Background
Image sub-menu).

Calendar Charms

Calendar Charms are small icons that you can use to mark special entries. Mark good days, mark bad
days, mark appointments, mark holidays, and more.

Calendar Charms are displayed on the calendar, as well as in the "entry tree". Every entry can be
marked with a Calendar Charm, in calendar categories and even in loose-leaf categories.

Calendar Charms can also be inserted into your entries as you type much like emoticons (or very small
clip art).

Setting (or Changing) an Entry's Calendar Charm

Menu: Entry | Entry Calendar Charm
Hot-key: Ctrl+F2

Removing an Entry's Calendar Charm
To remove the Calendar Charm from an entry, do this:

1. Bring up the Set Entry Calendar Charm form (Ctrl+F2).
2. Click on Clear.

Inserting a Calendar Charm in an Entry

Menu: Insert | Insert Calendar Charm
Hot-key: Shift+F2

Creating Your Own Calendar Charms

Calendar Charms can be single images, but are most often collections of small icons arranged in a grid.
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Here are some tips for creating your own Calendar Charms:
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¢ Grid layout - Arrange the icons in a simple grid (don't actually include grid lines), with every icon the
same size.

* Think small - If you want to use the icons on the calendar (instead of just inserting them into your
entries), it's best if you limit your icons to 16x16 pixels or 24x24 pixels. Larger icons will be reduced
to fit the calendar, and they may not look as good.

* Transparency - Calendar Charms are assumed to be transparent. If you use the PNG image format,
you can use the alpha channel to create transparency (and other special effects like anti-aliasing). If
you use BMP or JPEG images (or PNG images with no alpha channel), the color at pixel position
(0,0) will be made transparent when the icon is inserted or used on the calendar. The best
transparency colors are very bright and obviously not part of the image (like fuchsia in the example
above).

¢ Use PNG Images or BMP images - When you create your Calendar Charms, save them as PNG

images (*.PNG) or Windows Bitmap files (*.BMP). This way your images (and your transparency)
remain crisp.

Loading Your Calendar Charms

1. In The Journal, click on the User menu and choose User Images...

2. Click on Load Image, and browse to select your new image.

3. Set the image type to: Calendar Charms

4. Set the "# of Charms Across (X)" to: (the number of icons across)

5. Set the "# of Charms Down (Y)" to: (the number of icons down)

And that's all there is to it!

When you go to set an entry's calendar charm (hot-key: Ctrl+F2) or insert a calendar charm in an entry
grc?riliﬁgzliiriﬂﬂzz)’ drop down the list of Calendar Charm Collection and choose your new charms

5.7.8 Inserting Media Files into Entries

You can insert most types of audio and video files into your entries:
* audio - wma, wav, mp3, mid, midi, ra, ram
¢ video - wmv, mpg, mpeg, avi, mov, rm

Inserting Media Files

Click on this icon on the toolbar:

| & (9= V|

Or click on the Insert menu, and choose "Insert Media File (Audio/Video)..."

You can also drag images from Windows Explorer and drop them into your entry.
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A_n attached audio file shows this icon:

An attached video file shows this icon:
NOTE: Some media files are very large. Media files larger than 10 MB will cause your entries to load
and save slower. Media files larger than 50 MB may not perform well when stored in The Journal.

Also note: The Journal relies on Windows for media file playback. If you are using Windows XP, it's
possible that not all types of media file listed above will play.

Playing Media Files

To play a media file, doubleclick on its icon. This will start the Windows Media Player (or The Journal's
built-in media player if the Windows Media Player is not available).

Inserting Objects into Entries

Beyond images and media files, almost any kind of Windows file (like word processor documents,
spreadsheets, and more) can be inserted into an entry.

Click on the Insert menu and choose "Insert Object..."

Objects can be inserted as links to the files on your hard drive or network, or copied (embedded) into
the entry.

Journal Volumes

A Journal Volume is an "entry database" for The Journal. A Journal Volume can contain one or more
user logins and all of their categories and entries.

Journal Volumes can be placed on any available hard drive, internal or external or network attached, or
even removable thumb drives. Each Journal Volume must have a unique name.

The Journal supports multiple Journal Volumes, each in a unique folder. However, most users of The
Journal will only need a single Journal Volume.

By default, The Journal places all Journal Volumes in:
My Documents\The Journal Volumes\7\

If you are installing The Journal on a USB/external hard drive, the default path is relative to the installed
path:
\The Journal Volumes\7\

Journal Volume Properties

You can view or edit the properties of your Journal Volumes by clicking on the File menu, finding the
Journal Volume sub-menu, and choosing "Journal Volume Properties..."
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General

Name - This is the name of the Journal Volume. This name is also the name of the folder where the
Journal Volume resides.

Auto-load when The Journal starts - If checked (the default), the Journal Volume is opened and
loaded when The Journal starts up. If this option is not checked, you can still open the Journal Volume
by clicking on the File menu, finding the Journal Volume sub-menu, and choosing "Open Journal
Volume..."

Exclude from automatic backups - If checked, the Journal Volume is not backed up during an
automatic backup (for example, when closing The Journal). This property does not affect manually
started backups.

The path to the Journal Volume is displayed, as is the date of the last backup (if any).

Security

No new users can be created in Journal Volume - While this option is checked, no new users can
be created in this Journal Volume.

Journal Volume is Read Only - Check this option to make the entire Journal Volume "read only". This
prevents the creation of new users, new categories, and new entries.

5.8.2 Delete Users

To remove a user from the current Journal Volume, you must be able to provide the user's password.
The user and all of her categories and all of her entries in those categories will be deleted.

Deleting a User

1. Click on the File menu, find the Journal Volume sub-menu, and choose "Delete User(s)..."

2. Choose the user login name to delete.

3. Enter the user's password.

4. Click on Delete. You will be asked to confirm the delete one more time before it actually happens.

NOTE: Once deleted, a user CAN NOT be recovered (except by restoring from a backup or syncing
from a backup).

5.9 Links

The Journal supports hypertext-style links in document entries.

The easiest way to use links in The Journal is to click on this toolbar icon:

=W 2 @ E v

Or click on the Insert menu and choose Insert Link...
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There are three types of link: entry links, file links, and Internet links. Entry links are links to another
entry in The Journal. File links are links to files on your PC, or on your local network. Internet links are
links to web pages or email addresses.

Similar to a web browser, The Journal allows links to have a "tag" that is displayed for the link. For
example, instead of displaying the entry link this way: entry:Daily Journal\\2008\12\07, the link could
have a tag such as "My Birthday Last Year".

The Journal supports both tagged and un-tagged links. Un-tagged links are usually typed in by hand.
The Journal detects these and highlights them as you type. You can click on the link and it behaves
normally.

Bookmarks are supported for linking to a particular location in an entry.

Entry Links

Entry Links are special "hyperlinks" in The Journal that allow "jumping" to another entry.

Entry links can be "tagged" to hide the link information behind more descriptive text. Entry links can also
point to bookmarks within the entry.

Linking to an Entry

The easiest way to link to an entry is to click on this toolbar icon:
Ba < aEv

Or click on the Insert and choose Insert Link...

This will bring up the Insert Link form:

Link
I ™

Link Tag

Cancel

Then click on the "Select Entry" button: e

And select the entry you want to link to:
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= il Categories
=1 B4 Daily Journal
- |H 2014
= EE December
[% 20 - The last Saturday before Xmas.
[% 21 - Sunday, Sunday!
[ 22 - Yesterday's entry!
B
%[5 Notebook
# = Templates

| Select Entry | Cancel

If an entry has bookmarks, those will be displayed beneath the entry in the tree.
Typing Out Entry Links

You can also type out entry links by hand (instead of using Insert Link on the Insert menu).

Typing out Links to Calendar Entries
To do that requires using the following format:
entry:Category Name\\Entry\Date

or:

eﬁtry:Category Name\\*

Category Name - the name of the category where the entry is located. If Category Name is omitted,
then the entry is assumed to be in the current category.

Sub-categories should be clarified by listing their parent categories first, separated by a backslash ("\").
If no path is given, then the first category with the given name is used.

Entry\Date - the date of the entry. The default format for entry dates in links is: YYYY\AMM\DD (note the
use of backslashes instead of slashes).

Example:
entry:Daily Journal\\2009\07\18

Alternate Entry Date Formats

If you do not use the above format, then the date must be in a system-recognizable format. For users in
the US, the standard MM/DD/YY (or YYYY) format works (note the use of the forward slash in this
case). For users in the Europe, however, the format would (usually) be DD/MM/YY (or YYYY).

The date must consist of two or three numbers, separated by the character defined as the "date
separator” in your Windows Locale (in the US that's the slash / [forward slash] by default). The order
for month, day, and year is determined by the by your Locale as well (US default is m/d/y).

If the date contains only two numbers, it is interpreted as a date (m/d or d/m) in the current year.
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NOTE: These are Windows Locale settings, and not related to the date format used in The Journal for
inserting dates.

Example:
entry:Daily Journal\\4/9/2001

Current Entry Date - If an asterisk ( * ) is used in place of the entry date, then the entry link will jump
to the current entry date in the category.

Example:
entry:Daily Journal\\*

Typing out Links to Loose-leaf Entries

In a similar way, you can type in links to loose-leaf entries:
entry:Category Name\\Entry Name

ZLtry:Category Name\\Entry\Path

Category Name - same as above.

Entry Name - the name of the entry. The entry name is not case sensitive. If a loose-leaf category has
multiple entries with the same name, then the first matching entry is used.

Entry Path - the name of the entry, including the names of any "parents" of the entry, separated by a
backslash (\ ). For example:

entry:Notebook\\Recipes\English Muffins
"Notebook" is a loose-leaf category. "Recipes” is an entry with a sub-entry named "English Muffins".

Default Entry Link - If an asterisk ( * ) is used in place of the entry name or path, then the entry link
will jump to the current default entry in the category.

Typing out Links to Loose-leaf Attachments of Calendar Entries

The format for entry links to loose-leaf attachments (sub-entries) of calendar entries is a bit more
involved:

entry:Category Name\\Entry Date\\Attachment Name
or even:
entry:Category Name\\Entry Date\\Attachment\Path

Seriously: Just use Insert Link... ;-)

External Entry Links

External entry links are links to entries in The Journal from outside The Journal. For example, via a link
in an MS Word document or even a desktop shortcut.

Another use for external entry links is to link to an entry in a separate Journal Volume. Regular entry
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links can't do that.
Click on the Entry menu and choose "Copy External Entry Link to Clipboard".
You can then paste that link into the other software.

When you click on an external link, Windows will start The Journal (if necessary) to process the link
and show you the entry. If your journal has a password, you will be required to enter the password.

NOTE: External entry links won't work in other software if The Journal is installed in a cloud folder or on
an external hard drive. This is because The Journal has to set itself up in the Windows Registry to
process those links.

5.9.3 Bookmarks

Bookmarks in entries mark specific locations you can "jump" to, using the Go to Bookmark and Go to
Bookmark in Entry commands (on the Go menu) or with a link from another entry. Go to Bookmark
will take you to any bookmark in your journal. Go to Bookmark in Entry only takes you to bookmarks in
the current entry.

To insert a bookmark in an entry, click on the Insert menu and choose "Insert Bookmark..." You will
be prompted to give the bookmark a name. A gold star () will mark the location of the bookmark in
your entry.

To remove a bookmark, right-click on the bookmark icon and choose Remove Bookmark (bookmark
name). Or set the cursor to the beginning of the line with the bookmark, then click on the Insert menu
and choose "Remove Bookmark".

Bookmarks can make it easier to work with long document entries. Insert bookmarks at frequently
accessed locations, then use Go to Bookmark in Entry (on the Go menu) to jump from bookmark to
bookmark.

Bookmarks can also be used as link destinations. Entry links default to the top of the entry. By
specifying a bookmark, though, you can link to any line within the entry itself.

When WYSIWYG formatting is active, bookmarks are displayed as a dotted line across the page.

5.9.4 File Links

File links are links to files that on your PC or your local area network (LAN). When you click on a file
link, that file is opened.

The file link format is:
file://drive:\path\filename.ext

Examples:
file://C:\My Documents\Resume.DOC

If the file name or the path contains spaces, then you must use the Create/Edit Link form.
File links can be "tagged" to hide the link information behind more descriptive text.

When you click on the file link, the link is passed to Windows for activating. Whichever software you
have setup in Windows to open that kind of file will be opened.
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5.9.5 Internet Links

Internet links are web page addresses, email addresses, and so on.

Supported Internet link formats are:
Web Pages (http://www.webpage.com, https://www.webpage.com, or www.webpage.com)
Email Addresses (mailto:davidrm@davidrm.com or davidrm@davidrm.com)

Also supported are FTP (ftp://), Gopher (gopher://), telnet (telnet://) and news (news://).

Internet links can be "tagged" to hide the link information behind more descriptive text.

5.9.6 Insert/Edit Link

The Insert/Edit Link form can be used for either entry links, file links, or Internet links.

The easiest way to create a link is to click on this toolbar icon:
Baoamv
Or click on the Insert and choose Insert Link... (hot-key: Ctrl+Shift+K)

This will bring up the Insert Link form:

7 e e

Limk
| )

Link Tag

Cancel

Link

This is the actual link information. For example:
entry:Daily Journal\\2009\07\18

Or:
http://lwww.davidrm.com

Link Tag

The link's "tag" is descriptive text that can be used to "hide" the actual link information. Only the tag is
visible, and clicking on the tag activates the link.

Using the examples above, valid tags would be:
Saturday, July 18, 2009
Or:

DavidRM Software Home Page
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If no tag is specified, the link is inserted into the entry just as if it had been typed.

5.9.7 Typing out Links with Tags

You can type links that have a descriptive tag with this format:

[[link]tag]]

"link" can be either an entry link or an internet link. "tag" can be any single line of text (no ENTER).
After you type the closing ]], the typed out link will be converted to a tagged link.

Example:
[[http://www.davidrm.com/|DavidRM Software]]

5.10 Printing

The Journal supports a powerful collection of printing options. You can print a single entry, an entire
category, or a collection of entries from multiple categories.

Select Categories/Entries to Print

Active Entry

Only the active entry will be printed.

Active Entry with All Sub-Entries

The active entry and all of its sub-entries will be printed.
Current Day (in all Calendar Categories)

The entry for the current date in all calendar categories will be printed. No loose-leaf entries will be
printed with this.

These Categories/Entries

Whichever categories or entries you select will be printed. Entire categories can be selected for
printing, or groups of entries spanning several categories.

NOTE: Only document entries and images can be printed by The Journal. External object entries cannot
be printed. You will need to use the native application of the external object to print it.

Headers & Footers

Print Page Header - If checked, all pages will include the header for either the category or user (if one
is specified).

Print Page Footer - If checked, all pages will include the footer for either the category or user (if one
is specified).

Print Category Header - If checked, the category name will be printed before the first entry in the
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category.
Print Entry Header - If checked, all printed entries will be preceded by their entry name.

The page header and footer and the entry header are specified in User Preferences: Printing, or
Category Properties: Entry Text Style.

Page Breaks

Between Categories - If checked, a page break will be inserted after every category. NOTE: If no
pages breaks are to be inserted between categories, and there are multiple categories being printed,
then the page setups, headers, and footers for those categories will not be used. Instead the page
setup, header, and footer defined in User Preferences: Printing (if any) will be used.

Between Entries - If checked, a page break will be inserted after every entry. NOTE: If your entries
are short (less than one page), this option can result in a lot of paper being used.

Additional Options

Start Page Numbering With - By default, all printouts by The Journal begin with page number 1 (one).
If you would like the numbering to begin with a different number, you can specify that here. NOTE: If
you enter a "5", this option does not cause the printout to start at page 5. Rather, the first page of the
printout will be numbered "5" and the page numbers in sequence from there.

Force Text to Black & White - If checked, all text is converted to black and white before printing.

Printing Headers and Footers

Headers and footers can be specified at the user level (see User Preferences: Printing) or at the
category level. If no header or footer is assigned to a category, then it uses the corresponding setting
of the user.

Headers and footers are functionally identical, and are configured using the same options. The only
difference between them is that one is printed at the top of the page (headers) and one at the bottom of
the page (footers).

Formatted text can be used in both headers and footers. This means you can use any TrueType font
you have on your PC, you can use bold, italic, etc., and you can specify that the text be aligned to the
left, right, or centered. An empty header or footer will not be printed.

With the use of Print Macros, the text of the header and footer can include pre-defined values such as
the page number, the category name, and so on.

When printing, the content of entries is printed within the margins set in the page setup (either at the
category level or the user level). The headers and footers, if selected, are printed within the space
above the top margin and below the bottom margin. If the header/footer is too large to fit that space,
then the margins are adjusted so the header/footer can be printed. Also, there is a minimum "gutter”
space between the bottom of the header and the top of the text (and the top of the footer and the bottom
of the text). This gutter is calculated based on the default font for the category.

Also, if the printer cannot print to the full size of the page, the margins may be adjusted automatically.
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Default Header
<CATEGORYNAME/>

[Bolded category name print macro, default font, left aligned]

Default Footer

Page <PAGENO/>
Printed on <PRINTDATE/>

[Bolded page number print macro above the date printed, default font, both centered]

Print Macros

Print macros are used in the headers and footers. They are used as "place holders" for values that
replace them when the header or footer is actually printed.

Text formatting (font, bold, italic, etc.) that is consistent across the print macro within the header or
footer is applied to the result of the macro.

The print macros are only processed when used in a header or footer. Any macros included in an entry
are not processed, only printed.
Print Macros

<USERNAME/> - the "User Name" specified in User Preferences: Printing

<USERLOGIN/> - the user's login name

<CATEGORYNAME/> - the name of the category currently being printed

<ENTRYNAME/> - the name (or date) of the entry currently being printed

<PRINTDATE/> - the current date

<PRINTTIME/> - the current time

<PAGENO/> - the page number of the page being printed

NOTE: The <ENTRYNAME/> macro uses the name of the entry that is being printed whenever the new
page is started. If there are multiple entries printing on a single page, the name of the first entry printed
on the page will be used. This applies to both header and footer.

Reminders, Tasks & To-Do

With The Journal's reminders and tasks you can stay on top of your busy schedule.

You can create new reminders with a right-click on the date in the calendar above your entry tree (if
you’'ve set it to be active in the category you're viewing), or right-click the date in the day planner (if

you've set it to be active in the category you’re viewing) or go to the Tools menu and open the New
Reminder sub-menu.
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There are four types of reminder: appointments, events, tasks and special days.

Appointments

Appointments have both a date and a time, and you can choose to have The Journal popup a visual and
auditory prompt when it's time for the appointment, or up to 6 hours before hand so you can get an
early start.

Special Days

Special days are birthdays, anniversaries, and holidays that we all want to remember--but sometimes
those days sneak up on us, and even sneak past us.

Events

Similar to both special days and appointments, events can be daily, weekly, or monthly, and can even
occur at a particular time. The biggest difference between events and appointments is that events are
assumed to repeat on a regular basis (like the 2nd and 4th Wednesdays of each month, or every other
Friday).

Tasks

Tasks are a special kind of reminder. Like events, tasks usually repeat, either every day, every week,
etc. Tasks also have a status: active, done, skipped, canceled, or missed.

Appointments

Appointments have both a date and a time, and you can choose to have The Journal popup a visual and
auditory prompt when it's time for the appointment, or up to 6 hours before hand so you can get an
early start.

You can create new appointment with a right-click on the date in the calendar above your entry tree (if
you’'ve set it to be active in the category you're viewing), or right-click the date in the Day Planner (if

you've set it to be active in the category you're viewing) or go to the Tools menu, New Reminder sub-
menu, and choose New Appointment...

Date

You can click on the calendar to set the date of the appointment, select it from the dropdown calendar,
or type the date in by hand.

Time

You will need to type in the time of the appointment by hand. You can also optionally include an end
time for the appointment.

If you want an appointment without a specific time, use an Event instead.

Popup Reminder

By default, the reminder will popup at the correct time on the date of the appointment. If you would like a
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popup reminder before hand, you can set that as well, up to 6 hours in advance.
You can also assign a particular sound file (*.WAV) to be played when the reminder pops up.

By default, appointments are one-time events. To create an appointment that repeats daily, weekly,
monthly, or even annually, create an event, or look in Advanced Reminder Options.

5.11.2 Events

Similar to both special days and appointments, events can be daily, weekly, or monthly, and can even
occur at a particular time. The biggest difference between events and appointments is that events are
assumed to repeat on a regular basis (like the 2nd and 4th Wednesdays of each month).

You can create new event with a right-click on the date in the calendar above your entry tree (if you've
set it to be active in the category you're viewing), or right-click the date in the Day Planner (if you've set
it to be active in the category you're viewing) or go to the Tools menu, New Reminder sub-menu, and
choose New Event...

This Date

You can click on the calendar to set the date of the event, select it from the dropdown calendar, or type
the date in by hand.

Events can also be set to happen every week on a particular weekday (Sunday-Saturday), every
weekday (Monday-Friday), on the weekend (Saturday & Sunday), or even every day. It's also possible
to alternate, setting the reminder to be every other week or every other day.

More complex dates can also be set, including:

* Any day (or two days) of the week.

¢ Any weekday (or two weekdays) of the month.
¢ Any day (or two days) of the month.

* Any day (or two days) of the year.

Events set to a specific date are assumed to occur only once. Otherwise, events are assumed to
repeat. You can override both assumptions in Advanced Reminder Options.

Time

If you want to set a time for the event, you can type one in, as well as an end time for when the event
will conclude.

5.11.3 Tasks

Tasks are a special kind of reminder. Like events, tasks usually repeat, either every day, every week,
etc. Tasks have a status: active, done, skipped, canceled, or missed.

You can create new task with a right-click on the date in the calendar above your entry tree (if you've
set it to be active in the category you're viewing), or right-click the date in the Day Planner (if you’ve set
it to be active in the category you're viewing) or go to the Tools menu, New Reminder sub-menu, and
choose New Task...

Priority
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You can give the task a priority, which is used when listing the tasks above the entry editor. The higher
priority tasks are listed first.

Task Status

You can set the task to be active, done, skipped, canceled, or suspended. The "missed" status is set
automatically. When you first create a task, it's set to "active".

Active - The task is considered in progress.
Done - The task is complete. If this is a recurring task, it will switch back to active automatically.

Skipped - The task is incomplete and has been skipped for the current period (day, week, month,
year). If this is a recurring task, it will switch back to active automatically.

Missed - The task was incomplete at the time of its due date and marked automatically as missed. If this
is a recurring task, it will switch back to active automatically.

Suspended - The task has been put on hold. If this task had been a recurring, it will not automatically
occur again.

Canceled - The task has been canceled. If this task had been a recurring, it will not automatically occur
again.

The task keeps a history of its status (go to Advanced tab, then Status in the New Task or Edit Task).
This allows you to bring up a date and see those tasks for that date which were marked as done,
skipped, or canceled, as well as any tasks which were missed.

Special Days

Special days are birthdays, anniversaries, and holidays that we all want to remember--but sometimes
those days sneak up on us, and even sneak past us.

You can create new special day with a right-click on the date in the calendar above your entry tree (if
you've set it to be active in the category you're viewing), or right-click the date in the Day Planner (if
you've set it to be active in the category you're viewing) or go to the Tools menu, New Reminder sub-
menu, and choose New Special Day...

Birthday

For birthdays you can enter both the date of birth, and even the time of birth, if you so desire (and
know it).

If you know the year of birth, then the reminder for that birthday will be shown even when you're
reviewing past entries. If you don't know the year of birth, just use the current year, and the birthday will
show from this year forward.

For both birthdays and anniversaries, you can have the number of the birthday/anniversary displayed
with the reminder. Use "%yy" to display the simple year. Use "%yyth" to display the year like "1st",
ll2ndll’ ll17thll.

Example:
My Birthday (%yy years old)
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Displays as:
My Birthday (44 years old)

Example:
Jack Benny's %yyth Birthday

Displays as:
Jack Benny's 29th Birthday
Anniversary

Like birthdays, you can use the current year to be reminded from this year forward, or you can set the
actual year of the anniversary and see the reminder even in the past.

The default Calendar Charm for an anniversary is a bouquet of roses, but you can set that to any other
charm you wish, to remember anniversaries of all sorts.

See "Birthday" above for how you can display the year of the anniversary.

Example:
My %yyth Anniversary

Displays as:

My 20th Anniversary

Holiday

Holidays have a month and a day, and it's assumed you want to see the holiday every year, past or

future. If you want to set an effective date for a holiday, so that it doesn't show up before that date,
check out Advanced Reminder Options.

The drop down list of months includes information about some of the more common holidays, like New
Years, St. Valentine's Day, and Christmas. This information includes the month, day, and even a pre-
set Calendar Charm for that day.

5.11.5 Advanced Reminder Options

These advanced options are available for all types of reminders: special days, appointments, events and
tasks.

Name/Description

Every reminder needs a name. The name doesn't have to be unique, but it should convey the intent of
the reminder, since this is what you'll see most often.

For Birthday and Anniversary reminders, you use the %yy and %yyth macros to display the year of the
birthday/anniversary with the reminder. See Birthday in Special Days for more information.

Date/Time
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Date - The date of the reminder can be a specific day, a repeating weekday or collection of days, or
some pattern of days within a week, month, or year.

Time - The time of the reminder can be a specific time ("Eye Exam @ 7:00pm"), a start and end time
("Interview @ 9:00am-10:00am") or any time during the day ("Our Anniversary"). If you want to have a
reminder popup at you, you have to specify a time for the reminder.

This Happens - A reminder can be a one-time occurrence, or it can occur every day, week, month, or
year.

Effective Date - The effective date determines when the reminder becomes active. For example, if you
create a reminder for your wedding anniversary, you can set the effective date to the date of your

actual wedding. Every year after that, your anniversary will show on the calendar. You can also set an
end date, after which the reminder will no longer occur.

Display

Calendar Charm - Every reminder can be assigned a Calendar Charm. Default charms are chosen for
the different types of reminders, but you can change them to be whatever you like.

Show Reminder on small Calendar - If checked, the reminder's Calendar Charm will be shown on the
category calendar. If the same date has multiple reminders, only the top 3 will be shown, overlapping,

on the calendar. Since the calendar can get cluttered very quickly, you might want to limit the number of
reminders that show on the calendar.

Show Reminder

NOTE: The "Show Reminder" options listed here only apply when the day planner option is turned Off
(in Category Properties...).

Show Reminder above Entry - If checked, the reminder will be listed above the entry editor. You can
double-click the reminder when it's listed above the entry like this, and edit it.

That Day Only - If checked, the reminder will show above the entry only on the actual due date.

N Days Before - If checked, then the reminder will show above the entry for the specified number of
days before the due date. Use this option to get advance warning of a reminder coming due.

Until Completed/Canceled - If checked, the reminder will always show above the entry, until you
cancel (or delete) the reminder, or mark it as done.

Popup

Popup Reminder when Due - If checked, and if the reminder has a specific time it's due, a reminder
will popup in The Journal.

Popup Reminder N Minutes Before - If checked, a popup reminder will happen the specified number
of minutes before the due time. The popup will include an option for you to be reminded again.

Play Sound on Popup - The default sound is the Windows "beep". You can specify any sound file (*.
WAV) you want to be played when the reminder pops up.
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Status

Priority - A reminder can be given a priority from 1 (highest) to 100 (lowest). This priority determines
how the reminder is sorted when listed above the entry editor.

"Done" Charm - You can specify a different Calendar Charm to display when the reminder is marked
as done. The default is to use the same charm all the time.

"Skipped/Missed" Charm - You can specify a different Calendar Charm to display when the reminder
is marked skipped, or is missed.

Status History - This is a listing of the reminder's status history. Most non-task reminders will show the
date they went active, and the date (if any) that they were completed. Task reminders, though,
especially recurring tasks, will accumulate a sequence of active, done, skipped, and missed statuses.
You cannot edit this information.

Categories

All Categories - If checked (the default), then the reminder is displayed, on the calendar, above the
entry, or both, in all categories.

Active Category Only - If checked, the reminder will be displayed only in the category active at the
time you created the reminder.

These Categories - If checked, you can specify which categories to display the reminder in. Note that
in loose-leaf categories, like "Notebook", you can see reminders on the calendar for other days, but
you will only be able to see above the entry reminders for the current date.

Notes

You can enter text of any length in the reminder notes, just like a normal entry.

5.11.6 Day Planner

The day planner is your always there reference for all your reminders and can be set to display in any
of your categories above the entry editor (see "Show day planner with active reminders" option in
Category Properties). You can display your reminders just for today or for up to a week in advance.

All your reminders in this period can be editing, deleted or new ones created in the day planner, by
right-clicking the reminders themselves.

The day planner can be scrolled or vertically expanded or reduced to give you a view of the reminders
set at particular times, if necessary.

5.11.7 View All Reminders

The "View All Reminders" form provides a list of all of your reminders, active, done, canceled, etc. The
reminders are categorized by their type: Appointment, Event, Task, or Special Day. The "All" tab can be
used to view all of your reminders of all types.

From this form you can edit, copy or delete reminders. Click on the reminder, then click on the button
to "Edit", "Copy" or "Delete" the reminder.
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5.11.8 Daily/Weekly Reminder Report

Use the Daily/Weekly Reminder Report to view all of the reminders completed, canceled, skipped or
missed in a given date range: a day, a week, a month, a year, or any range at all.

Example:

You have various tasks that you want to perform daily. Each week you want to print out a report of how
you did the previous week. So you:

1. Click on the Tools menu, choosing "Daily/Weekly Reminder Report..."

2. Select Last Week.

3. Click on See Report.

All of the reminders that were completed, canceled, skipped or missed over the past week are listed.
You can review them and then print a report, if you want.

Show all Reminders from:

There are 6 pre-set date ranges you can use: Today, Yesterday, This Week, Last Week, This
Month, and Last Month.

If you need a specific date range, click on This Date Range and set the From and To dates
appropriately.

Look In:

You can have the report created from the Active Category or All Calendar Categories. Or you can
choose These Categories and select the specific categories to look in. Only reminders that are tied to

those categories (or are global reminders) will be reported.

5.11.9 Exporting Reminders

If you need to transfer your reminders from one install of The Journal to another, do this:
1. Click on the File menu, Import sub-menu, and choose "Export Entries as File..."

2. Select "Reminders" from the list.

3. Select Export File Type: The Journal Export File (. TJEXP)

4. Export to a file.

5. In the other install of The Journal, click on File, Import, Import Entries...

6. Click on Import.

If you need to move your reminders from The Journal to another program, however, you will need to
use a CSV file.

The Journal supports exporting your reminders and tasks into a simple CSV (comma-separated values)
format that can be imported by other scheduling software, such as Outlook, Sunbird, Mozilla, etc.

Reminders are exported as discreet events. That is, properties such as weekly and monthly recurrence
are not exported. Instead, the reminder will be exported once for each time the reminder would occur
within the specified date range.
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Start Date & End Date

These dates provide the range of reminders and task to export.

Which Reminders

Special Days - If checked, special days will be included in the export file. Un-check this option to
prevent special days from being exported.

Appointments/Dates - If checked, appointments/dates will be included in the export file. Un-check this
option to prevent appointments/dates from being exported.

Events - If checked, events will be included in the export file. Un-check this option to prevent events
from being exported.

Tasks - If checked, tasks will be included in the export file. Un-check this option to prevent tasks from
being exported.

5.11.10 Importing Reminders

Reminders can be imported from any software that supports the simple CSV file format used by The
Journal. This format was created some time back by other software manufacturers, and has become
something of a universal format.

Reminders are imported as single events with a specific due date and time.

Some information exported from scheduler/planner software, such as required attendees, meeting
location, and so on, has no corresponding type of information in The Journal. However, in order to be
provide some degree of available of that information, they are imported and added to the "Notes" of the
reminder.

5.11.11 Export/Import CSV Format

The first line of the CSV file includes all field names in quotes. The data, one record per line, is all string
data.

Fields

[<<] "Subject" [>>]

[<<] "StartDate" [>>]

[<<] "Start Time" [>>]

[<<] "End Date" [>>]

[<<] "End Time" [>>]

[<<] "Allday event" [>>]

[<<] "Reminder on/off" [>>]

[<<] "Reminder Date" [>>]

[<<] "Reminder Time" [>>]
"Meeting Organizer" [>>] (into Notes)
"Required Attendees"” [>>] (into Notes)
"Optional Attendees" [>>] (into Notes)
"Meeting Resources" [>>] (into Notes)
"Billing Information"
"Categories"
"Description”  [>>] (into Notes)

© 1996-2016 by David Michael



140 The Journal

"Location"  [>>] (into Notes)
"Mileage"

"Priority"  [>>] (into Notes)
"Private"

"Sensitivity"

"Show time as"

[<<] Exported by The Journal.
[>>] Imported by The Journal.s

5.11.12 Missed Reminders

The Missed Reminders report is run automatically when you log into The Journal. This report displays
reminders that were missed or had their due dates/times pass since the last time you logged in.

5.11.13 To-Do Items (Checkboxes)

The Journal supports simple to-do items. They look a bit like task reminders, but they are created on-
the-fly in your document entries.

When to Use a To-Do Item

If you have a one-off chore you need to do today or in the next few days, a to-do item is perfect.
Create the to-do item, and check it when you're done.

For a recurring chore, something that happens every week or every month, a reminder (either a task,
event or an appointment) would be a better choice.

To Create a To-Do Item
Click on the Insert menu and choose "Insert To-Do Item (Checkbox)".

That will insert a checkbox into your entry. Whatever you type after the checkbox will be the description
of the to-do item.

The to-do item can be either active (un-checked) or done (checked).

To-do items are specific to the category where you create them, so each category will have its own to-
do list.

Seeing Active To-Do Items

Right-click on your category tab and choose "Category Properties..." On the "General" tab, check
the option: "Show active to-do items"

All active (un-checked) to-do items for the category will be displayed above the entry editor.

NOTES:
* To-do items for the current entry are not displayed.
* To-do items that are checked off today will remain in the list for the rest of the day.

Managing To-Do ltems
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You can check or un-check to-do items in the list. When you do, the state of the to-do item (checkbox)
is reflected in the entry where the to-do item was created. NOTE: If the entry is locked (read only) you
will be prompted to force the update or not.

You can also right-click a to-do item in the list and cancel it. The to-do item will remain un-checked in its
entry, but it will no longer show up as an active to-do item. To make the to-do item active again, go the
entry, then check and un-check it.

To-Do Item Report
The Entry Report Wizard (on the Tools menu) includes the "To-Do Item (Checkbox) Report".

This report will show you active items, done items, or both. You can run the report for any date range
on the active category (or all categories).

5.12 Security

The Journal's security is designed to be as complete as possible while still offering a high level of
convenience. Also, The Journal's security is scalable, so you only have to use as much as you need.

Security Features and Options:
* Password protection

* Entry encryption

Hide hot-key

Lock on minimize/hide
Auto-hide on idle

The Journal also offers Extended Security. In short, Extended Security provides more control over the
login process, as well as makes The Journal's entry database that much more difficult to "hack."

5.12.1 Levels of Security

Not everyone wants or needs the same level of security. The Journal's standard settings provide a
medium-to-high level of security, but if you want more security, or if you want the security features to
stay out of your way, The Journal can support you.

The level of security you will want to set is based on the level of threat you perceive and/or wish to
protect against.
No Security

The Journal can support a near-lack of security if you want it to. With the Auto-Login option you can
have The Journal automatically log you in when it starts. See Auto-Login for more information.

The Journal also allows you to have a "blank" password.

Normal Security

By default, a user must be created with a password. This password has to be entered before that user's
categories and entries can be accessed.
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All entries in The Journal are compressed and encrypted before they are saved.
The Journal can be quickly "hid" (minimized) with this hot-key: Ctrl+J

The Journal also has a "global" hot-key that you can use from any application under Windows:
Ctri+Alt+J

Additional Security

The Journal can be "locked" when minimized or hidden.

The Journal can automatically hide itself, locking itself if that option is also set, after a specified period
of "idleness". So if you get up and walk away from your PC, forgetting to hide and lock The Journal, it

will automatically do this for you.

See User Preferences: Security for more information.

Extended Security

For the Truly Paranoid, The Journal's Extended Security features provide a logical "next step" for The
Journal's built-in security. See Extended Security for more information.

5.12.2 Choosing a Good Password

Having a password is hardly useful if you don't pick a good one. Here are some guidelines for choosing
a good password (submitted by Bernard Beam):

6-10 characters in length (don't always pick the same length).

Use mixed-case alphanumeric (aBcD ... 123 ...).

Try not to have more than 2 alpha characters in a row.

Try not to have more than 3 numeric characters in a row.

Don't use the correct spelling of a word.

When using numbers, use them for more than just substitutes for letters (1 for 'I', 3 for 'e', etc.).
Don't use the same password for multiple applications or purposes.

Change your password every 30-60 days.

In other words, "password1" is a particularly poor choice for a password. ;-)

A helpful mnemonic device is to select a phrase you will remember and use it as an acronym, for
example the phrase "l never forget to brush my gums" can create the password (In42bmg).

See Change User Password for more information.

5.12.3 Security Details

Here are the high-level details of The Journal's security algorithms.

Passwords
Passwords in The Journal are never stored in the database without being "hashed".

Passwords are salted and hashed with the SHA256 algorithm. This is a one-way hashing algorithm,
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making it nearly impossible to guess the password from the hashed value.

Encryption

By default, entries stored in The Journal are compressed before they are encrypted. The compression
removes redundant information from the entry, making the encryption somewhat more secure.

Compression of entries uses the LZH5 compression algorithm (a Lempel-Ziv-Huffman algorithm)
programmed by South Pacific Information Services Ltd. This is very similar to the compression used by
the LHarc utility.

Encryption of entries uses the Twofish block cipher designed by Bruce Schneier.

Encryption keys and password salts are created using the Microsoft Windows CryptGenRandom
function.

5.12.4 Extended Security

If you need a higher level of security than The Journal normally provides, then the Extended Security
option may be what you're looking for.

User Extended Security
A login name that uses Extended Security is significantly more secure than normal.

When Extended Security is turned on for a user, the user's master encryption key is encrypted using a
key generated from the plaintext of the user's password.

NOTE: A login with Extended Security active cannot have its password reset. If you lose your password,
there is absolutely nothing that can be done to recover it. This is a feature of Extended Security.

Extended Security: Global Options
5.12.5 Extended Security: Global Options

Use Extended Security for User Name

When checked, this option adds an additional layer of security to that user's categories and entries.

NOTE: A login with Extended Security active cannot have its password reset. If you lose your password,
there is absolutely nothing that can be done to recover it. This is a feature of Extended Security.

Automatic Login Failure

With Extended Security, you can specify that all login attempts fail after a certain number of
consecutive failures.

For example, if someone is attempting to guess a user's password, then after the specified number of
failures, The Journal automatically fails all other attempts. The Journal doesn't even check the password
entered. The failure message is displayed, and The Journal prompts for the password once again.

This option functions regardless of whether Extended Security is turned on for a particular user. Setting
any non-zero (0) number of tries activates this option.
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In addition, when this option is set to any value besides zero (0), the user will be shown the number of
unsuccessful login attempts when he logs in.

Minimum Wait Time (in minutes)

Once the automatic failure option has activated, the user will have to wait the specified minimum of
minutes before The Journal stops automatically failing attempts.

5.13 Styles
The Journal styles allow you to assign pre-defined font and paragraph settings to a block of text.

The Journal automatically creates the following styles for you:

Heading 1, Arial 16pt bold, outline level 1, 3pt before-spacing, 3pt
after-spacing

Heading 2, Arial 14pt bold-italic, outline level 2, 3pt before-spacing, 3pt after-
spacing

Heading 3, Arial 12pt bold, outline level 3, 3pt before-spacing, 3pt after-spacing

These styles can be edited or even deleted. They are provided primarily as an example of what styles
are capable of.

You can create as many styles as you like.
If you change a style that is already in use, the change will be visible in any existing entries.

See Style Options for more information.

Clear Formatting
You can quickly remove all formatting from the selected text by using the hot-key: Ctrl+<spacebar>
Or you can click on the Format menu and choose "Clear Formatting”.

Clear Formatting forces the font to the default font for the category.

Apply Normal Style (retain formatting)

Select a block of text, then click on the Format menu and choose "Apply Normal Style (retain
formatting)”. Hot-key: Ctri+Shift+<spacebar>

This command sets the block of text to the normal style, but any text formatting, like bold, italic, and so
on is retained.
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5.13.1 Adding New Styles

To create new text styles, click on the Format menu and choose "Styles..."

*4 Text and Paragraph Styles Style
a Default Font Mame
a Date Style N 3
a Eniry Link Style Applies to
a HTML Passthru (for blogs)
a [nternet/Email Link Style Style based on
a Time Style
=7
1 Heading 1 Style for following paragraph
8 Heading 2 Mormal
o3 Heading 3 J
Description and preview
Font: Times Mew Roman 12 pt [ Edit ]
Paragraph: default [ Edit ]
Preview text text text text. TeXt text text text taxt.
Text text text text text. Text text text text taxt.
Add (8.4 Cancel

Click on "Add" to create a new style.

If you wish to create a new style based on an existing style, click on the existing style first, then click on
"Add".

There are two main types of styles: text styles and paragraph styles.
Text styles only affect the font and character formatting.

Paragraph styles can affect both font and character formatting, and paragraph formatting. For example,
Heading 1 sets the font to Arial 16 pt and bold, but also sets the paragraph's before and after spacing.

5.13.2 Editing Styles

To edit your styles, click on the Format menu and choose "Styles..."
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] styles x
*4 Text and Paragraph Styles Style
a Default Font Mame
a Date Style ,
a Eniry Link Style Applies to
a HTML Passthru (for blogs)
a [nternet/Email Link Style Style based on
a Time Style
= | - -
1 Heading 1 Style for following paragraph
o3 Heading 2 floama)
o3 Heading 3
Description and preview
Font: Times Mew Roman 12 pt [ Edit ]
Paragraph: default [ Edit ]
Preview text text text text. Text text Xt text text.
Text text text text text. Text text text text taxt.
Add OK Cancel

You can see your existing styles listed (with details) under "Text and Paragraph Styles".
Click on the style you want to edit.

The many options available for styles are described here.

NOTE: If you change the name of an existing style, all entries in all categories will need to be
processed. This could take a few minutes if you have a lot of entries.

Editing Standard Styles

You can edit The Journal's built-in "standard" styles. The standard styles are:
¢ Date style - the style used with the Insert Date command.

Entry Link Style - how entry links are displayed.

Internet/Email Link Style - how internet/email links are displayed.

Time style - the style used with the Insert Time command.

Changes to these styles will be reflected throughout your categories and entries.
It is also possible to create new styles based on the standard styles. Click on the style to select it, then

click on "Add". That will create a new style based on the existing style. In the new style, you can
override the font and other settings.

5.13.3 Style Options

Name

Every style must have a unique name. You cannot change the name of the standard styles (e.g., "Date
Style").

Applies to

© 1996-2016 by David Michael



The Journal Reference 147

A style can apply to either the text (character formatting), paragraph, or both.
Text styles only affect the font/character formatting: font face, font size, and so on.
Paragraph styles affect the spacing, tabs, alignment, and so on.

Text and paragraph styles can affect everything.

Style based on

This is the "parent” style. A style inherits all the text and/or paragraph settings of its parent, but these
can be overridden.

Style for following paragraph

This is the style that will be applied when you create a new paragraph by pressing ENTER. Heading
styles, for example, all revert to the Normal style when you press ENTER.

Hot-Key
Up to 10 styles can be assigned a hot-key. The available hot-keys are Ctrl+1, Ctrl+2, up to Ctrl+0.

If you apply a hot-key that has already been assigned, the new assignment will override the old.

Description and preview

This displays a summary of the styles font, paragraph, and other settings, and also shows a preview of
how the style will appear in the editor.

Click on the "Edit" link to edit those settings for the style. Click on the "Reset" link to remove all changes
to the style and reset it the default (or its parent style settings).

5.14 Tables

The Journal entries can include tables with a variable number of rows and columns. More than simple
grids, each table cell can contain formatted text with any number of paragraphs, including images and
even other tables. Tables can be nested to any depth. Further, table cells can be merged together to
create larger cells, both horizontally and vertically.

Horizontally Merged Cells ‘

|
] | | |
D Vertically A table in a table...

Merged | H ‘

Cells | ” ‘
Tables in The Journal follow the HTML model. In this model, every cell in a table has its own distinct
border on all four sides. In addition, the table as a whole has a border, distinct from the cells in the
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5.14.1

table. You can change this default look, however, and make the tables appear to have a single line
border between cells.

Tables and cells can also have background images, and these background images can be centered,
tiled, stretched.

The contents of table cells can be aligned vertically (to the top, bottom or middle of the cell), as well as
horizontally (left, right, and centered).

Another advantage of the HTML table model is that widths of columns are calculated based on the widths
of individual cells. Widths of cells (and the table as a whole) can be defined as percentage of the visible
editor, or a specific number of pixels. The height of cells can be set to match the content of the cells, or
can be set to a specific number of pixels.

And, of course, you can change the width and height of the table and cells with the mouse.

Using Tables

There are many uses for tables! One of those is demonstrated in the sample template: "Food Log".

Sunday 19 Sep, 2004

Total Fat
Time Food Amount ‘Calories | Cabories

5:31 PM |Chips & Salsa |5 chips

Uses for tables:
* Arranging information in an easy-to-reference grid.
¢ Controlling text and image layout.

Adding a Row to a Table

To add a row to a table (like the Food Log):
1. Click on a cell in the last row of the table.
2. Click on the Table menu, Insert sub-menu, and choose Insert Row Below.

Merging Table Cells

To merge table cells together:
1. Select the table cells you want to merge.
2. Click on the Table menu and choose Merge Cells.

Using Tables for Text Layout

You can use tables to control the layout of text and pictures. For example, you can use a table to put
text beside a picture.

1. Click on the Table menu, Insert sub-menu, and choose Insert Table...
2. Number of Columns: 2
3. Number of Rows: 1
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4. Size Table Manually: 100 percent

5. Click on the left table cell.

6. Insert the image.

7. Use the mouse to resize the left table cell to fit the image.
8. Click on the right table cell.

9. Enter the text to be beside the image.

Hiding a Table's Borders
1. Click on the table.
2. Click on the Table menu and choose Table Properties...
3. Click on Table Border...
4. Border Type: None
5. Click on Cell Borders...
6. Border Type: None
5.14.2 Insert Table

Number of Columns

The number of cells across the table (left-to-right).

Number of Rows

The number of cells down the table (top-to-bottom).

Columns

Rows

Table Layout

Autosize - The table is created as wide as the entry editor, with all columns the same size.

Size Table to Fit Window - The table is created as if you had entered "Size Table Manually" as "100%
percent".

Size Table Manually - You can set the table width to be a set number of "Pixels" or a "Percent" of the
entry editor window.

Table Properties...

Click here to adjust the properties the table will be created with: fill color, cell padding, borders, and so
on.

Remember Table Size & Properties for New Tables?

If checked, the current settings are remembered for the next time you insert a table.
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5.14.3 Table Properties

To set or change a table's properties:

1. Click on any cell of the table.

2. Click on the Table menu, bring up the Select sub-menu, and choose Select Table.
3. Click on the Table menu and choose Table Properties...

Width

A table's width can be set one of 3 ways:

* As a percentage of the width of the document entry editor ("Percent”).

* As a specific number of screen pixels ("Pixels").

¢ Using the mouse to click-and-drag the table wider or narrower ("Manual").

Fill Color

Tables can be either "Transparent" (showing the color of the entry), or any color of your choice. The
table's fill color is the default fill color of all of the table's cells (though each cell can have its own color;
see Table Cell Properties).

Cell Padding

Cell padding is the amount of space (in screen pixels) between the border of the table cell, and the
contents of the cell.

Cell Spacing

Cell spacing is the amount of space (in screen pixels) between the border of the table and the border of
the cells. It is also the amount of space between the individual cells.

Cell spacing can be broken down into vertical spacing between the table border and the cells, horizontal
spacing between the table border and the cells; and vertical and horizontal spacing between individual
cells. You can adjust these values by clicking on More... on the Table Properties form.

Image...

A table can have a background image that is shown "behind" the table cells. The image can be tiled,
centered, or stretched.

Table Border...

You can set the color and highlight color of the table's border. You can turn off the border completely,
or have it displayed as sunken, raised, or flat.

Cell Borders...

You can set the color and highlight color of the table's cell borders. You can turn off the cell borders
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completely, or have them displayed as sunken, raised, or flat.

Keep Table on a Single Page

The table will not be printed on multiple pages.

Count of Heading Rows
If the table is printed on two or more pages, these first rows of the table will be repeated as a header on

all pages.

See also:
How do | make my tables look like those in MS Word/W ordPerfect/Etc?

Table Row Properties
Table Cell Properties

5.14.4 Table Row Properties

To set or change the properties of a row of a table:

1. Click on a cell in the row you want to change.

2. Click on the Table menu, bring up the Select sub-menu, and choose Select Row.
3. Click on the Table menu and choose Table Properties...

4. Bring up the Row tab.

Vertical Alignment
The vertical alignment of a table row can be set to either top (the default), center, or bottom.

This setting can be overridden at the cell level.

See also:
Table Properties
Table Cell Properties

5.14.5 Table Cell Properties

To set or change the properties of a row of a table:

1. Click on a cell in the row you want to change.

2. Click on the Table menu, bring up the Select sub-menu, and choose Select Cell.
3. Click on the Table menu and choose Table Properties...

4. Bring up the Cells tab.

Preferred Width

This is the preferred width for the cell(s), in pixels or percents of table width. Cells can be wider than
this value, if required to display its contents without overlapping.
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Height at Least

This is the minimum height for the cell(s), in pixels. Cells can be taller than this value, if required to show
all its contents.

Fill Color

This is the background color of the cell(s). This overrides the fill color of the table.

Image...

A table cell can have a background image that is shown "behind" the cell. The image can be tiled,
centered, or stretched to fit the cell.

Vertical Alignment

The vertical alignment of a table cell can be set to either top (the default), center, bottom, or default. If
set to default, the cell uses its row's vertical alignment.

See also:
Table Properties
Table Row Properties

Templates

Templates allow you to use standard forms or blocks of text in your entries. Writing and journaling
prompts, worksheets and forms, and "boilerplate” text are all possible with templates.

A template is either "simple" or "enhanced". Simple templates are inserted without any processing,
exactly as they were created. Any loose-leaf entry can be a simple template. Template entries are

displayed in the entry tree with a red "T" (Dﬁ) beside their name.

See Simple Templates and Creating Simple Templates for more information.

Enhanced templates provide many more options. Enhanced templates can be used to "create" entry text
that is then inserted into the current entry. An enhanced template can have one or more "sections" that
can be selected (at random or in sequence). An enhanced template can use other templates (simple or
enhanced) or even files external to The Journal.

See Enhanced Templates and Creating Enhanced Templates for more information.

Inserting a Template

Inserting a template is the same, whether it is simple or enhanced. You choose Insert Template from
the Insert menu (or from the right-click context menu) and then select the template you want. The
selected template is then added to the current entry.

Default Entry Template
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Each category can have a "default entry template”.

The default entry template will be inserted into new entries.

To set the default entry template for a category:

1. Right-click on the category tab and choose "Category Properties..."
2. Bring up the "Entry" tab.

3. Select the "Default Entry Template" from the list of available templates.

5.15.1 Simple Templates

Any loose-leaf entry can be a simple template.

When a simple template is inserted with Insert Template, the entire template entry is copied. All text
formatting is preserved.

To have an entry appear as a template in the Insert Template list, first select the entry. Then click on
the Entry menu, and choose Template Entry.

See Creating Simple Templates for more information.

5.15.2 Enhanced Templates

Enhanced templates are much more than just a text entry.

An enhanced template can have multiple "sections". When the template is inserted, only a single section
is selected and inserted into the entry. Which section is selected depends on how the template is setup.
It could be a random section, or the next section in the sequence.

With an enhanced templates ability to pull in other templates, simple or enhanced, they significantly
extend the "boilerplate” features of templates.

In addition, enhanced templates can use "scripting", such as VBScript or JavaScript, to provide even
more power. Scripting can prompt the user for information, or control the text that is ultimately returned.

Example uses of enhanced templates:

* Writing exercises, either in sequence or random
Journaling exercises

Inspirational quotes

Auto-generated notes and letters

Role-playing game (RPG) charts and tables

See also:

Creating Enhanced Templates
Enhanced Template Tags

Enhanced Template Script Variables
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5.15.3 Enhanced Template Tags

<TEMPLATE {{METHOD="method"} {SCOPE="scope"}} {USE="uselLanguage"}
{UNFORMATTED} {GLOBALVARSPACE="spaceName"}></TEMPLATE>

This tag must be the first non-whitespace of an extended template.
A single entry can include only one template.
Text in the document that is external to (follows) any defined templates is ignored.

METHOD specifies the default access method of the template. If unspecified, the default access method
is "sequence". Valid default access methods are "sequence" and "random".

SCOPE specifies how the "sequence" default access method stores the current point in the sequence.
Valid default scopes are "global" and "category". If no scope is specified, then "global" is used.

USE specifies the default "scripting language" used by <DECLARE> and

<EXECUTE> tags. If not specified, the default scripting language is "VBScript". Other supported
scripting languages are "JavaScript", "PerlScript", and "PythonScript". VBScript and JavaScript are
usually available so long as you have Internet Explorer 4 or higher installed on your PC. The availability
of PerlScript and PythonScript is beyond the scope of this document. Generally, you will need to
download and install special software to use those.

If UNFORMATTED is specified, the selected section of the template is forced to be unformatted. This
overrides any formatting specified in the section.

GLOBALVARSPACE creates a "named" set of global variables. This named set of global variables is

then available to any other template that uses it, as well. That is, global variables can then be used to
store data between templates.

<INCLUDE {ENTRY="entryName" {CATEGORY="entryCategoryName"}
{UNFORMATTED}}/>

<INCLUDE {FILE="fileName" {UNFORMATTED}}/>
<INCLUDE {URL="urIText" {UNFORMATTED}}/>

An included entry is specified external to any sections. By convention, included entries are generally
listed after any <DECLARE>'s with defined functions.

CATEGORY is used to include entries in other categories. If not specified, the entry must be within the
current category.

Any <DECLARE>'s in the included entry are treated as though they were declared in the including
template.

<SECTION>'s in included entries are added to the template according to their order in the included
enfry. Included entries can be specified before, after, between, and so on, sections that are in the "top
level" template.

If an included entry includes other templates (and so on), the sub-includes will be handled recursively.
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Duplicate entry includes, at the top level and within a <SECTION>, will be ignored.

<INCLUDE FILE...> is used to pull text (with or without formatting) into a template or <SECTION>. The
file is assumed to be text or text-with-markup. If no path is specified, the file will be looked for in the
active folder and then the default Windows path.

If the file has a .TXT extension, it is assumed that it will be unformatted text.

If the file has a .RTF extension, it is assumed to be rich text. If UNFORMATTED is specified, the file will
be included without formatting.

<INCLUDE URL...> is used to pull the contents of a URL into a template or <SECTION>. The URL can
specify a Web page, or an image.

<INCLUDE> can be used externally to <SECTION>'s, as well as within <SECTION>'s. The inserted text
will replace the entire <INCLUDE ... /> tag.

<INCLUDE>'s external to a <SECTION> will be processed every time the template is accessed.
<INCLUDE>'s internal to a <SECTION> will only be processed if that <SECTION> is selected.

If the included file causes incorrect formatting, or otherwise causes an error, accessing the template
will cause an error.

<DECLARE {USE="uselLanguage"}></DECLARE>

The <DECLARE> tag is used to define functions, procedures, and "global" variables that can be called
or accessed in other parts of the template.

<DECLARE>'s must be external to any <SECTION>'s. Thus, it is convention to place all <DECLARE>'s
at the beginning of the template.

An error in a DECLARE, for instance a syntax error in declaring a function or variable, will halt the
template.

Standard functions and procedures can be declared in a template with no sections. This template can
then be included in other templates. This allows a certain amount of "code re-use".

Variables declared in a <DECLARE> can be accessed by any <EXECUTE> in the template. However,
the value of the variable is not maintained from one <EXECUTE> to another.

If a template includes different <DECLARE>'s with different USE attributes, then each different scripting

language will have its own "run state". Elements declared for one scripting language will not be available
for use in other scripting language <DECLARE>'s or <EXECUTE>'s.

<EXECUTE {USE="useLanguage"}></EXECUTE>

The <EXECUTE> tag allows the template to perform some processing as part of processing.
<EXECUTE>'s external to a section will all be executed prior to accessing any section of the template.
Template-level <EXECUTE>'s can return a block of text that is embedded in the template. Thus, these
<EXECUTE>'s can selectively add <INCLUDE>'s, <DECLARE>'s, and so on to the template.

<EXECUTE>'s can also be used inside sections. In that case, the <EXECUTE> is considered to have a
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string-type result value (called "Result") that will be inserted into the section when the script is finished.
The text formatting of the initial <EXECUTE> tag will be applied to the inserted text. The inserted text will
replace everything between and including the <EXECUTE> and </EXECUTE>. Processing of the
template will begin again at the first position replaced. Thus, a <EXECUTE> could create further tagging
to be processed.

There are global variables that can be accessed from any <EXECUTE>, and any changes to those
variables are kept. These globals can hold just any kind of data. "Global[nn]", where nn specifies an
index into the global array.

An error in an EXECUTE, for instance a syntax error, will halt the template.

<SECTION {ID="id"} {BACKGROUNDIMAGE="userlmageName"}></SECTION>

The section's ID can be a single integer, or a range of integers. A range is specified as "nn-mm", and
includes the values nn and mm. mm must be greater than or equal to nn. By convention, sections are
arranged in ID order, least to greatest.

If no ID is specified for a section, then it is given an automatic ID relative to its position in the list of
sections in the template, based on the last ID specified. So if the first section ID was given as 100, the
next would automatically be 101, and so on.

It is possible for "blank" spots to occur in a template, where there is no section tied to a particular ID. If
one of these blank sections is accessed by ID, nothing is returned.

Specifying a section which duplicates an earlier 1D, or overlaps with a range specified for an earlier
section, will cause an error when accessing the template.

The section's BACKGROUNDIMAGE attribute overrides the template entry's background image (if there
is one). The background image must have been loaded into User Images (User menu, User Images...).
NOTE: You must use the full image name, including any extension (example:
BACKGROUNDIMAGE="journalpage.jpg").

If no user image by the given name exists, no image is used.

<SELECT ENTRY="entryName" {CATEGORY="entryCategoryName"}
{{METHOD="method"} {SCOPE="scope"} {DATA="data"}} {UNFORMATTED}/>

The SELECT tag can only be used within a section.

CATEGORY is used to select templates in other categories. If not specified, the template must be within
the current template's category.

METHOD specifies the how the template picks a section to return. If unspecified, the default access
method is "sequence". Valid access methods are "sequence"”, "id", and "random".

"random" access uses each sections ID range to determine that sections chance of being selected. So
a section with a wide ID range has a better chance of being selected than a section with a single ID.

SCOPE specifies how the "sequence" access method stores the current point in the sequence. Valid
scopes are "global", "template”, and "category". Default scope is "template”.

"global" scope means that current sequence value is stored for the template being called. "template”
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scope means that the sequence value is stored for the calling template and the template being called.
"category" means that the sequence value is stored for the calling category and the template being
called.

The DATA attribute is used by the "id" access method.

If UNFORMATTED is specified, then any formatting in the returned section is ignored.

<DATE {FORMAT="dd/mmlyy"}/>
<ENTRYDATE {FORMAT="dd/mmlyy"}/>
<TIME {FORMAT="hh:nn:ss"}/>

The text formatting of the date or time tag will be used on the inserted text.

DATE inserts the current system date. ENTRYDATE uses the date of the entry where the template is
being inserted into. In loose-leaf categories, ENTRYDATE functions the same as DATE.

If no FORMAT is specified, the Windows default setting for the date or time will be used.
The FORMAT's available include:

d, dd Day of the month, example: 3, 03
ddd Short day name, example: Tue
dddd Long day name, example: Tuesday
m, mm Month number, example: 6, 06
mmm  Short month name, example: Jun
mmmm Long month name, example: June
yy Short year, example: 03

yyyy Long year, example: 2003

h, hh Hour of the day, example: 7, 07
nn Minutes of the time

ss Seconds of the time

am/pm Adds "am" or "pm" to the time.

&lt; - replaced with '<' during section access.
&gt; - replaced with '>' during section access.

&quot; - replaced with ™ (double quote) during section access.

<LITERAL VALUE="string"/>
The literal quoted string is embedded in the template section replacing the LITERAL tag.

5.15.4 Enhanced Template Script Variables
The Journal provides some variables that can be used within the <DECLARE> and <EXECUTE> tags.

Result

If an <EXECUTE> is used inside a section the <EXECUTE> is considered to have a string-type result
value (called "Result") that will be inserted into the section when the script is finished. The text formatting
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5.15.5

of the initial <EXECUTE> tag will be applied to the inserted text. The inserted text will replace everything
between and including the <EXECUTE> and </EXECUTE>. Processing of the template will begin again
at the first position replaced. Thus, a <EXECUTE> could create further tagging to be processed.

Globalnn

"Globalnn", where nn specifies an index 1-1000 into the global array. Example variable names are:
Global1, Global23, Global456, etc.

There are global variables that can be accessed from any <DECLARE> or <EXECUTE>, and any
changes to those variables are kept. These globals can hold just about any kind of data.

Normally, global variables are cleared after each use of a template. Specifying a GLOBALVARSPACE,
though, in the <TEMPLATE> tag, creates a set of global variables that are available from one use of a

template to the next, and even available to other templates. The variables in a GLOBALVARSPACE are
available until the user logs out of The Journal.

RandomValue

The "RandomValue" variable is read-only. RandomValue is a random floating-point value where:
0 < RandomValue < 1

This variable is provided because the random functions of some scripting languages are inadequate.

Creating Simple Templates

Any loose-leaf entry can be a simple template.

Creating a Simple Template

Here are the steps to create a simple template:

1. Create a loose-leaf entry to be the template (press F9, or Entry menu, Create New Entry sub-
menu, Document). The "Templates" category can be used for this, or any other loose-leaf/notebook

category you choose. Name the entry "My Template".

2. Enter the text to use for the template. Here is some example template text (between the "- - - - - "):

Today | accomplished:
This made me happy today:

This made me angry today:

3. Now, to mark the entry as a template, click on the Entry menu, and choose Template Entry. The
entry's icon in the entry tree will now show a red "T" ( T).
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Using "My Template"

1. Bring up the current date in your "Daily Journal" category, and scroll to the end of the entry, if
necessary.

2. Click on the Insert menu, and bring up the Insert Template sub-menu. Choose "My Template".
This will insert the text of "My Template" into the active entry.

5.15.6 Creating Enhanced Templates

This section will provide a short tutorial in creating enhanced templates.

Like a simple template, an enhanced template must be a loose-leaf/notebook entry marked as a
template. However, while a simple template consists of whatever text is in its entry, an enhanced
template must be properly constructed using the enhanced template tags.

An enhanced template can have one or more "sections", any one of which can be chosen when the
template is inserted. A specific section can be chosen, or one can be chosen at random, or in
sequence, depending on how the enhanced template is used.

Enhanced templates can "include" sections from other templates or even other entries in other
categories. Combined with the ability to execute ActiveScript scripting commands, enhanced templates
are a powerful feature of The Journal.

In the "Templates" category that is created for you automatically, there are a small number of enhanced
templates. Those provide some examples of what can be done. Feel free to refer to those as you read
on, to see how they work and how they are structured.

Next: Enhanced Template Basics

5.15.6.1 Enhanced Template Basics

Enhanced templates use HTML- and XML-style "tags". These tags define the template itself, the sections
within the template, and handle scripting. The following example shows the simplest form of an
enhanced template:

<TEMPLATE>
<SECTION>Template text is here, as a section.</SECTION>
</TEMPLATE>

The <TEMPLATE> and <SECTION> Tags

As you can see in the example above, an enhanced template begins with a <TEMPLATE> tag, and ends
with a </TEMPLATE>. The <TEMPLATE> must be the first text in the entry. Any text that follows the </
TEMPLATE tag is ignored.

The <SECTION> and </SECTION> tags mark the actual text to provide when the template is inserted. If
you were to create an enhanced template from the above example, when you inserted the template, you
would get:

Template text is here, as a section.
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5.15.6.2

This may seem like a long way around to get to something that can be easily handled with simple
templates--and it is. So now we will talk about a couple useful things you can do with enhanced
templates.

Some Useful Tags: <DATE/> and <TIME/>

Suppose you want a way to quickly log when you eat, and what you eat. You don't want to create a
whole new category for this, preferring to just enter the information in your normal "Daily Journal"
entries. Here's a template that you can insert when you need it;

<TEMPLATE>

<SECTION>

Food Log for <DATE FORMAT="mm/dd/yy"/> @ <TIME FORMAT="hh:nn">
Food/Description ~ Servings Calories

</SECTION>

</TEMPLATE>

When you insert this template, the <DATE/> tag will be replaced with the current date, using the format
specified, and the <TIME/> tag will be replaced with the current time, again using the format specified.
Here's an example:

Food Log for 06/03/03 @ 07:47pm

Food/Description ~ Servings Calories

Then you could type in the name of the food you ate, and then tab over to fill in the number of servings
and the calories.

The "FORMAT=..." part of the tags is called an attribute. Aftributes usually take the form of:
ATTRIBUTENAME="Attribute Value"

That is, the name of the attribute is specified in all caps, followed by an equal sign (=), and then the
value of the attribute, enclosed in double quotes.

To see all of the available FORMAT options for <DATE/> and <TIME/>, click here.

NOTE: Typically, tags and attributes are entered in ALL CAPS, but this is only a convention. Enhanced
template tabs and attributes can be either lowercase, UPPERCASE, or MixedCase.

Next: Enhanced Template Sections Part 1

Enhanced Template Sections

You have been shown the basic structure of an enhanced template, using <TEMPLATE></TEMPLATE>
and <SECTION></SECTION pairs, and even how to use attributes to modify a tag like <DATE/>. We
will now talk about enhanced template sections in more detail.

Multiple Sections

As we have already covered, the <SECTION> and </SECTION> tags mark the actual text to provide

© 1996-2016 by David Michael



The Journal Reference 161

when the template is inserted. Unlike a simple template, however, where the entire entry is used every
time, an enhanced template can have more than one section, and which one is used can be determined
a couple of different ways. For example:

<TEMPLATE METHOD="random">

<SECTION>How are you today?</SECTION>
<SECTION>What's up?</SECTION>

<SECTION>How are you feeling today?</SECTION>
<SECTION>Have you won the lottery yet?</SECTION>
<SECTION>Do you know where your towel is?</SECTION>
<SECTION>What's the weather like?</SECTION>
<SECTION>How is work?</SECTION>

</TEMPLATE>

This enhanced template, when inserted, will randomly choose from one of the above questions. Only
one of them will be used each time the template is inserted.

Note the METHOD attribute of the <TEMPLATE> tag. This attribute specifies how the template will
choose from the available sections. There are two possible METHOD's:

random  Choose a random section
sequence Choose the next section in sequence

If the METHOD attribute had been set to "sequence” instead of "random", then the first time you
inserted the template, you would get:

How are you today?

The second time you would get:

What's up?

And so on. The sequence will repeat once it reaches the last available section.

While the example given is somewhat contrived, it's not too different from the various Writing Prompt
templates in the "Templates" category.

Section Formatting

A section will pull the text, with whatever font or formatting it may have, from the end of the <SECTION>
tag to the beginning of the </SECTION> tag. So if the section text has bold, or italic, or even difierent
fonts, this will be inserted, as well. This includes paragraph formatting, like indentation and hard returns.

The example above, with the different greetings, for instance, will insert the greeting at the current
cursor position in the active entry. Afterward, the cursor will be position immediately after the last
character in the greeting. If, instead, you wanted a blank line after the greeting, you would need to add
that to the section, like this:

<SECTION>How are you today?
</SECTION>
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If you wanted two blank lines after the greeting, you would do this:

<SECTION>How are you today?

</SECTION>

And, maybe you want a blank line before the greeting, to separate it from the preceding text. In which
case, you would do this:

<SECTION>
How are you today?

</SECTION>

You can override the formatting of all sections by using the UNFORMATTED attribute of the
<TEMPLATE> tag. This will force the text of the sections to be treated as simple text, with no formatting
such bold, italic, or whatever. Paragraph formatting will also be stripped off, though not hard returns/line
breaks used to separate paragraphs. This is how the above example would be changed:

<TEMPLATE METHOD="random" UNFORMATTED>

Next: Enhanced Template Scripting

Enhanced Template Scripting

With an understanding of enhanced template sections, we now turn our attention to one of the more
powerful aspects of enhanced templates: scripting. With scripting, you can create sophisticated
functions and use them when processing the enhanced template.

Warning: This discussion of scripting in enhanced templates assumes that you are familiar with basic
programming techniques. This is not a tutorial about any particular scripting language. It only shows
how scripting can be used in The Journal.

Enhanced templates can use ActiveScript languages such as VBScript, JavaScript, and so on. Any
ActiveScript language that is installed on your computer can be used.

Within a Section or Outside of a Section

Scripts in enhanced templates can be either inside of a section (between the <SECTION></SECTION>
tags) or outside of any section. The biggest difference between those two cases is:

1. Script within a section is only executed when that section is selected. The results of the script, if any,
may be added to the text of the section when it is inserted into the active entry.

2. Script that is external to any section is executed every time the enhanced template is processed,
before any section is selected.

The <EXECUTE> Tag
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Script commands are always bracketed by the <EXECUTE> tag, and it's trailing </EXECUTE>.
Everything between those tags is considered to be part of the script.

The default scripting language is VBScript. You can override this with the USE attribute. For example:
<EXECUTE USE="JavaScript">

/I JavaScript commands here...
</EXECUTE>

If you specifiy a language with the USE attribute, that language must be available. Otherwise, the script
will not run. For simplicity, VBScript will be used in the examples given in the rest of this tutorial.

Global Script Variables

For script that is executed outside of a section, the only way to hold onto any results is with the global
variables provided.

There 1000 global variables available, and they can contain just about any type of value you choose
(number, string, etc.). You access them within your script commands like so:

<EXECUTE>
Globalnn="This String'

</EXECUTE>

Or:

<EXECUTE>

if Globalnn >= 18 then
</EXECUTE>

Where "nn" is some number from 1-1000. Thus, you could have "Global1" or "Global23" or "Global456"
and so on.

The Result Variable

The Result variable is a local variable available only to <EXECUTE>'s that are inside of a section. The
Result variable can be assigned a value, either a string value or any value that can be easily converted
to a string (like a number). The value of Result is then inserted into the section's text, replacing the
entire <EXECUTE> </EXECUTE> script.

For example, this section:
<SECTION>

Hello, my name is <EXECUTE>Result="David"</EXECUTE>!
</SECTION>
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Would look like this when inserted:

Hello, my name is David!

An Example with Scripting
Let's say you want a simple writing exercise that uses a random letter. You could do it like this:
<TEMPLATE>

<EXECUTE>

if Int(RandomValue * 2) > 0 then
Global1="begins"

else
Global1="ends"

end if

</EXECUTE>

<EXECUTE>

Global2=Chr(65+Int(RandomValue*26))

</EXECUTE>

<SECTION>

Write about a word that <EXECUTE>Result=Global1</EXECUTE> with the letter:
<EXECUTE>Result=Global2</EXECUTE>

</SECTION>

</TEMPLATE>

This template randomly selects either "begins" or "ends", and then randomly selects a letter from A-Z
These values are stored in the global variables Global1 and Global2, respectively. The section then
combines those variables with some text to create the writing exercise. Examples of the templates output
are:

Write about a word that ends with the letter: X

Write about a word that begins with the letter: E

The "RandomValue" variable used in the above scripts is a global variable available in enhanced

templates. It returns a random value (x) where: 0 < x< 1

Next: Enhanced Template Scripting Part 2

Enhanced Template Scripting Part 2

Even with only what we've shown you so far, scripting is obviously a powerful feature. There is more,
however. In this topic, we discuss two more tags that take scripting to the next level.

Warning: This discussion of scripting in enhanced templates assumes that you are familiar with basic
programming techniques. This is not a tutorial about any particular scripting language. It only shows
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how scripting can be used in The Journal.

The <DECLARE> Tag

The <DECLARE> tag is much like the <EXECUTE> tag, in that it contains script code. Unlike the script
in <EXECUTE>'s, however, script in <DECLARE>'s is not run. Instead, the procedures and functions
declared are available to be called from within a <EXECUTE>.

You can have more than one <DECLARE></DECLARE> in an enhanced template. If you do have more
than one, they are consolidated and treated as a single collection.

One example of using <DECLARE> comes from role-playing games (RPG's). In RPG's many things are
based on the roll of a die. The die can have 4 sides (a d4), 6 sides (a d6), 8 sides (a d8), and so on. If
you wanted to create a template that would generate RPG items, you would be calculating random
numbers frequently. Rather than duplicate that script every time you need it, it is more useful to create it
once:

<TEMPLATE>

<DECLARE>

function RollDie(typeDie)
RollDie=Int(RandomValue*typeDie)+1

end function

function RollDice(typeDie,count)
total=0
for dd=1 to count

total=total+RollDie(typeDie)

next
RollDice=total

end function

</DECLARE>

<SECTION>You find <EXECUTE>Result=RolIDie(6)</EXECUTE> gold dubloons and
<EXECUTE>Result=RolDice(6,3)</EXECUTE> silver coins.</SECTION>

</TEMPLATE>

So now you can create a collection of common function and procedures with your enhanced template.
But what if you want to use the same functions and procedures in other enhanced templates?

The <INCLUDE> Tag

The <INCLUDE> tag allows you to access entries within The Journal, or even files outside of The
Journal, and "include" them as part of the enhanced template.

Thus, you could create a loose-leaf entry called "Dice Functions" that contains this:

<DECLARE>

function RollDie(typeDie)
RollDie=Int(RandomValue*typeDie)+1

end function
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function RollDice(typeDie,count)
total=0
for dd=1 to count

total=total+RolIDie(typeDie)

next
RollDice=total

end function

</DECLARE>

Then you could simply "include" that entry in those enhanced templates where you need those
functions:

<TEMPLATE>

<INCLUDE ENTRY="Dice Functions">

<SECTION>You find <EXECUTE>Result=RollDie(6)</EXECUTE> gold dubloons and
<EXECUTE>Result=RolIDice(6,3)</EXECUTE> silver coins.</SECTION>

</TEMPLATE>

Much more compact, and much easier to maintain.

Next: Enhanced Templates Wrapup

5.15.6.5 Enhanced Templates Wrapup

Hopefully this short tutorial has shown you some of what is possible with The Journal's enhanced
templates.

With multiple sections to provide some variability, and scripting to add power, enhanced templates can
be amazingly versatile and useful.

Again, check out the enhanced templates that are provided in the "Templates" category. See how they
do what they do, and feel free to tinker with them.

Learn more here:

Enhanced Template Tags
Enhanced Template Script Variables

5.16 Topics

Topics provide another powerful way to organize your thoughts in The Journal. You can set a topic to
the text of entry, either as you type it or afterward. You can set as many topics within an entry as you
wish, or even tag an entry with as many topics as you want. You can then search entries with a topic or
topics and review them. Searching by topic can be a lot faster than searching for a word, phrase, or
collection of words.

The Journal creates a list of more than 60 topics and sub-topics for you, including:
* Business
® Dream
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Family
Feelings
Finances
Friends
Health
Hobbies
And more!

Of course, you can add topics of your own and delete the ones you don't need.

Each topic can be given its own highlight color, to make it easier to see, and you can assign hot-keys to
up to 10 topics for ease of use.

When reviewing your entries, topics can be displayed (either one at a time or all at once) or hidden
entirely.

Using Topics
Apply Topic
Editing Topics
Searching Topics

Using Topics

You can use topics either as you type in your entries, or apply them afterward as you review your
entry.
Tagging an Entry with a Topic

Click on the Topic menu and choose "Tag Entry with Topic..." (hot-key: Ctrl+Shift+G). This applies
the topic or topics that you check to the entire entry.

Fr] Tag Entry with Topic(s)

Enter Topic(s)

NOTE: Use commas to separate multiple topics.

Select Topics from List Done Cancel

Type the topic or topics (separated by commas) that you wish to tag to the entry. You can also click on
"Select Topics from List" to see a list of all topics.
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1] Select Topic(s)

s s ncss|
O Employees
O Management
= O Client
O Client 1
O Client 2
O Dream
Oimages
[ Themes
O Family
O Brother
O Children
[ Daughter
O Father
O Mather

Clear all Topics

Done Cancel

Using Topics while Making Your Entry

You can also apply topics as you make your entry.

Select the topic you want from the drop-down list on the toolbar.
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- Oiness
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Once you do that, the name of the topic is inserted (as "[Topic Name]" on a line of its own), the topic's
highlight color is made visible, and then whatever you type will be automatically assigned that topic.
(NQOTE: The topic highlight color isn't printed.)

[Exercise]

In my workout today I adjusted the weight used |

You can switch to a new topic (or no topic) at any time by selecting the appropriate choice from the
topic list. The hot-key for "Apply <No Topic>" is: Shift+Ctrl+Q Also, if you triple-space after a

paragraph (hit ENTER three times), then you turn off the active topic.

Applying Topics to Your Entry

To apply topics to text after you have entered it, first select the text you want to tie to the topic, then

choose the topic from the list.
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A given block of text can have any number of topics assigned to it. The marked text will show up in
searches for any of the applied topics.

Viewing Topics

Topics that have already been tagged to the entry or applied to the entered text are displayed in the
status bar below the entry:

Topics: [Exercise], Diet, Energy

Topics applied to entered text are listed first, and shown with [brackets]. Topics that are tagged to the
entry are listed next.

By default, blocks of text that have a topic are displayed with their hightlight color. This highlight isn't
printed. It only serves to show the text with topics. You can change this so that text with topics applied

does *not* show the highlight color. Click on the Topic menu and choose "Edit Topics..." Un-check
the option "Default to 'Show all Topics' in Editor".

5.16.2 Apply Topic
Click on the Topic menu and choose "Apply Topic..."

Or, to apply a topic to the entire entry:

Click on the Topic menu and choose "Tag Entry with Topic..."

Topics that have already been applied to the entry will show as checked.
Check or un-check the topics you want to apply.

"Clear all Topics" will un-check all topics in the list.

5.16.3 Editing Topics

The Journal creates a list of more than 60 topics and sub-topics for you, but you can change the
topics, delete topics you don't need, and add topics of your own.

To edit your topics, click on the Topic menu and choose "Edit Topics..."
Any topic that you have used is shown as bold in the list of topics.

For explanation of all the available topic options, check out User Preferences: Topics.

5.16.4 Merging Topics

Click on the Topic menu and choose "Merge Topics..."

This form allows you to merge two or more topics into a single topics. Any entries that have the merged
topics will be updated.

NOTE: This operation cannot be undone. If you change your mind, you will have to restore from a
previous backup.
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5.16.5

5.17

5.17.1

5.17.2

Searching Topics

Searching by topic can be a lot faster than searching for a particular word or phrase. Because an entry
knows which topics have been used, it does not have to examine the entire entry.

To search by topic:

1. Click on the Topic menu and choose "Search Entries by Topic..."

2. Check the topic(s) you want to search for. NOTE: The topics you have used at least once in an entry
are listed first, in alphabetical order. All other topics are listed in alphabetical order following the ones
you have used.

3.Click on "Search".

User Interface

User Interface FAQ
How can | customize the look of The Journal (change the skin)?

How do | customize the toolbars?

What is the hot-key (keyboard shortcut) for...?

Customizing the User Interface with Themes

The Journal comes with dozens of pre-created themes.
The quickest way to change the theme is to click on the View menu and choose "Change Theme..."

You can also change the theme--or turn off themes--of The Journal in "User Preferences..." (on the
User menu), on the "Global" tab. Use the "Theme" sub-tab. To turn "off" themes, select the
"Windows" theme.

The Journal 6-style Skinning

The Journal 6 used a different set of themes, called "skins". You can use these skins instead of the new
themes, if you want.

NOTE: After you active "The Journal 6-style skinning", you will need to close The Journal and restart it.

ALSO NOTE: The colored tabs option (in User Preferences: Category) does not work with The Journal
6-style skinning.

Customizing the User Interface Font

You can select the font, font style (regular, italic, bold or bold italic) and size of font you would like to
use in the user interface. This can be useful for those with difficulties seeing small fonts or to change
the style of the The Journal.

Click on the User menu and choose "User Preferences...", and bring up the "Global" tab. Bring up
the "Theme" sub-tab, then click on the button Edit User Interface Font.

This font will be used in all areas of the user interface, but it is not the font selected for your Journal
entries.
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5.17.3 Customizing the Menus & Toolbars

The Journal supports full customization of the main menu and all toolbars.
Right-click on the menu or toolbar that you want to customize, and choose Customize.
Click on the Commands tab to see the list of available commands.

Under "Categories:" are groups of commands that roughly correspond to the menus of the same
name. For example, the commands available under "Format" are those on the "Format" menu.

Once you select a category, you can click on the menu or toolbar command under "Commands:" and
drag it where you want it to appear on the menu or toolbar.

5.17.4 Keyboard Shortcuts (Hot-Keys)

Ctrl+Tab Move to next category tab
Ctrl+Shift+Ta Move to previous category tab

b

F1 Context-sensitive help

F2 Rename selected entry

Ctr+F2 Add a Calendar Charm to selected entry

F3 Repeat last find

F4 Lock/Unlock active entry (prevent/allow editing)

F5 Go to today's entry in category (Calendar Categories only)
CtrI+F5 Go to date (Calendar Categories only)

Ctrl+Shift+F5 Go to a random entry in the current category (Calendar Categories only)
F6 Set date for all active categories (Calendar Categories only)
F7 Go to previous entry in category

Shift+F7 Go back 1 month (Calendar Categories only)
Ctrl+F7 Go back 1 year (Calendar Categories only)

F8 Go to next entry in category

Shift+F8 Go forward 1 month (Calendar Categories only)
Ctrl+F8 Go forward 1 year (Calendar Categories only)

F9 Create new entry

Shift+F9 Create new root entry

Ctrl+Shift+F9 Create new entry for today (Calendar categories only)
F10 Create new sub-entry

Shift+F10 Bring up entry context menu

F11 Normal editor (no split editing)

Shift+F11 Split Editor Horizontal

CtrlI+F11 Split Editor Vertical

Ctrl+Shift+F1 Full-screen (distraction free) Editor
1

F12 Save Entry as...
Ctr+F12 Export Entries...
Ctrl+F Find text in entry
Ctrl+Shift+F Search entries
Ctr+G Replace text in entry

Ctrl+<spacebar>  Apply default text style to selected text
Ctrl+Shift+<spacebaApply default text style to selected text, retaining formatting
r>

Ctrl+Delete  Delete word
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Ctrl+B
Ctrl+U

Ctrl+l
Ctrl+<dash>
Ctri+[

Ctrl+]
Ctrl+M
Ctrl+Shift+M
Ctrl+H
Ctrl+Shift+L
Ctrl+Shift+N
Shift+F10
Ctrl+Shift+D
Ctrl+Shift+Y
Ctrl+L
Ctrl+R
Ctrl+E
Ctrl+Shift+K
Ctrl+=
Ctrl+Shift+=

Ctrl+Shift+H

Ctrl+D
Ctrl+T
Ctrl+Shift+A
Ctrl+Shift+]

Toggle Bold On/Off

Toggle Underline On/Off

Toggle ltalics On/Off

Toggle Strikeout On/Off

-1 font size

+1 font size

Indent paragraph

Unindent paragraph

Hanging indent

Toggle bulleting

Toggle numbering

Bring up entry context menu

Add/edit description of selected image
Edit layout properties of selected image
Align paragraph left

Align paragraph right

Center paragraph

Block justify paragraph

Subscript

Superscript

Edit the current paragraph as right-to-left (for Middle Eastern users)

Insert Current Date at cursor

Insert Current Time at cursor

Insert Entry Date (date of the active entry) at cursor
Insert Current Timer at cursor

Ctrl+Shift+<dash> Insert line at cursor

Ctrl+K
Ctrl+Shift+X

Ctrl+Shift+B
Ctrl+Shift+S
Ctr+Shift+R

Ctrl+J
Ctrl+Alt+J

Ctri+Shift+J
Ctrl+Shift+U

Ctri+Shift+T
Ctrl+Shift+E
Ctri+Alt+C
Ctri+Alt+T
Ctri+Alt+|

Alt+Up
Alt+Down
Alt+Shift+Up

Ctrl+Z
Ctrl+Y

Ctrl+Shift+P
Ctrl+Shift+G

Insert Link
Insert To-do (CheckBox)

Backup The Journal
Spell checker
Thesaurus

Hide (and optionally Lock) Journal
Activate The Journal (if running)

Open Journal Volume
Switch user (login in as a different user)

Shift focus to date tree

Shift focus to entry

Toggle calendar On/Off

Toggle date tree On/Off

Toggle countdown timer and stopwatch On/Off

Move Entry Up
Move Entry Down
Promote Entry

Undo changes
Redo changes

Apply topic
Tag entry with topic
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Ctrl+Shift+Q Set selected text to "<No Topic>"

Editing Keyboard Shortcuts

Many of these keyboard shortcuts can be changed. Click on the Tools menu and choose "Edit Menu/
Toolbar Commands..."

The hot-keys for Styles (Ctrl+1 through Ctrl+0) and Topics (Ctrl+Shift+1 through Ctrl+Shift+0) cannot
be changed.

International Characters

Acute accent: A E, 1,0, U, Y, 4, 6,1, 6,0,y
Ctrl+Shift+<apostrophe> <letter>

Ctrl+Shift+* <letter>

Grave accent: A, E, I, O, U, 3, &, 1, 0, U
Ctrl+* <letter>

Tilde accent: A, N, O, &, A, &
Ctrl+Shift+~ <letter>

Umlaut accent: A, E, 1,0, U, Y, 4, 8,1, 6, U, ¥
Ctrl+Shift+<colon> <letter>

Slashed characters: 9, @
Ctrl+/ <letter>

Cedilla: C, ¢
Ctr+<comma> <letter>

Compound characters: B, A&, CE, &, e
Ctrl+Shift+t& s =

Ctrl+Shift+& a = ae

Ctrl+Shift+& o = ce

5.17.5 Keyboard Shortcuts (Hot-Keys) Alphabetically

Ctrl+A Select All (entire entry)

Ctrl+Shift+A Insert Entry Date (date of the active entry) at cursor
Ctrl+B Toggle Bold On/Off

Ctrl+Shift+B  Backup The Journal

Ctrl+C Copy selection to clipboard

Ctrl+Alt+C  Toggle calendar On/Off

Ctrl+D Insert Current Date at cursor
Ctrl+Shift+D Add/edit description of selected image
Ctrl+E Center paragraph

Ctrl+Shift+E  Shift focus to entry

Ctr+F Find text in entry

Ctrl+Shift+F  Search entries

Ctrl+G Replace text in entry

Ctrl+Shift+G Tag entry with topic
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Ctrl+H
Ctrl+Shift+H
Ctrl+l
Ctrl+Shift+]
Ctrl+Alt+]
Ctrl+J
Ctrl+Shift+J
Ctrl+Alt+J
Ctrl+Shift+K
Ctrl+K
Ctrl+L
Ctrl+Shift+L
Ctrl+M
Ctrl+Shift+M
Ctrl+Shift+N
Ctrl+Shift+O
Ctrl+P
Ctrl+Shift+P
Ctrl+Shift+Q
Ctrl+R
Ctrl+Shift+R
Ctrl+S
Ctrl+Shift+S
Ctr+T
Ctrl+Shift+T
Ctrl+Alt+T
Ctrl+U
Ctrl+Shift+U
Ctrl+V
Ctrl+Shift+V
Ctrl+W

Hanging indent

Edit the current paragraph as right-to-left (for Middle Eastern users)

Toggle ltalics On/Off

Insert Current Timer at cursor
Toggle countdown timer and stopwatch On/Off
Hide Journal

Open Journal Volume

Activate The Journal (if running)
Block justify paragraph

Insert Link

Align paragraph left

Toggle bulleting

Indent paragraph

Unindent paragraph

Toggle numbering

Toggle outline

Print

Apply topic

Set selected text to "<No Topic>"
Align paragraph right

Thesaurus

Save all changes

Spell checker

Insert Current Time at cursor

Shift focus to date tree

Toggle date tree On/Off

Toggle Underline On/Off

Switch user (login in as a different user)
Paste from clipboard

Paste Special from clipboard

Count words in entry or selected text

Ctrl+Shift+W Count words in the active entry plus the words in all sub-entries

Ctrl+X
Ctrl+Shift+X
Ctrl+Y
Ctrl+Shift+Y
Ctrl+Z

Ctr+Tab

Cut selection to clipboard

Insert To-do (CheckBox)

Redo changes

Edit layout properties of selected image
Undo changes

Move to next category tab

Ctrl+Shift+Ta Move to previous category tab

b

Ctrl+<spacebar Apply default text style to selected text
>

Ctrl+Shift+<spacebar Apply default text style to selected text, retaining formatting

>
Ctrl+Delete

Delete word

Ctrl+Shift+InserPaste from clipboard as text

t

Ctrl+<dash>

Toggle Strikeout On/Off

Ctrl+Shift+<dash> Insert line at cursor

Ctri+[
Ctrl+]

Ctrl+=

-1 font size
+1 font size

Subscript
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Ctrl+Shift+= Superscript

Alt+Up Move Entry Up
Alt+Down Move Entry Down
Altt+Left Promote Entry
Altt+Right Demote Entry
Alt+Shift+Left Back

Alt+Shift+Right Forward

F1 Context-sensitive help

F2 Rename selected entry

Ctrl+F2 Add a Calendar Charm to selected entry

F3 Repeat last find

F4 Lock/Unlock active entry (prevent/allow editing)

F5 Go to today's entry in category (Calendar Categories only)
Ctri+F5 Go to date (Calendar Categories only)

Ctrl+Shift+F5 Go to a random entry in the current category (Calendar Categories only)
F6 Set date for all active categories (Calendar Categories only)
F7 Go to previous entry in category

Shift+F7 Go back 1 month (Calendar Categories only)

Ctrl+F7 Go back 1 year (Calendar Categories only)

F8 Go to next entry in category

Shift+F8 Go forward 1 month (Calendar Categories only)

Ctrl+F8 Go forward 1 year (Calendar Categories only)

F9 Create new entry

Shift+F9 Create new root entry

Ctrl+Shift+F9 Create new entry for today (Calendar categories only)
F10 Create new sub-entry

Shift+F10 Bring up entry context menu

F11 Normal editor (no split editing)

Shift+F11 Split Editor Horizontal

Ctrl+F11 Split Editor Vertical

Ctrl+Shift+F1 Full-screen (distraction free) Editor
1

F12 Save Entry as...

Ctrl+F12 Export Entries...

Editing Keyboard Shortcuts

Many of these keyboard shortcuts can be changed. Click on the Tools menu and choose "Edit Menu/
Toolbar Commands..."

The hot-keys for Styles (Ctrl+1 through Ctrl+0) and Topics (Ctrl+Shift+1 through Ctrl+Shift+0) cannot
be changed.

International Characters

Acute accent: A E, 1,0, U, Y, 4 6,1i,06,0,y

Ctrl+Shift+<apostrophe> <letter>

Ctrl+Shift+* <letter>
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5.17.7

Grave accent: A, E, 1,0, U, 3, &, 1, 0, U
Ctrl+* <letter>

Tilde accent: A, N, &, &, i, 6
Ctrl+Shift+~ <letter>

Umlaut accent: A, E, 1, O, U, Y, &, &,7, 6, U, y
Ctrl+Shift+<colon> <letter>

Slashed characters: 9, @
Ctrl+/ <letter>

Cedilla: C, ¢
Ctrl+<comma> <letter>

Compound characters: R, &, CE, &, ce
Ctr+Shift+t& s =

Ctrl+Shift+& a = ae

Ctrl+Shift+& o = ce

Language

To change the user interface language, click on the View menu, Language sub-menu, and choose the
language.

Currently available languages:

* English (United States) (default)

¢ English (United Kingdom)

Chinese (People's Republic of China) [*]
German

Russian [**]

[*] This language shouldn't be used except on Asian-language versions of Windows.
[**] This language works best on Cyrllic-language versions of Windows.

NOTE: The Journal uses Windows Regional settings for many things, like month names, days of the
week, and so on. Thus, those types of text are *not* affected by choosing a different language.

Journal.INI

Under Windows Vista and Windows 7, the user-editable Journal.INI file can be found here:
C:\Users\WinUser\AppData\Roaming\The Journal 7\

Under Windows XP, this is the path:
C:\Documents and Settings\WinUser\Application Data\The Journal 7\

[GlobalOption]
The [GlobalOption] section provides access to the following settings:

GOShowSplashScreen

If true (=1), show the "splash screen" when starting The Journal. If false (=0), do not show the "splash
screen" when starting The Journal.
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GOForceRepair

If true (=1), force The Journal to repair all Journal Volumes. This option is automatically reset to false
(=0) after the forced repair is completed.

GOlnterfaceFontSize

If set to any positive value, that value is used as the font point size used in the entry date tree and
category tabs.

The default font point size is 8. If you would like to increase the font size used, try:
GOinterfaceFontSize=10

GONoCtrlAltHotKeys

If true (=1), this option turns off the keyboard shortcuts in The Journal that use Ctri+Alt key
ﬁgrfeir;z’.[ions. Currently, this only affects the Toggle Calendar (Ctrl+Alt+C) and Toggle Tree (Ctrl+Alt+T)

Some international users (e.g., from Poland) were having problems with the Ctrl+Alt+C hot-key. It
prevented them from using a particular accented character.

GOAlwaysChooseRunAnotherTJSet

If true (=1), then the user has chosen to always either run another instance of The Journal, or to always
*not* run another instance, bringing up the active instance.

GOAlwaysChooseRunAnotherTJ

If true (=1), then the user can run The Journal as many times as he wants, each time opening a new
instance of The Journal.

If false (=0), then The Journal will be limited to a single running instance.
5.17.8 Command Line Options
-v Specify Journal Volume
You can specify a Journal Volume to open when you start The Journal. The format is:
journal7.exe -v VolumeName
Example: journal7.exe -v Home
If the Journal Volume name includes spaces, then the name must be in quotes.
Example: journal7.exe -v "My Journal"
NOTE: When this command line parameter is present, only the specified Journal Volume is opened.

Other Journal Volumes, even those specified as auto-load, will not be opened. You can open those
Journal Volumes manually with File menu, Journal Volume sub-menu, "Open Journal Volume..."

-repair Force Database Repair
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5.17.9

5.17.9.1

5.17.9.2

5.17.9.3

If this command line option is present, The Journal will repair all Journal Volumes when starting. The
format is:

journal7.exe -repair

Miscellaneous Forms
This section describes the options and commands available on The Journal's forms.

Calendar Charms

Click on the Entry menu and choose "Entry Calendar Charm..." (hot-key: Ctrl+F2)

Or click on the Insert menu and choose "Insert Calendar Charm..." (hot-key: Shift+F2)
To choose a Calendar Charm:

1. Select the Calendar Charm Collection.

2. Click on the Charm you want, by clicking on it or using the arrow keys.

3. Click on Select.

To Remove a Calendar Charm:
1. Click on Clear.
2. Click on Done.

See also: Calendar Charms

Category Statistics

Click on the Category menu and choose "Category Statistics..."

This form shows the following information for the active category:

¢ # of Entries - the total number of entries in this category

* Security Level - whether the category requires a password or not

Shared? - whether the category is shared; if so, whether it's shared read only or full access
Access - whether the category is read only (no new entries, no editing of entries) or full access
Parent Category - if the category is a sub-category, this is the name of its parent category

Change User Password

Click on the User menu and select "Change User Password..."

You will need to enter your current password (unless you have a blank password) to create a new
password. When your current password has been verified, you will be asked to confirm your new
password.

The Journal allows passwords of any length.

See Choosing a Good Password for tips on how to make your password as secure as possible.
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Using a Blank Password

The Journal allows you to have a "blank" password if you want. If you do not want a password, but still
want The Journal to "prompt" you to login, a blank password will do that.

When you set your password, just leave the new password blank. Do not type anything.

See also: How do | reset my lost password?

5.17.9.4 Choose an Action

You will be presented with the "Choose an Action™ form in a variety of situations. The most frequent
cases are:

* You cancel out of a user login prompt and there is no other user logged in.
* The Journal is unable to find or open an expected Journal Volume.

The currently active Journal Volume, if any, is displayed.

You must choose one of these actions to proceed:

Open Another Journal Volume

You will be presented with a list of available Journal Volumes. Choose the Journal Volume you want to
open.

Log in to the Current Journal Volume

This choice will take you back to the user login. There you can choose a user name and enter the
password to log in.

Create a New Journal Volume

This choice will lead you through the steps necessary to create a new Journal Volume, which you can
then open and log into.

Restore from a Backup

If you need to restore from a backup, click on this button.

Close The Journal

The Journal will close.
5.17.9.5 Choose Category to Import Into

When importing entries from an export file, you will be prompted to choose the correct category to use
for the import.
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5.17.9.7

You can only choose a category that is the same type (calendar or loose-leaf) as the category that is
being imported.

You can also create a new category to receive the import, or you can tell The Journal to auto-create the
category. The automatic creation creates the new category based on the import category (same type,
name, and so on).

Clipboard Viewer

Click on the Edit menu and choose "Clipboard Viewer..."

The Journal's Clipboard Viewer provides a powerful tool for managing and using the Windows
clipboard. You can edit the clipboard contents, or paste them into the currently active entry.

With the "Auto-Paste to Active Entry" option, you can have anything that is copied to the Windows
clipboard automatically pasted into the active entry. This means you can rapidly collect information from
various applications and web pages without having to switch back and forth between The Journal and
the source of the information. Just select what you want, and copy it to the clipboard.

Countdown Timer

Click on the View menu and choose "Timer" (hot-key: Ctri+Alt+l).

The Journal's countdown timer can be used in a variety of ways:

* Many writing and journaling exercises want you to "just write" for a set period of time, like 10 minutes.

® For your current writing project, you want to write for an hour every day.

* For any project where you want to work for a period of time, the countdown timer can be set for a
matter of seconds, or even hours.

NOTE: When you use the countdown timer, the stopwatch is disabled. And vice versa. You cannot use
both the countdown timer and the stopwatch at the same time.

Time Remaining

You can set the countdown timer to any time from just 1 second to many hours. You type in the
duration you want, and hit ENTER.

Setting durations:

mm  Will set the timer for mm minutes.

:ss  Will set the timer for ss seconds.

mm:ss Will set the timer for mm minutes and ss seconds.

hh:mm:ss Will set the timer for hh hours and mm minutes and ss seconds.

While the timer is counting down, you can insert the current timer value into your entry by clicking on
the Insert menu and choosing Insert Timer Count.

When the timer reaches 00:00:00, a sound is played to alert you. You can set the sound in User
Preferences.

@ Start

Will start the countdown timer. If you have paused the timer, it will resume from its last count.
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5.17.9.8

5.17.9.9

W Pause

Will pause the countdown timer.

W Reset

Reset stops the countdown timer, resetting it to 00:00:00.

Delete Users

Click on the File menu, Journal Volume sub-menu, and choose "Delete User(s)..."
You can only delete users within the active Journal Volume.
You will need to enter the password of any users you want to delete.

NOTE: Deleting a user also deletes all categories and entries for that user. Once deleted, a user cannot
be recovered. You would need to restore from a backup.

Edit Auto Replace Strings

Click on the User menu and choose "User Preferences..." Bring up the "Editor™ tab.

You can use the auto-replace feature to simplify your typing. You can create simple strings that are
automatically replaced with more complex text as you type them.

Auto-Replace Strings

This is the list of all auto-replace strings you have created. To edit an auto-replace string, click on it in
the list. To create a new auto-replace string, click on New Auto-Replace.

Replace

This is the sequence of characters that is to be replaced with the text in With. Each replacement string
must be unique.

With

This is the text that is automatically inserted when you type the string in Replace within an entry. This
text can be one or more lines long, and can be either formatted or unformatted.

Use Formatting

Check this option to apply formatting to the With text.

5.17.9.10 Edit Header/Footer

This form is used to edit both headers and footers for users and categories.
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Headers and footers are functionally identical, and are configured using the same options. The only
difference between them is that one is printed at the top of the page (headers) and one at the bottom of
the page (footers).

Formatted text can be used in both headers and footers. This means you can use any TrueType font
you have on your PC, you can use bold, italic, etc., and you can specify that the text be aligned to the
left, right, or centered. An empty header or footer will not be printed.

With the use of Print Macros, the text of the header and footer can include pre-defined values such as
the page number, the category name, and so on.

See User Preferences: Printing and Printing Headers and Footers for more information.

5.17.9.11 Edit Symbol Replace Strings

Click on the User menu and choose "User Preferences..." Bring up the "Editor" tab.

Some symbols are awkward, if not impossible, to type using normal keyboards. The Journal's Symbol
Replace feature can help work around this limitation by associating simple sequences with special
characters.

Examples:

(c):©

(tm) : ™

'e:é

=) d

To create a new Symbol Replace sequence, simply click on New. Then type in the sequence of
characters, choose the font, and choose the symbol.

Replace

This is the sequence of characters that is to be replaced with the symbol. Each replacement string must
be unique.

Symbol Font

This is the Windows TrueType font that contains the desired symbol.

Symbol and WingDings fonts contain many command symbols, such as © and J

Special Roman characters, such as é and &, are genearlly supported by any normal Windows

TrueType font (such as Arial). For these characters, it is recommended that you use the "<Default>"
font option.

Symbol

Once you have selected the desired Symbol Font (or <Default>), simply choose the character you
want.
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5.17.9.12 Enter Registration Keys
Click on the Help menu and choose "Enter Registration Keys..."
Use this form to enter the Registration Keys you received when you bought The Journal.
The Registration Keys are in the form:

Key 1: YOUR NAME
Key 2: XXODDSTUFFHEREXX

Entering Your Registration Keys

Your Registration Keys are case-sensitive, so they must be entered exactly as sent to you. The easiest
way to do this is:

1. Select both Registration Keys from the email you were sent and copy them to the Windows clipboard
(hot-key: Ctrl+C).

2. In The Journal, click on the Help menu and choose "Enter Registration Keys..."

5.17.9.13 Entry Statistics

Click on the Entry menu and choose "Entry Information & Statistics..."

Entry Statistics

This form shows the following information for all entries:

Date Created - the date this entry was originally created

Date Last Modified - the date of the last modification to the entry

Date Last Printed - when the entry was last printed

Total Editing Time - the number of minutes spent editing the entry (this is measured as the time from

beginning an addition/modification to the time the entry was saved) *

¢ Revision Number - the number of times the entry has been modified (all changes on a single date
count as 1 revision)

* For some entries imported from The Journal 3, the total editing time reported may be incorrect.

Word Count

For document entries, it also displays:

* Words - how many words are in the entry

* Characters (no spaces) - how many non-whitespace characters are in the entry

Characters (with spaces) - how many total characters are in the entry

Paragraphs - the number of individual paragraphs in the entry (empty paragraphs are not counted)
Lines - the number lines displayed (this number varies as you resize The Journal)

Entry Changes Log
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This tab displays a summary of every time the entry was edited or otherwise changed. The name of the
user who made the change is included in the log.

NOTE: Changes/edits that happen within 30 minutes of each other are consolidated into a single
change.

Clear History - Clicking this button clears all of the current history for the entry, and inserts a history
item about the clear. NOTE: This cannot be undone.

5.17.9.14 Find Text...

Click on the Search menu and choose Find Text... (hot-key: Ctrl+F)
Search for text in the current entry.

NOTE: To search in multiple entries across categories, use Search Entries instead.

Text to Find

Enter the word or phrase you want to search for here.
5.17.9.15Get Web Page

Click on the Tools menu and choose "Get Web Page..."

Use this form to GET a page from the Web, with all images, and archive it in the active entry.

While most HTML formatting is supported, some formatting options are not supported (example: CSS
style sheets are not pulled). Also, characters from some languages may not be imported properly (this
will be fixed in a future update).

NOTE: The HTTP GET operation may take a few minutes, as it tries to download all of the images on the
page.

5.17.9.16 Go to Date
Click on the Go menu and choose "Go to Date..." (hot-key: Ctrl+F5)

Choose the date you want The Journal's calendar set to.
Type in the date by hand, or use the "drop-down" calendar.

When interpreting typed-in dates, The Journal uses the Windows setting for date format.

5.17.9.17 Handle Dropped File

This form pops up when you drag and drop a Windows file onto an entry.

Insert this file into Current Entry

The dropped file will be inserted into the current entry, if possible.

Replace Current Entry with this file
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The dropped file will replace the current entry.

Add this file under Current Entry

The dropped file will be added as a sub-entry under the current entry.

Add this file as an Entry

The dropped file is added as an entry at the same level as the current entry.
5.17.9.18 History...

Click on the Go menu and choose "History..."
This form contains a list of all the entries you have opened during this journaling session.

You can select any of those entries listed and then click on "Go to Entry”. Or you can double-click a
listed entry to open that entry.

5.17.9.19 Login

This is the primary login form of The Journal. Before you can do anything in The Journal, you have to
login.

If you need to login to another Journal Volume, press Cancel and then choose Open Another Journal
Volume.

If you want to create a new user, click on Create New User.

User Name

Select your user name from the list of users.

Password

Enter your password.

See also: How do | reset my lost password?

5.17.9.20 Paragraph Borders & Shading

Click on the Format menu and choose "Paragraph Borders & Background..."

Use this form to add (or remove) borders and shading to the current paragraph (or all selected
paragraphs).

Color

This is the color of the border drawn around the paragraph.
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Width

The width, in screen pixels, of the border lines.

Internal Width

This is the spacing between lines (centers of lines) in the border (for double and triple borders).

Offsets...

You can control the spacing between paragraph contents and border. Larger positive values increase
the spacing. Negative values force border to be inside of paragraph contents.

Border Type

You can set the border to be: no border, a single line border, a double line border, a triple line border, a
double line border with the inner line thicker, or a double line border the outer line thicker.

Fill Color

This is the color of paragraph background.

Padding...
You can control the display of the background colored area relative to paragraph contents (the distance

between limits of paragraph contents and limits of colored area). Larger positive values increase the
hanging. Negative values force the color to be inside of paragraph contents.

5.17.9.21 Replace Text...

Click on the Search menu and choose Relace Text... (hot-key: Ctrl+G)
Search Where

Entire entry - the current entry is searched, starting from the beginning of the entry.

All entries in <category>, starting here - Search the current entry, then search all following entries in
the category.

All entries in <category> - Search all entries in the category.

Text to Find

Enter the word or phrase you want to search for here.

Replace With

Enter the word or phrase that the found text will be replaced with.
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Options
Case-sensitive - the case (uppercase or lowercase) of the text to find must match exactly.
Whole words only - no partial-word matches.

Prompt on replace - you will be prompted before each replacement so you can choose whether this
text should be replaced.

5.17.9.22 Reset Login Password

Lost passwords cannot be recovered. But they can be reset.

When you are prompted for your password for your login name or category, type:
lIresetpassword

That will bring up this form.

NOTE: Users who have activated Extended Security cannot have their passwords reset. That's one of
the features of Extended Security.

Password Reset Code

Enter the password reset code you received here.

Request Reset Code
Clicking here will start your email program to request a password reset code from DavidRM Software.

Email DavidRM Software and request a password reset code.

5.17.9.23 Select Entry

This form is used by Insert/Edit Link to select the entry to link to.

Select the entry you want from the list of active categories and their entries.
5.17.9.24 Stopwatch Timer

Click on the View menu and choose "Timer" (hot-key: Ctrl+Alt+l), then click on "Stopwatch".

The Journal's stopwatch timer can be used to track how long you have been working on a particular
project.

NOTE: When you use the stopwatch, the countdown timer is disabled. And vice versa. You cannot use
both the stopwatch and the countdown timer at the same time.

Time Elapsed

Time Elapsed displays the time since you started the stopwatch, in hours, minutes, and seconds (hh:
mM:ss).
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While the stopwatch is running, you can insert the current elapsed time into your entry by clicking on
the Insert menu and choosing "Insert Timer Count".

@/ Start

Will start the stopwatch. If you have paused the timer, it will resume from its last count.

W Pause

Will pause the stopwatch.

W Reset

Reset stops the stopwatch, resetting it to the starting time (00:00:00).
5.17.9.25 Unlock Form

When The Journal is "locked", either by minimizing or by using the "Hide Journal” hot-key (Ctri+J),
you must enter your password to regain access.

5.17.9.26 User Images

Click on the User menu and choose "User Images..."

The Journal allows you to load images for use as backgrounds to document entries or as Calendar
Charms.

Images

This is the list of all images currently loaded by the user. Each user login in The Journal has its own list
of images.

Load Image...

Click this button to load a new image.

NOTE: Every image must have a unique file name.

Delete Image

Delete the currently selected image.

Description

You can add a description to the image. This description is shown, along with the filename, whenever
you need to choose a background image for an entry or a Calendar Charm collection.
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Image Type

An image is either a background image or a Calendar Charm collection.

Background Image Options
Position

A background image can be either tiled across the entry, centered in the middle of the entry, or
stretched to fit the entry editor.

Margin Offsets

Click on this button to adjust the margins used with background image, for example to prevent text from
displaying on the border of the image.

Calendar Charm Options

Calendar Charm images are often collections of same-sized images arranged in a grid (but without
visible grid lines).

# of Charms Across (X)

The number of charm images across the image.
# of Charms Down (Y)

The number of charm images down the image.

5.17.9.27 User Statistics

Click on the User menu and choose "User Statistics..."

NOTE: If you have a lot of categories and/or a lot of entries, it make take a few seconds for the totals to
be tallied.

This form shows the following information for the current user:

* # of Categories (Active) - how many active categories this user has (includes active sub-categories)
* # of Categories (Total) - the total number of categories this user has, active or inactive

* # of Entries (Active) - the number of entries in all active categories

¢ # of Entries (Total) - the number of entries in all categories, active or inactive

5.17.9.28 Word Count

Click on the Tools menu and choose "Word Count..." (hot-key: Ctr+W).

This form displays the following statistics for the entry or the selected text:

* Words - how many words are in the entry or selected text

* Characters (no spaces) - how many non-whitespace characters there are

* Characters (with spaces) - how many total characters are in the entry or selected text
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¢ Paragraphs - the number of individual paragraphs (empty paragraphs are not counted)

* Lines - the number lines displayed (this number varies as you resize The Journal)
5.18 User Preferences

Each user of The Journal can customize The Journal to fit her own tastes and preferences.

General
Global

Reminders
Date/Time

Links

Spell Checker
Printing
Backup/Restore
Security

5.18.1 User Preferences: General
Measurement System
The Journal supports either the US system (inches, etc.) or the Metric system (centimeters, etc.). The
Journal automatically uses the measurement system settings active in Windows. If you wish to change
it, use this option.
Display Start of Week on
Your calendar can be set to start on any day of the week. Your Tasks, Events, Appointments etc will
also use this day of the first day of the week. NOTE: You can override this at the category level.
Display Week Numbers on Calendar
If checked, the week number is displayed on the small calendar.

NOTE: If the start-of-week is set to Monday, the week number is calculated according to ISO 8601.

Highlight dates with entries on calendar

If checked, dates with one or more entry are highlighted on the small calendar.

Start New Entry Date After

This is the time after which The Journal considers a new entry date to have begun in daily entry
calendar categories. The default is midnight (12:00 am or 00:00).
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Create New Entry always prompts for date (calendar categories only)

When checked, the Create New Entry command (hot-key: F9) always prompts for the date to be used
for the new entry.

This option only applies to calendar categories like "Daily Journal".

Create New Entry defaults to today's date (calendar categories only)

When checked, the Create New Entry command (hot-key: F9) uses today's entry date by default. If not
checked, the date of the currently active entry is used instead.

This option only applies to calendar categories like "Daily Journal".

Edit Custom Colors

Use this option to set up to 16 custom colors that will be available wherever The Journal allows a color to
be set or selected.

5.18.2 User Preferences: Global

These options affect all users in all Journal Volumes on this computer.

Auto-Save Every nn Minutes

When checked and the number of minutes is selected, this option specifies when The Journal will
automatically save all changes.

Auto-Minimize if idle for nn Minutes

When checked and the number of minutes is selected, this option specifies when The Journal will
automatically minimize if it has received no input from the user.

Display/Ul

Show "splash screen” on Startup

Un-check this option if you do not wish to see The Journal's opening screen when starting The Journal.

Show icon in the Windows system tray

If this option is checked, The Journal will minimize to the Windows "system tray"” (in the lower-left
corner, by the time display) instead of the taskbar. When The Journal is not minimized, The Journal will
still have a button on the Windows taskbar.
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Minimize on Close

If this option is checked, The Journal will not close when you click on the "X"' (Close Window) button in
the upper right corner of The Journal window. Instead, The Journal will minimize.

To force The Journal to close, click on the Journal menu and choose "Exit The Journal".

Minimize when The Journal loses focus

If this option is checked, any window that is placed in front of The Journal will prompt The Journal to
minimize.

Disable Ctrl+Alt Hot-keys

If checked, this option turns off the keyboard shortcuts in The Journal that use Ctrl+Alt key

combinations. Currently, this only affects the Toggle Calendar (Ctrl+Alt+C), Toggle Tree (Ctrl+Alt+T),
and Toggle Timer (Ctrl+Alt+]) hot-keys.

International character hot-keys override topic hot-keys

If checked (the default), then the international hot-keys for circumflex accented characters (" over the
letter) and combined characters (like the German double S, ) are active.

If un-checked, topic Ctrl+Shift+6 and Ctrl+Shift+7 are available as topic hot-keys.

When The Journal is inactive, mouse-click only activates

If checked (the default), when The Journal is visible but inactive (for example, behind another program),
clicking on The Journal *only* activates it. That is, brings The Journal to the top.

If un-checked, when The Journal is brought to the top, the user interface element under the mouse is
also clicked.

The Journal Hide/Unhide Global Windows Hot-Key Active

If this option is checked, The Journal can be activated (as long as it is running) regardless of where
you are in Windows, and what other applications may be running.

To set the global hot-key for The Journal, click on the hot-key entry. Then hold down the keys you want
to use for the hot-key.

The Journal's default hot-key is: Ctri+Alt+J

If you change the hot-key, you will want to test to make sure that none of your other Windows
applications are using the same one.

Show Journal Volume tabs

If checked, open Journal Volumes will have tabs down the left side of The Journal's window. You can
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use these tabs to quickly switch between Journal Volumes.

Note: This is a global option and affects all users.

Show User Name tabs

If checked, all users you have opened in the Journal Volume will have tabs with their name along the
bottom edge of The Journal's window. You can use these tabs to quickly switch between open users.

Note: This is a global option and affects all users.

Theme

Active Theme

This option sets the active visual theme for the user interface. To see the list of themes with a preview,
click on the "Preview" button.

NOTE: If you want to turn off visual themes, select the "Windows" theme.
Theme applies to form borders

Un-check this option to allow Windows to control the display of form borders and title bars.

Use The Journal 6-style skinning (overrides active theme)

When checked, this option will give you the option of choosing from the user interface skins from The
Journal 6. Click the browse ("...") button to select the skin to use.

Note that if you turn The Journal 6-style skinning on (or back off), that you will need to close and restart
The Journal.
Disable shadows under forms when skins are active

If checked, the shadow displayed "under" The Journal's main form and dialogs is disabled. This also
disables any transparency in the form caption.

NOTE: This option only applies to The Journal 6-style skinning.

Edit User Interface Font

Use this option to control the font, font type (regular, italic, bold, bold italic) and font size used in all
areas of The Journal's main user interface. For example, if you want to use a larger font size, to make
the tabs and tree easier to read, you can do that here.

Toolbar, Menu and Entry Tree Icons

You can choose whether to use The Journal's default (current) set of icons for the toolbars, menus and
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entry tree, or use those from a previous version, either The Journal 4 or The Journal 5,.

Sound

Countdown Timer Completed Sound

This is the sound played when the countdown timer reaches 00:00:00. This can be any sound (.WAV)
file on your computer.

User Preferences: Category

Default Category

The default category is the category opened when starting The Journal. If no default category is set, the
first active category is opened.

Category Layout
Display Categories in a Tree

If checked, your categories are displayed in a tree. You can position the tree to the left of the entry
editor, or above it.

Embed category tree in entry user interface

If checked, the category tree is "embedded" into the entry user interface, just above the calendar and
entry tree. This allows the category tree to take up as little space as possible.

Categories are Tabs (classic layout)

If checked, your categories each have a separate tab, either on the right of the entry editor, or above it.
Show category type on tab

If checked, an icon displaying the type of category (calendar, loose-leaf, or folder) is displayed on the
category tab, as well as the name of the category.

Category Options
Default Category Type

Determines which type of category (calendar or loose-leaf) is automatically checked when you "Create
New Category..."

The options are:
¢ Calendar (like "Daily Journal")
* |oose-leaf (like "Notebook")

Keep all active calendar categories on the same date
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If checked, this option keeps all calendar categories on the same entry date. That is, if the date is
changed in the current calendar category, the same date is set for all other active calendar categories.
Prompt for entry name when creating new loose-leaf entries

If checked (the default), when you do a Create New Entry (hot-key: F9) or Create New Sub-Entry (hot-
key: F10) to create a new loose-leaf entry, you will be prompted for the name of the entry.

Show entry date/name above entry editor

If checked, the date or title of the entry will be shown above the entry editor.

If you are using a lower-resolution setting and need more screen "real estate", un-check this option.

Show category colors on tab and in tree

If checked, category tabs are color coded. Categories are automatically assigned default tab and text
colors. You can set each category to have a unique color in Category Properties.

NOTE: If you are using The Journal 6-style skinning, the category tabs will not be color coded.
5.18.4 User Preferences: Entry

Entry Background Color

This is the color used as the background for all entries. This setting can be overridden at both the
category level (see Category Options: Entry Text Style) and at the entry level.

Entry Background Image

This is the image that is used as the background for all entries. This setting can be overridden at both
the category level (see Category Options: Entry Text Style) and at the entry level. Images must be
loaded using the User Images form (on the User menu).

NOTE: Entry Background Image overrides Entry Background Color

Entry Font & Paragraph Settings

This is the font and paragraph formatting that will be used for all entries. This setting can be overridden
at both the category level (see Category Options: Entry Text Style) and at the entry level.

5.18.5 User Preferences: Editor

Editor Options Image Options Misc Options

Editor Options

Default Tab Width
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The default tab width is either 0.50 inches (US) or 1 cm (Metric). If you want it to be some other value,
you can specify that here.

When selecting, auto-select entire word

When using the mouse to select text in an entry, this option causes the selection to always pick up full
words.

Auto-Replace while Typing

If active, this option causes specified sequences to be replaced by text. The replacement text can be
either formatted or unformatted.

Edit Auto-Replace Strings

This button brings up the Edit Auto-Replace Strings form so you can edit, add, or delete auto-replace
strings.

Auto Symbol Replace while Typing

If active, this option causes specified sequences to be replaced by a symbol. For example, '(c)' would
be replaced by '©'".

Edit Symbol Replace Strings

This brings up the Edit Symbol Replace Strings form where you can edit, add, or delete symbol
replacement strings.

Symbol replacements are designated by:

e string to replace (Example: :-) )

e font to pull the symbol from (Example: WingDings)
¢ symbol to replace with (Example: J)

Auto-Correction

Replace i with | - When checked, all instances of a singularly typed ‘i' will be replaced with ‘I'." This
option is On by default for English-language versions of Windows, and Off for non-English-language

versions of Windows.

Capitalize the first word of a sentence - When checked, the first letter of a word that begins a
sentence will be capitalized.

Typographical Quotes (curly quotes) - When checked, all double- and single-quote characters are
converted to their typographical (curly) equivalents.

Image Options
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Default Layout for Inserted Images

This setting is used when inserting images. You can change the default to be any of the following:
bottom to base line of text (default)

middle to base line of text

top to line top

bottom to line bottom

middle to line middle

left side

right side

Insert large images as thumbnails

If true, images with a width or height larger than the specified number of pixels are displayed scaled to
that size.

NOTE: The scaling is display only. The image is not resampled. The image can be viewed at smaller or
larger sizes by clicking on a corner and dragging.

Automatic Image Resizing

For most journaling and scrapbooking purposes, images, especially digital photos, don't need to be
stored at their full size. However, having to manually resizing the images before putting them in The
Journal can be inconvenient. This feature makes it possible to have your images automatically resized
when you insert them.

Resizing can be fully automatic, you can have The Journal prompt you, or you can select to have no
image resizing.

The images are resized according to their largest dimension. If the image's width is greater than its
height, then the width is used to scale the image. If the height is greater than the wide, then the height is
used.

The image is resampled during the resize, so that the quality of the image remains high. The resampling
uses the Lanczos resampling algorithm with a 6x6 cell size.

Default Image Type

To improve save/load times of entries with images, The Journal automatically converts inserted and
pasted images to either JPEG or PNG formats. The JPEG format allows for the best compression, but at
the cost of some information. For most photos, JPEG is the best choice.

The PNG (portable network graphic) format doesn't compress most images as small as JPEG, but PNG
has the advantage of losing no pixels and doesn't cause the subtle color shifts sometimes seen in JPEG.

This setting only affects images when they are first inserted or pasted. After that, the images aren't
changed, regardless of this setting.

Misc Options

When pasting, Rich Text Format has priority over HTML Format
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If checked, when pasting from the clipboard, Rich Text Format (if available) has priority over HTML
Format.

When pasting as Plain Text, preserve images

If checked, when using Paste as Plaint Text, if the text on the clipboard contains images, those will be
pasted, as well as the text.

Insert URL when pasting from Web pages

When you copy and paste text and images from a Web page, the URL is inserted immediately following
the pasted text/images.

Show special characters in editor (global option)

When checked, this option causes spaces, paragraph and soft-hyphens to be displayed.

Use alternative editor formatting (global option)

When checked, this option causes the editor to use a slightly slower but sometimes more accurate
method of formatting text on screen.

Use this option if you see improper line breaks or other formatting issues.

Force Bidirectional Editing (global option)

This option forces The Journal to use bidirectional editing even when the Windows default is left-to-
right.

You will need to close and restart The Journal after changing this setting.

NOTE: Activating this option disables "block justify" formatting display. Block justified text will still print
correctly, but it will not be displayed with block justification in the entry editor.

Scroll Speed in Editor (global option)

This number determines how fast the entry editor scrolls when you spin the mouse wheel. The possible
values are 1 (slowest) to 99 (fastest).

NOTE: This setting has no effect on the WYSIWYG editor scroll speed.
5.18.6 User Preferences: Topics

Default Topic Highlight Color

Topics are displayed with a highlight color that distinguishes them. This is the default highlight color
used by all topics. This color can be overriden by each topic, so that special topics get more a
distinctive color. This color can also be set to "Transparent”, which displays no highlighting in the entry
editor.
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Default to "Show all topics" in Editor

If checked (the default), then any text in an entry that has one more topics applied to it will display with
that topic's highlight color. If not checked, topic highlight colors aren't displayed. However, the topics in
the entry are still listed below the editor:

Topics: [Exercise], Diet, Energy

Insert Topic Name

If checked (the default), then the topic name is inserted any time a new topic is selected. How the topic
is inserted is controlled by the Topic Name Format option.

NOTE: This option has no effect when you select a block of text and then apply the topic.

Topic Name Format
The default topic name format is: [%topic]

The "%topic" variable is replaced by the name of the topic.

[Exercise]

In my workout today I adjusted the weight used |

Topics

This is the list of all the topics you have defined. The Journal automatically creates nearly 100 topics for
you. You can add new topics, delete topics you don't want, and edit topics that need changing.

Topics that you have used in an entry are indicated in bold text.

You can make a topic a sub-topic by clicking and dragging it to the topic you want it to be under, then
dropping it.

Topic Name

Every topic, including sub-topics, must have a unique name.

Highlight

To make it easier to distinguish topics used in an entry, you can set the highlight color. If you do not set
a color, then the default topic highlight color is used.
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Hot-Key

Up to 10 topics can be assigned a hot-key. Giving a topic a hot-key makes it even easier to apply that
topic. The available hot-keys are Shift+Ctri+1, Shift+Ctrl+2, up to Shift+Ctrl+0. (NOTE: Shift+Ctrl+6 and
Shift+Ctrl+7 are only available if the global option "International character hot-keys override topic hot-
keys" is un-checked.)

New Sub-Topic

This button creates a new sub-topic of the currently selected topic.

Delete Topic

Deletes the selected topic.

User Preferences: Reminders

Click here for more information about reminders.

Report Missed Reminders

If checked (the default), then every time you log in, The Journal will see if you missed any reminders
since the last time you logged out.

Include Reminders When Printing/Exporting Entries
NOTE: This option only applies to entries in calendar categories, like "Daily Journal".

If this option is checked, then when you print or export entries from calendar categories, any reminders
that were active, completed, missed, skipped or canceled on that date will also be printed or exported.

Display reminders/events from MS Outlook in The Journal

If checked, The Journal will display your reminders/events from your default MS Outlook calendar.

Default Category or Categories for New Reminders
Active category - New reminders are created to be visible in the currently active category.
All categories - New reminders are created to be visible in all categories.

Selected categories - When you create new categories, you will need to specify which category or
categories the reminder will be visible in.

User Preferences: Date/Time

"Insert Date" Format
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This is the format that is used for dates inserted with the Insert | Date (Ctrl+D) command.

Use the following codes for the date format:
yyyy - 4 digit year (1996)

yy - 2 digit year (96)

mmmm - full month name (August)

mmm - three-letter abbreviation of month (Aug)
mm - 2 digit month (08)

m - 1-2 digit month (8)

dddd - full day name (Friday)

ddd - three-letter abbreviation of day (Fri)
dd - 2 digit day (09)

d - 1-2 digit day (9)

Edit "Insert Date" Style
The formatting of the inserted date text can be specified with this option.

See Styles for more information.

Entry Date Header Format
This format is used to display the date above calendar entries.

See "Insert Date" Format above for formatting codes. Commas or any punctuation, or spaces can be
added or deleted to suit the format of date you would like to display

Force month and day names to English (global option)

When this option is checked names of months and days will be converted to English. This applies to the
calendars and planners as well as the Insert Date and Insert Time commands.

Note: This is a global option and affects all users.

"Insert Time" Format
This is the format that is used for dates inserted with the Insert | Time (Ctrl+T) command.

Use the following codes for the time format:
hh - 2 digit hour (02:00)

h - 1 digit hour (2:00)

nn - 2 digit minute (2:03)

n - 1 digit minute (2:3)

ampm - 12-hour clock, AM/PM (2:00 PM)
am/pm - 12-hour clock, am/pm (2:00 pm)
a/p - 12-hour clock, a/p (2:00 p)

Edit "Insert Time" Style
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The formatting of the inserted time text can be specified with this option.
See Styles for more information.
User Preferences: Links

Auto-Highlight Links

If checked, then Internet links/URLs (web page addresses, email addresses, etc) and entry links will be
highlighted as they are typed in.

Clicking links opens a New Browser

If checked, a new browser window is opened when Internet links are clicked on. If not checked, then
the most recently opened browser window is used. In either case, if no browser window is open, one is
opened.

Edit Internet/Email Links Style

The formatting used to display Internet links/URLs can be specified with this option.

See Styles for more information.

Edit Entry Link Style

The formatting used to display entry links can be specified with this option.

See Styles for more information.

5.18.10 User Preferences: Spell Checker

Check spelling as you type

This option performs "live" spell checking if activated. Misspelled words will be marked with a distinctive
underline (see Spelling errors underline color below). Marked words can be right-clicked on to bring up
a list of suggestions to correct the misspelling.

Spelling errors underline color

This option specifies the color used when marking misspelled words when performing "live" spell
checking.

Correct spelling errors as you type

This option performs "auto-correction” of designated misspellings. For example, "teh" is automatically
corrected to "the".

The Journal includes a list of commonly misspelled words and their automatic corrections. Plus, you
can add new auto-corrected words to your custom spell check dictionary.
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5.18.11 User Preferences: Printing
User Name

This option defaults to your login name for The Journal. If you would like your full name to appear on
entry printouts (using the <USERNAME/> macro), enter that here.

Edit Default Page Setup
The default page setup is used when printing entries from any category that does not specify its own

page setup. You can specify the default page orientation (portrait or landscape), as well as the margins
to be used.

Edit Default Page Header and Footer

The header and footer specified here are used when printing any category that does not specify its own
header and footer.

Edit Default Entry Header

The entry header specified here is used when printing entries from a category that does not specify its
own entry header.

See Printing for more information.
5.18.12 User Preferences: Backup/Restore
Backup Path

This is the folder or drive path where the backup will be located. You can select your own destination to
removable media or any folder on your hard drive by selecting Browse (...)

Always backup when closing The Journal

When checked, The Journal will do a backup whenever you close the software.

This option overrides the "Prompt for backup every nn days" option.

Backup Journal Volumes every nn day(s)

When this option is checked and the number of days is selected, The Journal will backup your Journal
Volumes before closing. The default is every 3 days.

Append date & time to backup archive

If checked, the backup file name will be automatically appended with the current date and time.
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Keep only the nn most recent backups per Journal Volume

Once the number of backups for a Journal Volume reaches this number, then the oldest backup is
deleted to make room for the new one.

This applies to the backup path you set above, and to all paths you have The Journal copy your
backups to (but not to FTP servers).

Copy backup archive to these locations

This feature allows you to automatically create identical backup copies in additional locations by
selecting Browse (....), selecting a location, and then clicking "Add".

You can also have The Journal automatically FTP your backup file to an offsite location. To do that, you
have to input the FTP information in this format:

ftp://userLogin:userPassword@ftp.host.com/remote/path/

Or, if you use anonymous login to the FTP server (not recommended):
ftp://ftp.host.com/remote/path/

Finally, it's also possible to upload with FTPS, assuming your server supports FTPS:

ftps://userLogin:userPassword@ftp.host.com/remote/path/

5.18.13 User Preferences: Security

Automatically log in this user (bypass password)

If you would like to automatically log you in when you launch The Journal, set this option. You can also
set (or clear) this option by clicking on the User menu and choosing Auto-Login.

You must confirm your password to activate this option. If you have a blank password, just hit
ENTER.

NOTE: This feature effectively bypasses The Journal's built-in security features, so only activate this
feature if you are the only person using your computer.

In past versions of The Journal, Auto-Login was called "Single User Mode".

Lock User on Minimize/Hide (prompt for password on restore/un-hide)

This setting, if active, "locks" The Journal when minimized or it is hidden, whether with the auto-hide
option or the "Hide The Journal" hot-key (Ctrl+J).

Compress Entries

If checked (the default), all entries are compressed as they are saved. This keeps the Journal Volume
as small as possible, and adds a bit more security.
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NOTE: The Journal overrides this setting for entries that have media attachments or a large (or a large
number of) JPG or PNG images. This is because most media files and JPG and PNG images are
already compressed, and trying to compress them further slows down loading and saving without
gaining any significant benefit.

Encrypt Entries

If checked (the default), all entries are encrypted as they are saved. If compression is also turned on,
that happens prior to encryption.

Why you might turn off compression and/or encryption: If you are not worried about the security
of your entries, then you might turn off these options to speed up loading and saving of large entries.

NOTE: Turning off either does not affect entries that already exist. Only entries that are added or
modified will use the new settings.

See Extended Security: Global Options for more information.
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"Insert Date" Format 200
"Insert Time" Format 200
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add-on packages 85

anniversary reminder 134
anniversary, display year 134

Append date & time to backup archive 203
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Arrange Category Tabs on the Right 190
ATOM Publishing Format 108

ATOM, importing entries from 62
ATOM, importing from 109

audio files 115
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Auto Symbol Replace while Typing 195
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Auto-load when The Journal starts 122
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bookmark 73
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Bookmarks 127

border images, loading 118
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calendar charm, setting or changing an entry's
Calendar Charms 73, 120, 178

Calendar Charms, creating your own 120
Calendar Charms, loading 120

Calendar Charms, user-created 188
Calendar Views 82

calendar, month 82

calendar, year 82

Can | insert digital photos in my entries? 54

Can | use voice-recognition software with The
Journal? 60

Categories 58, 73, 81

categories, calendar 82
categories, linked 84

categories, loose-leaf 83
categories, merging 84
categories, notebook 83
categories, options 85

categories, options for calendar 87
categories, shared 84

Category Active 86

120

Category Entries are Read Only (and no new entries)

92
Category is a Folder Only 86
Category is Shared 93
Category Name 86
Category Password 92
Category Properties 85
Category Properties: Calendar 87
Category Properties: Entry 89
Category Properties: Entry Text Style 92
Category Properties: General 86
Category Properties: Security 92
Category Properties: Sharing 93
Category Share Password 93
Category sort order 86
Category Statistics 178
Category Tab Visible 86
category tabs, move totop 58
category tabs, putontop 58
category, calendar, whatisa 58
category, creatinganew 58
category, default type 194
category, deleting 58
category, how to create anew 48
category, loose-leaf, whatisa 58
category, merging 84

cedilla, hot-key 173

centimeters 190

Change User Password 178
changing password 66

Character: Font 146

Character: Highlight Color 146
characters, typing international 171
Check spelling as you type 202
Choose Category to Import Into 179
choose date 184

Choosing a Good Password 142
Clean Journal Volume folder 95
Clipboard Viewer 180

Command Line Options 177
Compress Entries 204

Contact Information 13

Convert Doodle to Image 116
Copy backup archive to these locations
copy backup to ftp 203
Correct spelling errors as you type
countwords inan entry 189
count words in selection 189
Countdown Timer 180
Countdown Timer Completed Sound 191
Create a New Entry Every ... 87

Creating a New Category 48

Creating Additional Journal Volumes 50
Creating Additional Logins 50

Creating Enhanced Templates 159

Creating Entries 43

Creating New Styles 145

Creating Simple Templates 158

Creating Your Own Backgrounds 119
Creating Your Own Borders 118

Creating Your Own Calendar Charms 120
Credits 16

Ctrl+Alt hot-keys, disable 191

CtrlI+Alt key combinations, disable 176
Cumberland Diary, import from 111

Custom Colors 190

customize menus 171

customize toolbars 171

Customizing the User Interface Font 170
Customizing the User Interface with Skins 170

203

202
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daily entry categories 82
Daily Journal 43
Daily/Weekly Enty Report 103
Daily/Weekly Reminder Report
Database Maintenance 51, 93
Day Planner 73, 137
DayNotez CSV file import 111
Dedication 16

Default Category Type 194
Default Editor Background Image 195
Default Entry Template 89

default entry template, setting 152
Default Footer 130

Default Header 130

Default Image Type 195

Default Page Setup, Page Header, Page Footer, and
Entry Header 89

default path 122

Default Tab Width 195

Default to "Show All Topics" in Editor 198
Default Topic Highlight Color 198

Delete Entries 105

Delete Users 123, 181

deleted entries, recovering 105

Deleting a User 123

Diaro import 111

Diaro, importing entries from 62
dictionary, custom, spell checker 202
dictionary, spell checker 202

digital photos 115

digital photos, inserting 54, 115

Disable Ctrl+Alt Hot-keys 191

Display actual date/time entry created 87
Display calendar folders for ... 87
Display first line of entry in entry tree 87

Display reminders/events from MS Outlook in The
Journal 200

Display Start of Weekon 190

Display week numbers on calendar 190
Document Entries 96

Document Entry Options 89

document, export entriesas 106
documents, importing 109

doodle, convert to image 116

103, 138

Doodling in Entries 116

-E -

Edit "Insert Date" Style 200

Edit "Insert Time" Style 200

Edit Auto Replace Strings 181, 195
Edit Custom Colors 190

Edit Default Header and Footer 203
Edit Default Page Setup 203

Edit Entry Link Style 202

Edit Font and Text Settings 92

Edit Header/Footer 181

Edit Internet/Email Links Style 202
Edit Page Setup, Header, Footer 89
Edit Styles 145

Edit Symbol Replace Strings
Editing Categories 48
Editing Keyboard Shortcuts 171

Editing Standard Styles 145

Editing Topics 169

EfficientPIM, import from 111

Encrypt Entries 204

encryption algorithrm 142

Enhanced Template Basics 159
Enhanced Template Script Variables 157
Enhanced Template Scripting 162
Enhanced Template Scripting Part2 164
Enhanced Template Sections 160
Enhanced Template Tags 154
Enhanced Templates 153

Enhanced Templates Wrapup 166
enhanced templates, basics 159

Enter Registration Keys 183

Entries 54, 73, 95

entries, document 96
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entries, image 96

entries, locking 54

entries, maximum 54

entries, searching 98

entries, text 96

Entry Background Color 92

Entry Background Image 92

Entry Background Images 117

Entry Changes Log 183

Entry Date Header Format 200

182, 195
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entry history 185

Entry Index 103

Entry Links 124

Entry Links to Calendar Entries 125
Entry Links to Loose-leaf Entries 125
entry links, typing 125

entry links, with bookmarks 127
Entry Report Results 104

Entry Report Wizard 103

Entry Statistics 183

entry time stamp, remove 54

entry tree 73

Entry Type 89

Event Reminders 133

Events 133

EverNote enex import 111
EverNote, importing entries from 62
EverNote, importing from 109
Exclude from automatic backups 122
Export Entries as Document 106
Export Entries as File 108

export files, importing 109

export formats 105

Export/Import 105

Export/Import CSV Format (for reminders)

Exporting 106, 108
exporting entries 98
exporting HTML 106
Exporting Reminders 138
exporting rich text (RTF) 106
exporting text 106
Extended Security 66, 143

Extended Security: Global Options 143

external entry link 126

external hard drive, install The Journal to a

External Object Entries 96
External Object Entry 89

-F -

FAQ 53

FAQ: Backup/Restore 64
FAQ: Categories 58

FAQ: Database Maintenance 64
FAQ: Entries 54

FAQ: Export/Import 62

FAQ: Journal Volumes 61

FAQ: Printing 57

FAQ: Security 66

FAQ: Upgrading 66

FAQ: User Interface 60

File Links 127

Find Tex 184

Flash drive, install The Journaltoa 61
font, category default 92

font, interface 191

Force Bidirectional Editing 195
Force month and day names to English 200
Frequently Asked Questions 53

-G -

german double s, hot-key 173
Get Web Page 184
Getting Started 40

global options 191
Glossary 73

GotoDate 184
GOForceRepair 176
GOShowSplashScreen 176

-H -

Handle Dropped File 184

history of entries opened 185

hot-key 191

hot-keys 171

hot-keys for international characters 173
hot-keys, Ctrl+Alt, disable 191

hot-keys, editing 171

How do | backup The Journal? 64

How do | create a new category? 58
how do | create a new user login 50
How do | customize the toolbars? 60
How do | delete a category? 58

How do | get rid of my password? 66
How do | get rid of the time on my entries? 54
How do | insert images in my entries? 54

How do | install The Journal on a USB/Flash Drive?
61

How do | make my entries read only? 54

How do | make The Journal 6 look like The Journal 4?
66

How do | move The Journal to a new computer? 61
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How do | put the category tabs on top (instead of on
the right)? 58

How do | reset my password? 60
How do | restore from a backup? 64

How do | restore just one category from a backup file?
64

How do | see how many entries are in a category?
58

How do | set a category's default font? 58
How do | set the printer margins? 57

How do | set/change my password? 66

How do | synchronize 2 Journal Volumes? 61
How do | use The Journal on a Network? 61
How do | use topics in my entries? 54

How do | wrap text around pictures in my entries?
54

How many entries can The Journal hold? 54
How to Buy the Journal via "Snail" Mail 18

How to Buy the Journal via the World Wide Web
18

how to create a new category 48

how to create a new Journal Volume 50
how to link to anentry 124

HTML, export entries 106

Ignore words... 202
Image Descriptions
Image Entries 96
Image Entry 89
image, doodle on
Images 115
images, inserting
images, resizing 115

images, searching 115

import entries from another program 62
import, batch entry 111
import, DayNotez csv file
import, Diaro xml file 111
import, EverNote (.enex) 110
import, EverNote export 111
import, Lotus Organizer csv file
import, Penzu (.xml) 110
import, WordPress export
import, XML 110
Importing 109

Importing Entries from Other Journal Software

115

116

54, 115

111

111

111

110

109
139
109

importing HTML files
Importing Reminders
importing rich text files
importing text files 109
inches 190

Include Reminders When Printing/Exporting Entries

200

InfoSelect v8/v9

INI settings 176
insert audio 121
insert bookmark
Insert Doodle

Insert Media 121
Insert Table 149
Insert Topic Name

111

127
116

198

Insert URL when pasting from Web pages
insert video 121

Insert/Edit Link 128

Inserting Images 54, 115

inserting links 128

Inserting Media Files into Entries 121
Inserting Objects into Entries 122
inserting photos 54

international character hot-keys 173

International character hot-keys override topic
hot-keys 191

International Characters
Internet Links 128

-J -

Journal Volume 73

171

Journal Volume is Read Only 122
Journal Volume Properties 122
journal volume, default path 122

Journal Volume, how to create anew 50
Journal Volume, whatisa 61

Journal Volumes 122

Journal.INl 176

-K -

Keep All Active Standard Categories on the Same

Date 190

Keep only the nn most recent backups per Journal

Volume 203

Keep The Journal "on top" 191
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Keyboard Shortcuts 171
Keyboard Shortcuts (Hot-Keys) Alphabetically
keyboard shortcuts, editing 171

-L -

Language 176

Levels of Security 141
license 14

link, entry, external 126
linked categories 84
linking to an entry, how to
Links 73, 123

links to files 127

links, email 128

links, entry 124

links, file 127
links, internet
links, Web page

173

124

128
128

links, with bookmarks 127

Loading Your Background Image 119
Loading Your Border Image 118
Loading Your Calendar Charms 120

Lock Entries on Edit 93
lock entry 105

Lock on Minimize/Hide
Login 185

Loose-leaf Categories 83

lost password, resettinga 60
Lotus Organizer csv file import 111

Make The Journal 6 look like The Journal4 66
Mark past entries read-only 87
Master Category 86

204

Measurement System 190
measurement, metric 190
measurement, US 190
media 73

media files 115

media files, inserting 121

media files, playing 121

menus, customizing 171

merge two or more categories 84
Merging Categories 84

metric 190
Minimize on Close 191

Minimize when The Journal loses focus

140
200

Missed Reminders
MS Outlook reminders

-N -

network, how do | use The Journal on a
new computer, moving The Journal to a
36
103
No new users can be created in Journal VVolume

new features in The Journal 6
New/Updated Entry Report

122

Normal Document Entry 89
Notebook 43

notebook categories 83

-0 -

objects, inserting 122
only one instance of The Journal

203
200
195

options, backup
options, date/time
options, editor
options, entry link 202
options, general 190
options, global 191
options, internet/URL links
options, link 202
options, printing
options, reminder 200
options, security 204
options, spell checker
options, topic 198
Orange Diary Pro, import from
order form 19

-P-

Packages 85

packages, add-on 85
paragraph borders 185
Paragraph Borders & Shading

202

203

202

176
Only show if there are active reminders
Only Verify Password Once per Session

111

185
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191

61
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paragraph color 185
paragraph shading 185
Paragraph: Alignment & Indents: Alignment

Paragraph: Alignment & Indents: Apply Style to

Indentation 146

Paragraph: Alignment & Indents: Left and Right
Paragraph: Alignment & Indents: Special 146

Paragraph: Apply Style to Paragraph Settings
Paragraph: Numbering/Bullets: Apply Style

Paragraph: Numbering/Bullets: Bullet/Numbering Type

146
Paragraph: Numbering/Bullets: Indent 146

Paragraph: Numbering/Bullets: Numbering Style

146

Paragraph: Spacing: Apply Style to Paragraph

Spacing 146

Paragraph: Spacing: Before and After 146
Paragraph: Spacing: Line Spacing 146
password hashing 142
password, category 92
password, changing 66
password, changing your 178
password, choosing a good 142
password, how to resetmy 60
password, | dontwanta 204
password, removing 66
password, resettinga 60
password, tips for a good 142
password, user 204

Penzu, importing entries from 62
Penzu, importing from 109
photos 115

photos, inserting 54, 115
pictures 115

pictures, inserting 115
preferences, backup/restore 203
preferences, date/time 200
preferences, editor 195
preferences, general 190
preferences, global 191
preferences, link 202
preferences, printing 203
preferences, reminder 200
preferences, security 204
preferences, spell checker 202
preferences, topic 198
preferences, user 190

pricing, The Journal 19

Print Loose-leaf Entry Index Indented 203
Print Macros 131

Printing 57, 129

Printing Entries 45

Printing Headers and Footers 130
printing, headers & footers 181

printing, margins 130

printing, page setup and margins 130
product license information 14

Prompt for backup every nn day(s) 203
Prompt for backup when closing The Journal

203

Prompt for entry name when creating new loose-leaf

entries 190
Prompt for Lock Message 93
Prompt on repeated word 202

-Q -

Quantity Pricing 19

-R -

read only, make an entry 105

read only, make category 92

read only, make Journal Volume 122
read only, past entries marked as 87
registration keys, entering 183
Reminders & Tasks 131

Reminders to Show Above Entry 200
reminders, # to show above entry 200
reminders, advanced options 135
reminders, anniversary 134
reminders, appointment 132
reminders, birthday 134

reminders, category options 135
reminders, date 132

reminders, date/time options 135
reminders, display options 135
reminders, event 133

reminders, export/import format 139
reminders, exporting 138

reminders, importing 139
reminders, missed 140, 200

reminders, moving to another install of The Journal

138
reminders, notes 135
reminders, popup options 135
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reminders, special day 134
reminders, status options 135
reminders, task 133

reminders, view a listof all 137
remove bookmark 127

removing password 66

Repair All Journal Volumes 95
Repair Journal Volume 95

Repair System Database 95
Repair The Journal Databases 95
Replace Text... 186

Report Missed Reminders 200
report, new/updated entries 103
report, topics used 103

reports, types of entry 103

Reset Login Password 187
Resizing Images 115

Restore 94

restore a category from a backup file 64
Restore Journal Volume 94
Reverting to The Journal 6 67
rich text (RTF), export entries as 106

-S -

Save Entry As... 98

Save entry editor state between sessions 89
Saving Entries 98

script variables, enhanced template 157
Scroll Speed in Editor 195

search and replace text 186

Search Categories 98

Search Entries 98

Search Results 102

Search Text 98

Searching Image Descriptions 115
Searching Topics 170

Security 141

Security Details 142

Security Overview 141

security, extended 143

security, levels of 141

security, overview of The Journal's 141
Select Categories/Entries to Export 106
Select Categories/Entries to Print 129

Select Entry 1

Select Export Format

87

106

Setting the Entry Background Image
Setting Up a Blogger (Google) Blog
Setting Up a Custom Blog

Setting Up a WordPress Blog

settings, backup

203

Shared Categories 84

shortcuts, keyboard

Show calendar

86

80

171

Show Category Typeon Tab 1
Show day planner with active reminders
Show Entry Date/Name above Category Tabs

Show entry tree

Show Journal Volume tabs
Show special characters in editor

86

79

90

190

Show The Journal "splash screen" on Startup

Show The Journal in the Windows system tray

Show User Name tabs
Simple Templates 153
skin, changing the 170

skin, how do | change the

skinning, turn off 191

skinning, turn on

191

190

60

Index 213
117
80
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190
195

191
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sound, countdown timer completed

sound, reminder
special day remi
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Special Thanks
spell checker

popup
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134
16
202

135
134

Spelling errors underline color
stamp entries with time
standard styles, editing

Start New Entry Date After

87
145

Start on latest entry by default
Stopwatch 187

style 73

Style Name 146

Style Options
Styles 144

146

styles, create new 145

styles, editing
styles, standard,

145
editing

145

202

190
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supported blogs
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176

191
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synchronizing The Journal 62
Syncing The Journal 113
Syncing The Journal from USB to Desktop

Syncing The Journal from Work to Home 113

system database 73

-T-

tab setting 195
Table Cell Properties 151
Table FAQ 148
Table Properties 150
Table Row Properties 151
Tables 147
tables, inserting 54, 149
tables, making tables look like MS Word 54
tables, using 148
tabs 81
tabs, calendar 82
tabs, category 81
tabs, daily entry 82
tabs, loose-leaf 83
tabs, notebook 83
tagging an entry with a topic 167
task reminders 133
Tasks 133
template

creating a simple 158
template, insertinga 152
Templates 152
Templates Overview 152
templates, enhanced 153, 159
templates, enhanced tags 154
templates, enhanced, basics 159
templates, inserting 54
templates, overview of 152
templates, simple 153
text, export entriesas 106
The Journal 4 icons, how to use 66
The Journal 6, going back to 67
The Journal 6, new features 36
The Journal 6, revertingto 67

The Journal Hide/Unhide Global Windows Hot-Key

191

The Journal Order Form 19

The Journal Pricing 19

Theme applies to form borders 191

theme, changing the 170
theme, how do | change the 60
timer, countdown 180

timer, stopwatch 187

TJ4 icons for menus and toolbars, how to use
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TJ6, revertingto 67

TJEXP export file format 108
TIXML export file format 108
to-do items 140

to-do items, creating 140
to-do items, managing 140
to-do items, report 140
toolbars, customizing 171
toolbars, how to customize 60
topic 73

Topic Name 198

Topic Usage Report 103

topic, options 169

Topics 166

topics, applying 167

topics, editing 169

topics, searching 170

topics, using 167

tree 73

Turn on Skinning 191

typing international characters 171
Typing Out Entry Links 125
Typing out Links with Tags 129
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unlock entry 105

Unlock Form 188

Un-upgrading to The Journal 7 67
Upgrade Pricing 19

Upgrading Add-on Packages 70
Upgrading Categories (The Journal 2.x) 70
Upgrading Entries (The Journal 2.x) 70
Upgrading from a Backup File 67
Upgrading from The Journal 2.x 70
Upgrading from The Journal 3 67
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66

© 1996-2016 by David Michael



Index 215

Upgrading Your Journal Volumes from The Journal 6
(or earlier) 67

URLs 128

USB drive, install The Journaltoa 61
Use alternative editor formatting 195
Use Category Extended Security 92
Use The Journal 4 icons 191

Use TJ4 icons for the toolbars, menus and entry tree
191

Use WYSIWYG formatting 89
User Images 188

User Interface Font 191

User Name 203

User Preferences 190

User Preferences: Backup/Restore 203
User Preferences: Date/Time 200
User Preferences: Edit 195

User Preferences: General 190
User Preferences: Global 191
User Preferences: Links 202
User Preferences: Printing 203
User Preferences: Reminders 200
User Preferences: Security 204
User Preferences: Spell Checker 202
User Preferences: Topics 198
User Statistics 189

users, changing passwords 178
users, deleting 123

UsingaBlog 77

Using Categories 48

Using Images in Entries 115
Using Tables 148

Using Topics 167
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Version History 20

video files 115

video files, inserting 121

View | Change Skin/Theme 170
View All Reminders 137

view deleted entries 105

voice-recognition software, using The Journal with
60

volume 122
volume, journal 122
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Web pages 128

week numbers, displaying 190

week, firstday of 190

Welcome to The Journal 11

What are the size limits on a Journal Volume? 61
What is a Journal Volume? 61

What is Extended Security? 66

What kind of encryption does The Journal use? 66
What's New in The Journal 6 36

When pasting as Plain Text, preserve images 195

When pasting, Rich Text Format has priority over
HTML Format 195

when selecting, auto-select entire word 195
Word Count 183, 189

word count, on the status bar 89

word count, running 89

WordPress blog setup 79

WordPress xml import 111

WordPress, importing entries from 62
wrap text around pictures 54

WYSIWYG 89
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XML, exportto 108
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